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システム構成例

ワイヤレス	
マイクロホン
パッケージ	
UWP-D21、	
UWP-D22

ワイヤレス	
マイクロホン
レシーバー	
URX-P03D

マルチインター
フェースシュー
アダプター	
SMAD-P3D

マルチインターフェース
シューアダプター	
SMAD-P5

Aマウントアダプター	
LA-EA3	
LA-EA4

Eマウントレンズ

マイクロホン	
ECM-VG1、ECM-MS2

リモートコントロール
ユニット	
RM-30BP

マルチカメラライブ
プロデューサー	
MCX-500

グリップリモコン（付属）

ILME-FX6V/ILME-FX6VK

XLRアダプター
キット	
XLR-K2M、
XLR-K3M

ビデオライト	
HVL-LBPC

CFexpress 	
Type A	
メモリーカード

SDXC	
メモリーカード

ショットガンマイクロホン	
ECM-B1M

バッテリーパック	
BP-U35、BP-U60、
BP-U60T、BP-U70、
BP-U90、BP-U100

ACアダプター	
（付属）

CFexpress Type Aカードリーダー/	
SDカードリーダー

バッテリーチャージャー	
BC-U1A、BC-U2A



1章　概要4

各部の名称と働き
左側面・前面部
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1.	 メジャーフック
メジャーフックがイメージセンサー面の位置とな
ります。本機から被写体までの距離を正確に測
るには、メジャーフックの位置を参考にしてくだ
さい。メジャーフックにメジャーの先端をかけて、
被写体からの距離を実測できます。

2.	ビューファインダー接続端子（20ページ）

3.	 吸排気口
［ご注意］
吸排気口をふさがないでください。

4.	 TC IN/OUT切り替えスイッチ（36ページ、
123ページ）

5.	 グリップリモコン端子（22ページ）

6.	 （Nマーク）（63ページ）
ˎˎ NFC機能搭載のスマートフォンと本機を無線接
続するときにタッチします。	
一部のおサイフケータイ対応のスマートフォン
はNFCに対応しています。詳しくはスマートフォ
ンの取扱説明書でご確認ください。

ˎˎ NFC（Near Field Communication）は近距離
無線通信技術の国際標準規格です。

7.	 グリップリモコン取り付け部（22ページ）

8.	グリップリモコンリリースボタン
（22ページ）

9.	Wi-Fiアンテナ

10.	記録／タリーランプ（フロント）（36ページ）
記録メディアやバッテリー残量が少なくなると点
滅します。

11.	 FOCUSスイッチ（39ページ）

12.	イメージセンサー

13.	PUSH AUTO FOCUS（プッシュオートフォー
カス）ボタン（43ページ）

14.	レンズ信号接点
［ご注意］
直接手で触れないでください。

15.	WB SET(ホワイトバランスセット)ボタン
（49ページ）

16.	レンズリリースボタン（23ページ）
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右側面前部/上部/下部
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1.	 Clip Flagボタン（56ページ、
73ページ）

2.	 HOLDスイッチ（105ページ）

3.	 録画START/STOPボタン（36ページ）
録画START/STOPボタンを押して録画が開始さ
れると、LEDが赤色に点灯します。

4.	ND VARIABLEダイヤル（47ページ）

5.	 ND PRESET/VARIABLEスイッチ
（47ページ）

6.	ND FILTER POSITION上下ボタン
（47ページ）

7.	 ND CLEARランプ（47ページ）

8.	ND VARIABLE AUTOボタン（47ページ）
ND VARIABLE AUTOボタンを押してNDフィル
ターの自動濃度調整が開始されると、LEDが緑
色に点灯します。

9.	マルチファンクションダイヤル（52ページ）
ビューファインダーに映像が表示されているとき
に押すとダイレクトメニューが表示され、操作す
ることができます。
また、ビューファインダーに各種メニューが表示
されているときに回すとカーソルが上下に移動し
て、メニュー項目や設定値を選択できます。押す
と選択している項目を確定します。
メニュー表示していないときは、アサイナブルダ
イヤルのように機能させることができます。

10.	IRISファンクションボタン（46ページ）

11.	 CANCEL/BACKボタン（72ページ）

12.	THUMBNAIL（サムネイル）ボタン（71ペー
ジ）

13.	MENU（メニュー）ボタン（14ページ、
76ページ）

MENU（メニュー）ボタンを押すと、ステータス画
面が表示されます。MENU（メニュー）ボタンを
長押しすると、フルメニュー画面が表示されます。
ステータス画面、フルメニュー画面のときに押す
と元の画面に戻ります。

14.	ISO/GAINファンクションボタン
（46ページ）

15.	 ISO/GAIN（ゲイン切り替え）スイッチ
（46ページ）

16.	WHT BAL（ホワイトバランス）ファンクショ
ンボタン（49ページ）

17.	 WHT BAL（ホワイトバランスメモリー切り替
え）スイッチ（49ページ）

18.	SHUTTER（シャッター）ファンクションボタン
（47ページ）

19.	ヘッドホン端子（36ページ）

20.	POWERスイッチ（36ページ）

右側面後部（6ページ）
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右側面後部・カードスロット部
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1.	 Wi-Fiアンテナ

2.	 AUDIO LEVEL(CH1)ダイヤル
（50ページ）

3.	 CH1（AUTO/MAN）スイッチ（50ページ）

4.	ASSIGN（アサイナブル）1～3ボタン
（52ページ）

5.	 本体内蔵マイク（50ページ）
環境音収録用のナレーションマイクです。 

［メモ］
ハンドル装着時は、このマイクは無効になり、ハンドル内
蔵マイク（7ページ）が有効になります。

6.	DISPLAY（画面表示）ボタン（11ページ）

7.	 本体内蔵スピーカー（36ページ）

8.	POWERランプ（36ページ）

9.	 SLOT SELECT（メモリーカードスロット(A)/
(B)選択）ボタン（36ページ）

10.	CH2（AUTO/MAN）スイッチ（50ページ）

11.	 AUDIO LEVEL（CH2）ダイヤル
（50ページ）

12.	アクセスランプA（27ページ）

13.	CFexpress Type A/SDカードスロット（A）
（27ページ）

14.	CFexpress Type A/SDカードスロット（B）
（27ページ）

15.	アクセスランプB（27ページ）
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ハンドル部・背面部・端子部
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1.	 ハンドルHOLDスイッチ（105ページ）
ハンドル部の操作部材を無効にできます。

［メモ］
ハンドル録画START/STOPボタンのみにも設定できます。

2.	ハンドル録画START/STOPボタン

3.	 ハンドル内蔵マイク

4.	マルチインターフェースシュー

マルチインターフェースシュー対応アクセサリーに
ついて詳しくは販売店にお問い合わせください。

5.	 ハンドルアサイナブルダイヤル（52ページ）

6.	ハンドルズームレバー（105ページ）

7.	 ASSIGN（アサイナブル）7～ 8ボタン
（52ページ）

8.	マルチセレクター（8方向＋決定）

9.	アクセサリーシュー（7ページ）

10.	アクセサリー取り付け用ネジ穴（1/4インチ）
1/4-20UNCのネジ（長さ6 mm以下）に対応して
います。

［ご注意］
6 mmより長いネジを使用すると、外装部品が破損するお
それがあります。

11.	 記録／タリーランプ（リア）（36ページ）

12.	BATT RELEASEボタン（18ページ）

13.	吸気口
［ご注意］
吸気口をふさがないでください。

14.	バッテリーパック装着部（18ページ）

15.	USB-CTM端子（66ページ）

16.	INPUT2（オーディオ入力2）端子
（50ページ）

17.	 INPUT1（オーディオ入力1）端子
（50ページ）

18.	INPUT2スイッチ（LINE/MIC/MIC+48V）
（50ページ）

19.	 INPUT1スイッチ（LINE/MIC/MIC+48V）
（50ページ）

20.	拡張用ネジ穴
M3のネジ（長さ4 mm以下）に対応しています。

［ご注意］
4 mmより長いネジを使用すると、外装部品が破損するお
それがあります。

21.	HDMI OUT端子（122ページ）

22.	SDI OUT端子（122ページ）

23.	TC IN/TC OUT（タイムコード入力／出力）端
子（123ページ）

24.	REMOTE端子
汎用のLANC端子アクセサリーを接続する端子で
す。

25.	USB/マルチ端子（124ページ）

26.	DC-IN端子（標準DCジャック）（19ページ）

アクセサリーシューを取り付ける

1	 シューバネの先端を持ち上げ、刻印された
矢印の向きと反対方向へ引き抜く。

シューバネ

アクセサリーシュー

1

2	 アクセサリーシューの凸部とアクセサリー
シュー取り付け部の凹部を合わせて取り付
け、4本のネジを締める。
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3	 シューバネを矢印の方向に挿入し、コの字部
分がアクセサリーシューの端部にはまるよう
に取り付ける。

シューバネ

アクセサリーシュー

2 32 3

アクセサリーシューを取り外す

「アクセサリーシューを取り付ける」の手順1と同
様にシューバネを外し、ネジを緩めてアクセサ
リーシューを外す。

ハンドルを取り付ける

ハンドルを本機のハンドル接続端子とネジ穴に合
わせてセットし、ハンドル取り付けネジを押しな
がら時計方向に回して締めて、ハンドルを本機に
取り付ける。
また、六角レンチ（4 mm）で2個のハンドル取り
付けネジを時計方向に回して締め付け、しっかり
固定することもできます。

［ご注意］
ハンドルはハンドル取り付けネジ2本を確実に締めて使用し
てください。ネジを確実に締めずに使用すると、ハンドル
が外れて本体が落下するおそれがあります。

ハンドルを取り外す

取り付けと逆の手順で取り外してください。

ハンドルコネクター保護キャップ（付属
品）の使いかた

ハンドルを外して本機を使用するときは、付属
の保護キャップを使って端子部を保護してくださ
い。

［メモ］
ハンドル装着時、付属の保護キャップはハンドルの底面に
収納できます。

接続端子の保護について

接続端子を保護するために、使用しない端子類
にはカバーを装着してください。

上面

1

2 2

2

2

1.	 ハンドル接続端子

2.	アクセサリー取り付け用ネジ穴（1/4インチ）
1/4-20UNCのネジ（長さ6 mm以下）に対応して
います。

［ご注意］
6 mmより長いネジを使用すると、外装部品が破損するお
それがあります。
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底面

1 2

1.	 三脚用ネジ穴（1/4インチ、3/8インチ）
1/4-20UNCネジ、3/8-16UNCネジに対応してい
ます。三脚（別売、ネジの長さ5.5 mm以下）を
取り付けます。

2.	排気口
［ご注意］
排気口をふさがないでください。

ビューファインダー

ビューファインダー（付属）の取り付けについては、
20ページをご覧ください。

1
2
3

4 5

1.	 PEAKINGボタン

2.	 ZEBRAボタン

3.	 ASSIGN（アサイナブル）9ボタン
（52ページ）

4.	タッチパネル
アサイナブルボタンまたはメニューでタッチ操作
を無効にすることもできます（10ページ）。

5.	 MIRRORスイッチ

グリップリモコン

グリップリモコン（付属）の取り付けについては、
22ページをご覧ください。

4

3
2

1

7
8

6
5

1.	 ズームレバー

2.	 ASSIGN（アサイナブル）4ボタン
（52ページ）

3.	 グリップアサイナブルダイヤル（52ページ）

4.	ASSIGN（アサイナブル）6ボタン
（52ページ）

5.	 グリップ回転レバー（22ページ）

6.	録画START/STOPボタン

7.	 マルチセレクター（8方向＋決定）

8.	ASSIGN（アサイナブル）5ボタン
（52ページ）
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タッチパネルの使いかた
タッチパネル利用上のご注意

本製品のビューファインダーはタッチパネルに
なっており、指で直接触れて操作を行えます。

ˎˎ タッチパネルは指で軽く触れるように設計され
ています。指で強く押したり、先の尖ったもの
（爪／ボールペン／ピンなど）を押し付けたりし
ないでください。

ˎˎ 次の場合はタッチパネルに触れても動作しない
ことがあります。また、誤動作の原因となりま
すのでご注意ください。

ˎˎ 	爪の先での操作

ˎˎ 	異物を操作面に乗せたままでの操作

ˎˎ 	保護シートやシールなどを貼っての操作

ˎˎ 	ディスプレイに水滴が付着または結露して
いる状態での操作

ˎˎ 	濡れた指または汗で湿った指での操作

タッチパネル上の操作

タップ
アイコンやメニューなどの項目に指で軽く触れ、
すぐに離します。

ドラッグ
画面に触れたまま目的の位置までなぞって指を離
します。

フリック／スワイプ
画面に触れて上下または左右にはらうように操作
します。

［メモ］
表示内容が画面の外へ続く場合は、表示内容をドラッグし
たりフリックしたりしてスクロールさせることができます。

タッチパネルの設定

タッチパネルを利用するかどうかは、Technical
メニューのTouch Operation（105ページ）で
設定できます。
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画面表示
撮影中（記録中/記録待機中）および再生中は、ビューファインダー画面の映像に本機の状態や設定が
重ねて表示されます。
表示/非表示の切り替えは、DISPLAYボタンで行います。非表示にした場合も、ダイレクトメニュー
（52ページ）の操作中は表示されます。
また、項目ごとに表示/非表示を選択することもできます（99ページ）。

撮影中の画面に表示される情報

3 42

6
8

9 1075
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13 12
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19 20 21 22 23 24 25 26 27 28 29

30
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34
35
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37

138

1.	 ネットワーク状態表示（13ページ）
ネットワーク接続の状態がアイコンで表示されま
す。

2.	アップロード中表示/転送ファイル残数表示
（68ページ）

3.	 フォーカスエリア表示（40ページ）
オートフォーカスでフォーカスを合わせる領域が
表示されます。

4.	記録モード/スロットA/B/動作状態表示、イ
ンターバルレック記録間隔時間表示（54
ページ）

表示 意味
●Rec 記録中
Stby 記録待機中

5.	 被写界深度表示

6.	イメージャースキャンモード表示（26ペー
ジ）

使用レンズのイメージサークルサイズと、イメー
ジャースキャンモードの有効画サイズに不一致が
ある場合は、  マークが表示されます。
Imager Scan ModeがFFで、画角が狭くなる（ク
ロップされる）モードの場合はCマークが表示さ
れます。

クロップされるモードは以下のとおりです。

ˎˎ 記録フォーマットが3840×2160でS&Q 
Motionフレームレートが100fpsまたは
120fpsの場合

ˎˎ CodecでRAWまたはRAW & XAVC-Iを選択
し、RAW出力フォーマットが3840×2160の
場合

7.	 RAW出力動作状態表示（62ページ）
RAW信号の出力状態が表示されます。

8.	UWP-Dシリーズの状態表示（13ページ）
UWP-DシリーズをMIシューにデジタルオーディ
オ伝送の設定で接続したとき、電波強度を示す
RFレベルなどがアイコンで表示されます。

9.	スロー＆クイックモーション撮像フレーム
レート表示（53ページ）

10.	バッテリー残量/DC IN電圧表示（18ペー
ジ）

11.	 フォーカスモード表示（43ページ）
意味 表示
Focus Holdモード Focus Hold
MFモード MF
AFモード AF
リアルタイムトラッキング	
AFモード

顔/瞳検出AF（AF/ /Only/ / ）

顔/瞳検出アイコン

顔/瞳限定AFアイコン Only
保存された追尾顔ありアイ
コン
AF一時停止アイコン1)

1)	 AF動作中にAF動作が継続できず、一時的にAF動作が
停止したときに表示されます。AF動作を停止する原因が
解消し、AF動作再開すると、非表示になります。

12.	フォーカスポジション表示
フォーカスの位置が表示されます。

13.	ズームポジション表示（38ページ）
ズームの位置が0（広角端）～ 99（望遠端）の範
囲で表示されます。（ズーム設定表示対応レンズ
装着時のみ）
バー表示または焦点距離表示に変えることもで
きます（106ページ）。
全画素超解像ズームを有効にすると、以下の表
示が追加されます。
表示 意味

全画素超解像ズーム機能が有効

倍率数値 全画素超解像ズーム中

14.	手ブレ補正モード表示

15.	SDI出力/HDMI出力のRec Control状態表
示（122ページ）

RECコントロール信号の出力状態を表示します。

16.	フォーカスインジケーター表示（39ペー
ジ）

17.	 メディア残量表示
表示 意味

マウント処理中/マウント状態	
（メディアA）
マウント処理中/マウント状態	
（メディアB）
マウント処理中/マウント状態	
（メディアB）1)

（点滅）

マウント状態（記録不可）	
（メディアB）1)2)

1)	 プロキシデータのみを記録する場合
2)	記録開始時または記録中にメディアエラーやメディアフ
ルなどが発生した場合

メモリーカードがプロテクトされている場合は、
 マークが表示されます。
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18.	ホワイトバランスモード表示
表示 意味

自動モード

 Hold 自動モード一時停止

W:P プリセットモード
W:A メモリー A モード
W:B メモリー B モード

19.	タイムコード外部ロック表示/タイムデータ表
示（36ページ）

他機のタイムコードにロックさせると「EXT-LK」と
表示されます。

20.	NDフィルター表示（47ページ）
表示 意味

自動モード

ボケ調節モード（57ページ）

21.	シーンファイル表示（59ページ）

22.	アイリス表示
アイリスの位置（F値）が表示されます。（アイリス
設定表示対応レンズ装着時のみ）

23.	映像レベル注意表示

24.	ゲイン表示（46ページ）
撮影モード（25ページ）がCustomのときはゲ
イン値またはISO値、Flexible ISOのときはISO
値を表示します。
Cine EI/Cine EI Quick（25ページ）のときは、
EI値を表示します。

表示 意味
自動モード

H プリセットHモード
M プリセットMモード

表示 意味
L プリセットLモード

一時調節モード
ボケ調節モード（57ページ）

25.	クリップ名表示（97ページ）
記録中または次に記録するクリップの名前が表示
されます。

26.	シャッター表示（47ページ）

27.	AEモード/AEレベル表示（46ページ）

28.	水準器表示
本機の水平方向の傾きが±1°刻みで±15°まで表
示されます。

29.	オーディオレベルメーター
CH1～ CH4のオーディオレベルを表示します。

30.	映像信号モニター（55ページ）
ウェーブフォーム、ベクトルスコープ、ヒストグラ
ムを表示します。
オレンジの線はゼブラレベルの設定値を表しま
す。
撮影モードがLog撮影（25ページ）のときは、
表示の上にモニター対象としているLUTの種類な
どが表示されます。

31.	Base Sensitivity表示/Base ISO表示
（46ページ）

撮影モード（25ページ）がCustomのときは、
MainステータスのBase ISO/Sensitivity、ま
たはフルメニューのShootingメニューのISO/
Gain/EIのBase Sensitivityで設定されている
基準感度が表示されます。
Flexible ISO/Cine EI（25ページ）のときは、
MainステータスのBase ISO/Sensitivity、ま
たはフルメニューのShootingメニューのISO/

Gain/EIのBase ISOで設定されているBase ISO
感度が表示されます。

Cine EI Quick（25ページ）のときは、 と
Exposure Indexに連動して自動で設定された
Base ISO感度が表示されます。

32.	ガンマ表示アシスト表示/基本ルック
撮影モード（25ページ）がCustomのときは、
ガンマ表示アシストの状態を表示します。ガ
ンマ表示アシストの表示/非表示は、Gamma 
Display Assistが割り当てられたアサイナブルボ
タン（52ページ）で切り替えることができます。
Log撮影（25ページ）のときは、基本ルックの
設定値を表示します（94ページ）。

33.	記録映像表示（59ページ）
メモリーカードに記録される映像信号を表示しま
す。撮影モード（25ページ）がCustomのとき
は、基本ルックの設定値を表示します。
Log撮影（25ページ）のときは、色域の設定
（88ページ）を表示します。

34.	プロキシ状態表示
表示 意味

プロキシ記録On

プロキシ記録中

 	
（点滅）

プロキシ記録準備中

プロキシ分割記録On
プロキシ分割記録中

 
（点滅）

プロキシ分割記録準備中

35.	記録フォーマット（コーデック）表示
（87ページ）

メモリーカードに記録されるフォーマット名称を
表示します。

36.	記録フォーマット（フレームレートとスキャン
方式）

37.	記録フォーマット（画サイズ）表示（87ペー
ジ）

メモリーカードに記録される画サイズを表示しま
す。

38.	リアルタイムトラッキングAF終了ボタン
（44ページ）
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再生中の画面に表示される情報

再生画像には、次のような情報が重ねて表示されます。

1

9 10 11 12 13 14

2 3 4 5 6 7 8

1.	 ネットワーク状態表示

2.	アップロード中表示/転送ファイル残数表示

3.	 クリップ番号/クリップ総数

4.	再生動作状態表示

5.	 再生フォーマット（フレームレートとスキャン
方式）表示

6.	再生フォーマット（画サイズ）表示

7.	 バッテリー残量/DC IN電圧表示

8.	 再生フォーマット（コーデック）表示

9.	 メディア表示
メモリーカードがプロテクトされている場合は、
 マークが表示されます。

10.	タイムデータ表示

11.	 クリップ名表示

12.	ガンマ表示アシスト表示
撮影モード（25ページ）がCustomのときは、
ガンマ表示アシストの状態を表示します。
Log撮影のときは、適用されたモニター LUTを
表示します。

13.	オーディオレベルメーター
再生オーディオレベルを表示します。

14.	記録映像表示

アイコン表示について

ネットワーク接続のアイコン表示

ネットワークモード 接続状態 アイコン
アクセスポイントモード アクセスポイントとして動作中

アクセスポイント動作エラー

ステーションモード Wi-Fi接続中
電波強度によりアイコンが変化（4段階）

   

Wi-Fi接続断（準備中含む）

Wi-Fi接続エラー

USBテザリング USBテザリング接続中

USBテザリング切断

USBテザリングエラー

UWP-Dシリーズのアイコン表示

送信機の状態 受信状態 アイコン
電源OFF 未受信

通常送信状態 受信中  ～  （受信レベル
を4段階で表示）

ミュート状態 受信中（ミュート中）

バッテリー残量警告状態 受信中  （アイコン点滅）

ミュート、かつバッテリー残量警告状態 受信中  （アイコン点滅）
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ステータス画面

ステータス画面では、本機の設定や状態を確認
することができます。また、*印が付いている項
目については設定を変更できます。
ステータス画面はタッチ操作に対応しています。

ステータス画面を表示させるには
ˎˎ MENU（メニュー）ボタンを押す

［メモ］
TechnicalメニューのMenu Page On/Off（106ページ）
で、各ステータス画面の表示/非表示を切り替えることが
できます。

ステータス画面を切り替えるには
ˎˎ マルチファンクションダイヤルを回す

ˎˎ マルチセレクターを上下に操作する

ˎˎ ステータス画面を上下にスワイプする

ステータス画面を消すには
ˎˎ MENU（メニュー）ボタンを押す

設定を変更するには
ステータス画面の表示中にマルチファンクション
ダイヤルやマルチセレクターを押すと、ページ内
の設定項目を選べるようになります。ページ番号
を選んで押すと、ページ切り替えに戻ります。
なお、タッチ操作で直接選ぶこともできます。

［ご注意］
フルメニューのTechnicalメニュー >Menu Settingsの
User Menu Only（105ページ）をOnにすると、ステータ
ス画面で設定変更できなくなります。

メインステータス画面

カメラの主な機能の設定やメディアの空き状態を
表示します。

表示項目 説明
S&Q Frame 
Rate*

スロー＆クイックモーション撮
影とフレームレートの設定

Frequency/
Scan*

システム周波数と走査方式の
設定

Imager Scan* イメージセンサーの読み出し
モード

Media Remain 
(A)

スロットAのメディアの空き容
量

ND Filter NDフィルターの設定値
ISO/Gain/EI ISO/Gain/Exposure Index

の設定値
Base ISO/
Sensitivity*

Base ISO/Base Sensitivity
の設定

Codec* 記録するコーデックの設定
Media Remain 
(B)

スロットBのメディアの空き容
量

Scene File* 使用中のScene Fileとその
File ID

Base Look/LUT* Base Look/LUTの設定
Shutter シャッタースピードまたは

シャッター角度の設定値
Iris アイリスの設定値
Video Format* メモリーカードに記録する画

サイズ
RAW Output 
Format*

RAW出力の画サイズ

White Balance ホワイトバランスの設定値

カメラステータス画面

主にカメラの各種プリセットの状態を表示しま
す。

表示項目 説明
White 
Switch<B>

ホワイトバランスのメモリー B
の設定値

White 
Switch<A>

ホワイトバランスのメモリーA
の設定値

White 
Switch<P>

Preset Whiteの設定値

ND<Preset> NDフィルターのPreset1 ～ 3
の設定値

ISO / Gain1)<L>* ISO/Gain1)<L>の設定
ISO / Gain1)<M>* ISO/Gain1)<M>の設定
ISO / Gain1)<H>* ISO/Gain1)<H>の設定
Base ISO/
Sensitivity*

Base ISO/Base Sensitivity
の設定

Zebra1* ゼブラ1のOn/Offとレベルの
設定

Zebra2* ゼブラ2のOn/Offとレベルの
設定

VF Gamma/
Gamma

ガンマカテゴリーとカーブ

Scene File* 使用中のScene Fileとその
File ID

1)	 Cine EI/Cine EI QuickのときはExposure Indexとな
ります。

オーディオステータス画面

各チャンネルの入力設定、オーディオレベルメー
ターと音声モニターの設定を表示します。

表示項目 説明
CH1 Level 

Control
自動調節のOn/Off状態

Level 
Meter

オーディオレベルメーター

Source* 入力ソース
Reference* 入力リファレンスレベル
Wind 
Filter*

マイクの風音低減フィルター
の設定

CH2 Level 
Control

自動調節のOn/Off状態

Level 
Meter

オーディオレベルメーター

Source* 入力ソース
Reference* 入力リファレンスレベル
Wind 
Filter*

マイクの風音低減フィルター
の設定

CH3 Level 
Control*

自動調節のOn/Off状態

Level 
Meter*

オーディオレベルメーター

Source* 入力ソース
Reference* 入力リファレンスレベル
Wind 
Filter*

マイクの風音低減フィルター
の設定

CH4 Level 
Control*

自動調節のOn/Off状態

Level 
Meter*

オーディオレベルメーター

Source* 入力ソース
Reference* 入力リファレンスレベル
Wind 
Filter*

マイクの風音低減フィルター
の設定
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表示項目 説明
Audio Input 
Level*

音声入力レベル（マスターボ
リューム）の設定

HDMI Output 
CH*

HDMIに出力される音声チャ
ンネルの設定

Volume* ヘッドホン/内蔵スピーカーの
音量の設定

Monitor CH* モニターするチャンネルの設
定

プロジェクトステータス画面

撮影プロジェクトに関する基本的な設定を表示
します。

表示項目 説明
Frequency/
Scan*

システム周波数と走査方式の
設定

Codec* 記録するコーデックの設定
Rec Function* 特殊な記録機能のOn/Offと

主な設定
Simul Rec* 2スロット同時記録機能の

On/Off状態と設定
Title Prefix1) / 
Reel2)

クリップ名のタイトル部分/
Camera IDとReel Number
の設定値

Imager Scan* イメージセンサーの読み出し
モード

Video Format* メモリーカードに記録する画
サイズ

Picture Cache 
Rec*

ピクチャーキャッシュレック機
能のOn/Offとキャッシュサイ
ズの設定

Number1) / 
Shot2)

クリップ名の最後の数値部分/	
Camera PositionとShot 
Numberの値

Shooting 
Mode*

撮影モードの設定

RAW Output 
Format*

RAW出力の画サイズ

Proxy Rec* プロキシ記録のOn/Offの設
定

1)	 Auto NamingがTitleのとき
2)	Auto NamingがCam ID + Reel#のとき

モニタリングステータス画面

SDI、HDMI出力の設定を表示します。

表示項目 説明
SDI Signal* 出力画サイズ

Info. 
Disp.*

画面表示出力On/Off

Color 
Gamut*

色域の設定値/モニター LUT
の適用状態

HDMI Signal* 出力画サイズ
Info. 
Disp.*

画面表示出力On/Off

Color 
Gamut*

色域の設定値/モニター LUT
の適用状態

Stream Signal 出力画サイズ
Info. 
Disp.

画面表示出力（Off固定）

Color 
Gamut*

色域の設定値/モニター LUT
の適用状態

VF Color 
Gamut*

ガンマ表示アシストの設定値/
色域の設定値/モニター LUTの
適用状態

Base Look/LUT* Base Look/LUTの設定
Gamma Display 
Assist*

Gamma Display Assistの
On/Off状態

アサイナブルボタンステータス画面

各アサイナブルボタンに割り当てた機能を表示し
ます。

表示項目 説明
1 ASSIGN1ボタンに割り当てら

れている機能
2 ASSIGN2ボタンに割り当てら

れている機能
3 ASSIGN3ボタンに割り当てら

れている機能
4 ASSIGN4ボタンに割り当てら

れている機能
5 ASSIGN5ボタンに割り当てら

れている機能
6 ASSIGN6ボタンに割り当てら

れている機能
7 ASSIGN7ボタンに割り当てら

れている機能
8 ASSIGN8ボタンに割り当てら

れている機能
9 ASSIGN9ボタンに割り当てら

れている機能
Focus Hold 
Button

レンズのFocus Holdボタンに
割り当てられている機能

Multi Function 
Dial

マルチファンクションダイヤル
に割り当てられている機能

Grip Dial グリップアサイナブルダイヤル
に割り当てられている機能

Handle Dial ハンドルアサイナブルダイヤル
に割り当てられている機能
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バッテリーステータス画面

バッテリーまたはDC IN電源の情報を表示します。

表示項目 説明
Detected 
Battery

バッテリーの種類

Remaining 残容量（％）
Charge Count 充電を行った回数
Capacity 残容量（Ah）
Voltage バッテリー電圧（V）
Manufacture 
Date

バッテリーの製造年月日

Video Light 
Remaining

ビデオライトバッテリー残量
表示

Power Source 電源供給源
Supplied 
Voltage 

供給電源電圧

メディアステータス画面

記録メディアの残量および残記録可能時間を表
示します。

表示項目 説明
メディアAのメディ
ア情報

スロットAにメディアが挿入さ
れているとき、メディアアイコ
ンを表示する

メディアAの残量
メーター

スロットAに挿入されている記
録メディアの残容量を、残比
率で表したバーで表示する

メディアAの残時
間

現在と同じ状態でスロットA
に挿入されている記録メディ
アに記録したときの予測残時
間を分単位で表示する

Format 
Media(A)*

フォーマット種別（Full 
FormatまたはQuick 
Format）を選択して、メディ
アAを初期化する

メディアBのメディ
ア情報

スロットBにメディアが挿入さ
れているとき、メディアアイコ
ンを表示する

メディアBの残量
メーター

スロットBに挿入されている記
録メディアの残容量を、残比
率で表したバーで表示する

メディアBの残時
間

現在と同じ状態でスロットBに
挿入されている記録メディア
に記録したときの予測残時間
を分単位で表示する

Format 
Media(B)*

フォーマット種別（Full 
FormatまたはQuick 
Format）を選択して、メディ
アBを初期化する

ネットワークステータス画面

ネットワーク接続の接続状態を表示します。

表示項目 説明
Wireless LAN* 無線LANネットワークの動

作モードの設定（Off/AP/
Station）、接続状態

Wired LAN* 有線LANネットワークのOn/
Off、接続状態

Modem* USBテザリングによる無線
ネットワークのOn/Off、接続
状態

ファイル転送ステータス画面

ファイル転送の情報を表示します。

表示項目 説明
Auto Upload Auto UploadのOn/Off状態
Auto Upload 
(Proxy)

Auto Upload (Proxy)のOn/
Off/Chunk状態

Total Transfer 
Progress

総ジョブの転送進捗状況

Default Upload 
Server

Auto Upload (Proxy)の転送
先サーバー名

Job Status 
(Remain / Total)

総ジョブ数と残りのジョブ数

Current File 
Transfer 
Progress

転送中ファイルの転送進捗状
況

Current 
Transferring File 
Name

転送中のファイル名

Server Address ファイル転送先サーバーのア
ドレス

Destination 
Directory

ファイル転送先サーバーの転
送先ディレクトリー
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タッチ操作対応設定画面の使いかた

画面構成
設定項目

直前の設定値
を示す印

Set（決定）	
ボタン

設定値選択
カーソル	
（橙色枠）

設定項目名

設定値の選択肢

操作方法

1	 設定項目をタップする。

タップ
設定値の選択肢が表示されます。

2	 設定値をドラッグまたはフリックして選択す
る。

フリック

3	 Setボタンまたは設定値選択カーソルをタッ
プする。
設定値を確定し元の画面に戻ります。

［メモ］

ˎˎ CANCEL/BACKボタンを押すと直前の設定値に戻りま
す。
ˎˎ マルチファンクションダイヤルやマルチセレクターでも操
作できます。
ˎˎ タッチ操作を無効にすることもできます（105ページ）。
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電源の準備
バッテリーパック、またはACアダプターを介して
AC電源を使用できます。
安全のため、下記ソニー純正以外のバッテリー
パックを使用しないでください。

リチウムイオンバッテリーパック
BP-Uシリーズ

バッテリーチャージャー
BC-U1A
BC-U2A

ACアダプター（付属）

直射日光の下や火気の近くなど、高温のところに
バッテリーを置かないでください。

［ご注意］

ˎˎ AC電源につないで使うときは、付属のACアダプターを
ご使用ください。
ˎˎ バッテリーパックやACアダプターは、必ず本機の
POWERスイッチをOffの位置にしてから脱着してくださ
い。POWERスイッチをOnの位置のまま脱着した場合、
まれに起動しなくなることがあります。もし起動しなく
なった場合には、POWERスイッチをOffの位置にしてか
らバッテリーパックおよびACアダプターを一旦取り外し、
約30秒放置した後に取り付けてください。（バッテリー
パックで動作中の本機にACアダプターを着脱する場合
は、POWERスイッチはOnの位置のままで問題ありませ
ん。）

バッテリーパックを使う

バッテリーパックをバッテリーパック装着部
（7ページ）の奥まで差し込んで、下にスライ
ドさせてロックします。

取り外すときは、BATT RELEASEボタン（7
ページ）を押しながらバッテリーパックを上にスラ
イドさせてロックを外し、引き抜きます。

BATT RELEASE
ボタン

［ご注意］

ˎˎ 装着する前に、専用のバッテリーチャージャー BC‑U1A
またはBC‑U2Aを使用して充電してください。
ˎˎ 使用直後などバッテリーパックの温度が上昇した状態で
充電すると、完全に充電されないことがあります。

残量を確認する

バッテリーパックを使用して撮影・再生している
ときは、ビューファインダー画面（11ページ）
にバッテリー残量が表示されます。

アイコン 意味
100％～ 91％

90％～71％

70％～ 51％

50％～31％

30％～ 11％

10％～ 0％

残量は、現在の消費電流のペースで本機を継続
使用した場合のバッテリーパックの使用可能時間
を計算して、分単位で表示されます。

バッテリーパックの容量が低下すると

使用中にバッテリーパックの容量が一定の値まで
低下すると（Low Battery状態）、バッテリーパッ
クの残りが少ないことを知らせるメッセージが画
面に表示され、記録/タリーランプの点滅で警告
します。
さらに容量が減り、動作が継続不可能な状態に
なると（Battery Empty状態）、バッテリーパック
の残りがないことを知らせるメッセージに切り替
わります。
充電されたバッテリーパックに交換してください。

警告残量を変更する

工場出荷時には、Low Batteryはフル充電の
10%、Battery Emptyは3%に設定されていま
す。これらの設定は、フルメニューのTechnical

メニューのCamera Battery Alarm（107ペー
ジ）で変更することもできます。
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AC電源を使う

バッテリーが切れることを心配しないで使えま
す。

DC IN 端子

ACアダプター

電源コード

ACアダプターを本体のDC IN端子につなぎ、電
源コード（付属）をAC電源に接続します。

ACアダプターの出力電圧が低下する
と

使用中にACアダプターの出力電圧が一定の値ま
で低下すると（DC Low Voltage1状態）、ACアダ
プターの出力電圧が低下していることを知らせる
メッセージが画面に表示され、記録/タリーラン
プの点滅で警告します。
さらに電圧が低下し、動作が継続不可能な状態
になると（DC Low Voltage2状態）、ACアダプ
ターの出力電圧が不足していることを知らせる
メッセージに切り替わります。
ACアダプターが故障している可能性があります
ので、必要に応じて点検を行ってください。

警告電圧を変更する

工場出荷時には、DC Low Voltage1は16.5 V、
DC Low Voltage2は15.5 Vに設定されてい
ます。これらの設定は、Technicalメニューの
Camera DC IN Alarm（107ページ）で変更す
ることもできます。

ACアダプターについて

ˎˎ ACアダプターを壁との隙間などの狭い場所に
設置して使用しないでください。

ˎˎ ACアダプターは手近なAC電源を使用してくだ
さい。本機を使用中、不具合が生じたときは
すぐにAC電源からプラグを抜き、電源を遮断
してください。

ˎˎ ACアダプターのプラグを金属類でショートさ
せないでください。故障の原因になります。

ˎˎ ACアダプターをつないでも本機に装着した
バッテリーを充電することはできません。

ˎˎ ACアダプターを本体から取り外す際はプラグ
部分を持って真っすぐ抜いてください。ケーブ
ル部分を引っ張ると故障の原因になります。
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機器の取り付け・調整
マイク（別売）を取り付ける

1	 マイクをマイクホルダーに取り付ける。

2	 マイクケーブルをINPUT1端子または
INPUT2端子に接続する。

INPUT

1
LINE MIC

+48VMIC

2
LINE MIC

+48VMIC

1

2

マイク

マイク	
ホルダー

INPUT1 INPUT2

3	 図のように、マイクケーブルをケーブルホル
ダーに取り付ける。

ケーブルホルダー

［メモ］

ˎˎ マイクがしっかりと固定できないときは、マイクに付属の
スペーサーを使ってください。
ˎˎ 取り付けるレンズの種類によってはマイクの先端が写り
込んでしまう場合があります。マイクの位置を調整してく
ださい。

ビューファインダーを取り付
ける

［ご注意］
ビューファインダーの取り付け/取り外しは、本機の電源を
切った状態で行ってください。

ハンドルの前部にビューファインダーを
取り付ける

1	 ハンドルのビューファインダー取り付け部に、
ビューファインダー取り付け台座を差し込み
（）、ネジ（付属）を時計方向に回して締める
（）。

取り付け台座は45°きざみで自由に取り付け
が可能ですが、取り付け部が固定ネジの真
上に来る位置を推奨します。
ネジ
ビューファインダー	
取り付け台座

2	 ビューファインダーのクランプ部をビューファ
インダー取り付け台座に差し込み（）、固定
つまみを時計方向に回して締める（）。

［ご注意］
ビューファインダーは固定つまみを確実に締めて使用してく
ださい。固定つまみを確実に締めずに使用すると、ビュー
ファインダーが外れて落下するおそれがあります。

3	 本体の▲マークとビューファインダー接続端
子の▼マークを合わせて、ケーブルを差し込
む。
必ず▼マークが外側になるように、向きを確
認してから差し込んでください。

4	 図のように、ケーブルをケーブルホルダーに
取り付ける。

ケーブルホルダー



2章　準備：機器の取り付け・調整21

ハンドルの後部にビューファインダー
を取り付ける

パンドルの後部（）と本体後部（）にもビュー
ファインダー取り付け部があります（各2箇所）。「ハ
ンドルの前部にビューファインダーを取り付ける」
と同じ方法で取り付けます。

ビューファインダーの位置を調節する

ビューファインダーは上下前後に回して、見やす
い角度に調節することができます。
MIRRORスイッチを使用して、対面撮影などに活
用できます。

［メモ］
本機を使用しない場合や移動する場合などは、図のように
ビューファインダーを閉じて、ビューファインダーを保護す
ることをおすすめします。

ビューファインダーを取り外す

ビューファインダーの固定つまみを緩め、ビュー
ファインダーを取り付けたときと逆の方向に抜き
取ります。

ビューファインダーフードを取
り付ける

1	 ビューファインダーフードの金具を開く。

2	 ビューファインダー上部の取り付けフックに
ビューファインダーフード上部の金具をひっ
かけてから、下部の取り付けフックにビュー
ファインダーフード下部の金具をひっかける。

取り付けフック

3	 ビューファインダーフード下部のロック板を
矢印の方向に押し上げてビューファインダー
フードをロックする。

ロック板

ビューファインダーフードカバーを開く

ビューファインダーフードカバーの中央下部を手
前に引き、上方に開く。

［ご注意］
ビューファインダーを動かすときは、ビューファインダー本
体を持って動かしてください。ビューファインダーフードを
持って動かさないでください。

ビューファインダーフードを取り外す

ビューファインダーフードのロックを解除して
ビューファインダーからビューファインダーフード
を取り外します。
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グリップリモコンを取り付け
る

［ご注意］
グリップリモコンの取り付け/取り外しは、本機の電源を
切った状態で行ってください。

1	 グリップリモコン端子にケーブルを接続す
る。

2	 本体のグリップリモコン取り付け部とグリッ
プのマウント標点を合わせ（）、グリップを
本体にセットして、反時計方向にゆっくり回
す（）。
「カチッ」と音がして、ロックし、取り付けが
完了します。

標点

［ご注意］
正しく装着できない場合は、グリップリモコンや本体に無
理な力を加えないで、取り付けをやり直してください。

3	 手順2で接続したケーブルを図のように、グ
リップリモコンのスリットの下に入れる。

［ご注意］
ケーブルがスリットの下に収まっていないと、グリップの取
り付け角度を変更したときに、ケーブルに無理な力が加わっ
たり、ケーブルが回転部に巻き込まれたりすることがあり
ます。

グリップリモコンの角度を調節する

グリップは撮影スタイルに合わせて、下図の範囲
で角度を変えることができます。

標準位置

レンズ側に回転（最大回転状態：90度）

本体背面側に回転（最大回転状態：83度）

1	 グリップ回転レバーを図の位置にずらし、レ
バーを押したままグリップを回す。

2	 希望の位置付近でグリップ回転レバーから指
を外す。

3	「カチッ」と音がしてグリップが固定されるよ
うに、グリップ位置を微調整する。
グリップが固定されると、グリップ回転レ
バーは元の位置に戻ります。

［ご注意］

ˎˎ 変更後、グリップが固定されたことを必ず確認してくだ
さい。
ˎˎ 変更可能範囲を超えた角度調整はできません。無理に
グリップを回転させないでください。



2章　準備：機器の取り付け・調整23

グリップの握りかた（推奨例）

グリップの握りかたに決まりはありませんが、操
作しやすい握りかたの例を以下に示します。

ASSIGN 5ボタンやマルチセレクターを使
うとき

A：人差し指でグリップアサイナブルダイヤルを
操作する。
B：親指でマルチセレクターとASSIGN 5ボタン
を操作する。
C ： 中指、薬指、小指でグリップをしっかりと握
る。

ズーム操作を行うとき

A：人差し指、中指でズームレバーを操作する。
B：親指でグリップをしっかりと握る。
C：薬指、小指でグリップをしっかりと握る。

グリップを取り外す

［ご注意］
グリップを取り外すときは、必ず本機を机など平らな場所
に置いて行ってください。

1	 グリップリモコン端子からケーブルを抜く。

2	 本体のグリップリモコンリリースボタンを押
しながら、グリップが外れるまで時計方向に
ゆっくり回す。

グリップリモコンリリースボタン

［メモ］
本体のグリップ取り付け部、グリップ側の取り付け部には
ロゼットを取り付けることができます。
ロゼットの購入についてはソニー業務用商品相談窓口まで
お問い合わせください。
‒‒ カメラ本体側：4-546-932-（別売）
‒‒ グリップ側：4-547-089-（別売）
‒‒ 取り付け用ネジ*：	
カメラ本体側：7-627-556-（別売）	
グリップ側：7-627-556-（別売）

*	 ロゼット1つにつきネジは4本必要です（下図ので囲ん
だ部分がネジ穴です）。指定以外のねじを使用すると、
外装部品が破損する恐れがあります。

本体側 グリップ側

レンズを取り付ける

レンズを太陽に向けて放置しないでください。太
陽光がレンズを通して機器内部に焦点を結び、
火災の原因となることがあります。

［ご注意］

ˎˎ レンズの取り付け/取り外しは、本機の電源を切った状
態で行ってください。
ˎˎ レンズは精密部品です。レンズは、マウント部側を下に
して直に置かないでください。必ず付属のキャップをか
ぶせてください。

［メモ］
本機で使用できるレンズについて詳しくは、ソニーのサー
ビス窓口にご相談ください。

Eマウントレンズを取り付ける

1	 本体とレンズから、キャップやカバーを外す。

2	 本体とレンズのマウント標点（白色）を合わせ、
レンズを軽く本体に押し付けながら、時計方
向にゆっくり回す。
「カチッ」と音がしてロックし、取り付けが完
了します。

マウント標点（白色）
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［ご注意］
レンズを取り付けるときは、レンズリリースボタンを押さな
いでください。

Aマウントレンズを取り付ける

Aマウントレンズを取り付けて使用する場合は、
マウントアダプター（別売）を取り付けてからAマ
ウントレンズを装着してください。

［ご注意］
Aマウントレンズ使用時は、アイリスがマニュアルに、フォー
カスがMFになります。

レンズを取り外す

次の手順で取り外してください。

1	 レンズリリースボタンを押したまま、レンズを
しっかりと支えながらレンズを反時計方向に
回す。

2	 レンズを前方に引き抜く。
［ご注意］

ˎˎ レンズを取り外すときは、レンズロックリングの標点と本
体の標点を揃えてください。
ˎˎ レンズを落とさないように、レンズを手でしっかりと持っ
て取り外してください。
ˎˎ 別のレンズをすぐに取り付けないときは、必ずボディ
キャップを取り付けてください。

レンズにAuto Irisスイッチがついてい
る場合のアイリス調節について

ˎˎ レンズのAuto IrisをAUTOにすると、アイリス
の自動調節、または本機からの手動調節操作
が可能です。

ˎˎ レンズのAuto IrisをMANUALにすると、レン
ズリング操作のみ可能となり、本機からのアイ
リス操作を受け付けなくなります。

レンズにフォーカス切り替えスイッチが
ついている場合のフォーカス調節につ
いて

ˎˎ レンズのフォーカス切り替えスイッチを「AF/
MF」または「AF」にすると、フォーカスの自動
調節、またはリモートコントロールユニットか
らの手動調節が可能です。

ˎˎ レンズのフォーカス切り替えスイッチを「MF」に
すると、レンズリング操作、またはリモートコ
ントロールユニットからの手動調節が可能で
す。

	 ［ご注意］
Aマウントレンズ使用時はリモートコントロールユニット
からの手動調節ができない場合があります。

ˎˎ レンズのフォーカス切り替えスイッチを「Full 
MF」にすると、レンズリング操作のみ可能とな
り、本機からのフォーカス操作を受け付けなく
なります。

三脚の取り付けについて

三脚に取り付けるときは、本機の三脚用ネジ穴を
ご使用ください。レンズの三脚座を使用すると、
破損することがあります。

アナモフィックレンズについて

アナモフィックレンズでの撮影時に、HDMI出
力映像をデスクイーズ表示する方法、および
本機のビューファインダーでデスクイーズ表示
をする方法については「デスクイーズ表示設定」
（57ページ）をご覧ください。
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本機の基本動作を設定する
本機を初めて使用するときやバックアップ電池が
放電してしまった後に、初めて本機の電源を入れ
るとビューファインダー画面に初回設定画面が表
示されます。
この画面を使用して内蔵時計の日付/時刻を設定
してください。

Time Zoneについて
UTC（協定世界時）からの時差を設定します。必
要に応じて変更してください。

日付/時刻を設定する

マルチセレクター（7ページ）またはマルチファ
ンクションダイヤル（5ページ）で項目や数値
を選び、マルチセレクターの決定ボタンまたはマ
ルチファンクションダイヤルを押して決定すると、
時計が動き始めます。
設定画面が消えた後は、Maintenanceメニュー
のClock Set（112ページ）を使用してTime 
Zoneおよび日時の設定を変更することができま
す。

［ご注意］

ˎˎ 動作電源が供給されていない（バッテリーパックもDC IN
電源も接続されていない）状態でバックアップ電池が消
耗するなどして現在日時の情報が失われた場合は、次に
電源を入れると初回設定画面が表示されます。
ˎˎ 初回設定画面が表示されている状態では、この画面で
の設定が完了するまで電源を切る以外の操作はできま
せん。
ˎˎ 本機は日時や各種の設定を電源の入/切と関係なく保持
するために、充電式電池を内蔵しています。

撮影を始める前に、運用形態に合わせて、
Projectステータス画面で基本動作の設定を行
います。

撮影モード

本機では現場で自在に映像の作り込みができる
「Custom」と、ポストプロダクション処理を前
提とし、現場では絵作りを行わないフィルムカメ
ラと同等の使い方ができる「Log撮影（Flexible 
ISO、Cine EI Quick、Cine EI）」を切り替えて使
用します。
ProjectステータスのShooting Mode
（15ページ）で切り替えます。

［メモ］
フルメニューのProjectメニュー >Base Settingの
Shooting Mode（87ページ）でも設定できます。

Custom

撮影モードがCustomのときは、映像規格を選
ぶことができます。
フルメニューのProjectメニュー>Base Setting
のTarget Display（87ページ）で切り替えま
す。

ˎˎ SDR(BT.709)：HD放送の規格に準じた撮影

ˎˎ HDR(HLG)：次世代の4K放送の規格に準じた
撮影
その他詳細は59ページをご覧ください。

Log撮影（Cine EI、Cine EI Quick、Flexible ISO）

記録信号および出力信号のベースとなる色域を選択します。ここで選択した色域がMLUTをOffに設定
した映像出力の色域となります。
フルメニューのProjectメニュー>Cine EI/Flex.ISO SetのColor Gamut（88ページ）で切り替えま
す。

ˎˎ S-Gamut3.Cine/SLog3：デジタルシネマの色域（DCI-P3）への調整がしやすい色域

ˎˎ S-Gamut3/SLog3：ソニー独自のITU-R BT.2020をカバーする広い色域
詳しくは「ポストプロダクションでルックを調節する前提で撮影する」（61ページ）をご覧ください。
Log撮影には「Flexible ISO」、「Cine EI」、「Cine EI Quick」の3種類があります。

ˎˎ Flexible ISO：撮影シーンに合わせたISO感度による露出設定でS-Log3の素材を記録します。

ˎˎ Cine EI/Cine EI Quick：選択された基準感度に固定したS-Log3の素材を記録し、Exposure 
Indexによって暗部・明部の配分を変えることができます。Cine EI Quickでは、Exposure Index
の設定に適した基準感度が自動選択されます。

［ご注意］
Cine EI Quick、Cine EIでの記録中は、Exposure Indexの設定を固定にすることをお勧めします。Exposure Indexの
設定を変更してしまうと、ポストプロダクション処理での明るさ補正が非常に難しくなり、撮影時の状態を再現できない恐
れがあります。

撮影モードごとの機能制約は以下のようになります。
Yes：使用可能
No：使用不可

項目 Custom Log撮影
Flexible ISO Cine EI Quick Cine EI

ISO/GAIN Yes Yes（ISOのみ） No No
AGC Yes Yes No No
Base Sensitivity Yes No No No
Base ISO No Yes Yes（自動） Yes
Exposure Index No No Yes Yes
Auto Shutter Yes Yes No No
ATW Yes Yes No No
LUT On/Off No Yes Yes Yes
Paint/Look（Base Lookを除く）Yes No No No
RAWを含んだCodec No Yes Yes Yes
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システム周波数

ProjectステータスのFrequency/Scan
（15ページ）で切り替えます。設定値によって
は、切り替えを実行すると本機が自動的に再起
動します。

［メモ］
フルメニューのProjectメニュー >Rec Formatの
Frequency（87ページ）でも設定できます。

［ご注意］
記録・再生中にシステム周波数を切り替えることはできま
せん。

イメージャースキャンモード

イメージセンサーの有効画サイズと解像度の設
定を行います。
ProjectステータスのImager Scan（15ペー
ジ）で切り替えます。

ˎˎ FF：フルサイズで使用します。

ˎˎ S35：Super 35mmサイズで使用します。

［メモ］
フルメニューのProjectメニュー >Rec FormatのImager 
Scan Mode（87ページ）でも設定できます。

［ご注意］

ˎˎ 記録・再生中にイメージャースキャンモードを切り替える
ことはできません。
ˎˎ S35のとき、ビデオフォーマットは1920×1080に制限
されます。

コーデック

ProjectステータスのCodec（15ページ）で切
り替えます。

［メモ］
フルメニューのProjectメニュー >Rec FormatのCodec
（87ページ）でも設定できます。

［ご注意］
記録・再生中にコーデックを切り替えることはできません。

ビデオフォーマット

記録するビデオフォーマットの設定を行います。
ProjectステータスのVideo Format（15ペー
ジ）で切り替えます。

［メモ］
フルメニューのProjectメニュー >Rec FormatのVideo 
Format（87ページ）でも設定できます。

［ご注意］

ˎˎ 記録・再生中にビデオフォーマットを切り替えることは
できません。
ˎˎ ビデオフォーマットの設定によって、SDI OUTおよび
HDMI OUT端子からの信号も制限されます。
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本機では、撮影した映像・音声を、カードスロット内のCFexpress Type Aメモリーカード（別売）また
はSDXCメモリーカード（別売）に記録します。また、プロキシ記録、設定内容の保存・読み出しと、将
来のバージョンアップ（ソフトウェアアップデート）時にもこれらのメモリーカードを使用します。

CFexpress Type Aメモリーカードについて

本機では、「推奨メディアについて」（28ページ）に記載のソニー製CFexpress Type Aメモリーカー
ド*をご使用ください。
他社製メディアの動作については、各社メディアの取扱説明書やメーカー情報をご確認ください。
* �本書ではCFexpressカードと表現しています。

SDXCメモリーカードについて

本機では、「推奨メディアについて」（28ページ）に記載のSDXCメモリーカード*をご使用ください。
* �本書ではSDカードと表現しています。

メモリーカードを使う
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推奨メディアについて

動作保証条件はRec FormatやRecording設定によって異なります。
Yes：動作を保証
No：保証しない

記録フォーマット CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

RAW Out & 
XAVC-I

4096×2160
Class300

Normal mode 59.94P Yes No No No No No No Yes
50P Yes No No No No No No Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
24P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes

3840×2160
Class300

Normal mode 59.94P Yes No No No No No No Yes
50P Yes No No No No No No Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes

S&Q（60fps以下） 59.94P Yes No No No No No No Yes
50P Yes No No No No No No Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
23.98P Yes No No No No No No Yes

S&Q（100fps、120fps） 59.94P Yes No No No No No No No
50P Yes No No No No No No No
29.97P Yes No No No No No No No
25P Yes No No No No No No No
23.98P Yes No No No No No No No
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記録フォーマット CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 4096×2160
Class300 

Normal mode 59.94P Yes No No No No No No Yes
50P Yes No No No No No No Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
24P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes

S&Q（60fps以下） 59.94P Yes No No No No No No Yes
50P Yes No No No No No No Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
24P Yes No No No No No No Yes
23.98P Yes No No No No No No Yes

3840×2160
Class300 

Normal mode 59.94P Yes No No No No No No Yes
50P Yes No No No No No No Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes

S&Q（60fps以下） 59.94P Yes No No No No No No Yes
50P Yes No No No No No No Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
23.98P Yes No No No No No No Yes

S&Q（100fps、120fps） 59.94P Yes No No No No No No No
50P Yes No No No No No No No
29.97P Yes No No No No No No No
25P Yes No No No No No No No
23.98P Yes No No No No No No No
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記録フォーマット CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 1920×1080
Class100

Normal mode 59.94P Yes No No No No No Yes Yes
50P Yes No No No No No Yes Yes
29.97P Yes No No Yes No Yes Yes Yes
25P Yes No No Yes No Yes Yes Yes
23.98P Yes No No Yes No Yes Yes Yes

S&Q（60fps以下） 59.94P Yes No No No No No Yes Yes
50P Yes No No No No No Yes Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes

S&Q（100fps、120fps） 59.94P Yes No No No No No No Yes
50P Yes No No No No No No Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
23.98P Yes No No No No No No Yes

S&Q（150fps、180fps） 59.94P Yes No No No No No No No
50P Yes No No No No No No No
29.97P Yes No No No No No No No
25P Yes No No No No No No No
23.98P Yes No No No No No No No

S&Q（200fps、240fps） 59.94P Yes No No No No No No No
50P Yes No No No No No No No
29.97P Yes No No No No No No No
25P Yes No No No No No No No
23.98P Yes No No No No No No No
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記録フォーマット CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 3840×2160
420 

Normal mode 59.94P Yes No No Yes No Yes Yes Yes
50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No Yes No Yes Yes Yes
25P Yes No No Yes No Yes Yes Yes
23.98P Yes No No Yes No Yes Yes Yes

S&Q（60fps以下） 59.94P Yes No No Yes No Yes Yes Yes
50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No No Yes

S&Q（100fps、120fps） 59.94P Yes No No No No No Yes Yes
50P Yes No No No No No Yes Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
23.98P Yes No No No No No No No

1920×1080
HD50

Normal mode 59.94P Yes No No Yes No Yes Yes Yes
50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No Yes No Yes Yes Yes
25P Yes No No Yes No Yes Yes Yes
23.98P Yes No No Yes No Yes Yes Yes

S&Q（60fps以下） 59.94P Yes Yes Yes Yes Yes Yes Yes Yes
50P Yes Yes Yes Yes Yes Yes Yes Yes
29.97P Yes No No Yes No Yes Yes Yes
25P Yes No No Yes No Yes Yes Yes
23.98P Yes No No Yes No Yes Yes Yes

S&Q（100fps、120fps） 59.94P Yes No No Yes No Yes Yes Yes
50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes
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記録フォーマット CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 1920×1080
HD50

S&Q（150fps、180fps） 59.94P Yes No No No No No Yes Yes
50P Yes No No No No No Yes Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
23.98P Yes No No No No No No Yes

S&Q（200fps、240fps） 59.94P Yes No No No No No Yes Yes
50P Yes No No No No No Yes Yes
29.97P Yes No No No No No No Yes
25P Yes No No No No No No Yes
23.98P Yes No No No No No No Yes

1920×1080
HD35

Normal mode 59.94P Yes Yes Yes Yes Yes Yes Yes Yes
50P Yes Yes Yes Yes Yes Yes Yes Yes
29.97P Yes Yes Yes Yes Yes Yes Yes Yes
25P Yes Yes Yes Yes Yes Yes Yes Yes
23.98P Yes Yes Yes Yes Yes Yes Yes Yes

S&Q（60fps以下） 59.94P Yes Yes Yes Yes Yes Yes Yes Yes
50P Yes Yes Yes Yes Yes Yes Yes Yes
29.97P Yes No No Yes No Yes Yes Yes
25P Yes No No Yes No Yes Yes Yes
23.98P Yes No No Yes No Yes Yes Yes

S&Q（100fps、120fps） 59.94P Yes No No Yes No Yes Yes Yes
50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No Yes No Yes Yes Yes
25P Yes No No Yes No Yes Yes Yes
23.98P Yes No No No No No Yes Yes

S&Q（150fps、180fps） 59.94P Yes No No Yes No Yes Yes Yes
50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No Yes Yes
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記録フォーマット CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 1920×1080
HD35

S&Q（200fps、240fps） 59.94P Yes No No Yes No Yes Yes Yes
50P Yes No No Yes No Yes Yes Yes
29.97P Yes No No No No No Yes Yes
25P Yes No No No No No Yes Yes
23.98P Yes No No No No No No Yes
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メモリーカードを入れる

1	 カードスロット部のメディア蓋を開ける。

2	 メモリーカードを差し込む。
ˎˎ CFexpressカードの場合はラベルを左に
する。

ラベル

ˎˎ SDカードの場合はラベルを右にして切り
欠き部を下にする。

切り欠き部

アクセスランプ（6ページ）が赤く点灯し、
使用可能な状態になると緑で点灯します。

	 ［ご注意］
アクセスランプの赤い点滅が長く続き緑点灯にならな
い場合は、一度電源を切りメモリーカードを抜き差し
することで、緑点灯になる可能性があります。

3	 メディア蓋を閉める。
［ご注意］

ˎˎ 誤った向きで無理に入れると、メモリーカードやメモリー
カードスロット、画像データが破損することがあります。
ˎˎ CFexpress Type A/SDカードスロット（A）/（B）両方に
メディアを挿入して記録を行う際には、どちらのスロッ
トにも、記録するフォーマットに対して動作が推奨され
ているメディアを挿入してください。

メモリーカードを取り出す

カードスロット部のメディア蓋を開け、メモリー
カードを軽く1回押して取り出します。

［ご注意］

ˎˎ メモリーカードにアクセス中に本機の電源を切ったりメ
モリーカードを抜いた場合はデータは保証されません。
カードに記録されたすべてのデータが壊れる可能性があ
ります。電源を切ったり、カードを抜くときは、必ず使
用するメモリーカードのアクセスランプが緑で点灯また
は消灯していることを確認してから操作してください。
ˎˎ 記録終了後にメモリーカードを取り出した際、メモリー
カードが熱くなっている場合がありますが故障ではあり
ません。

メモリーカードをフォーマット
（初期化）する

フォーマットされていないメモリーカード、また
は別の仕様でフォーマットされたメモリーカード
を装着すると、メッセージ「フォーマットが必要な

メディアです」がビューファインダー画面に表示さ
れます。
下記の手順に従ってフォーマットしてください。

1	 Mediaステータス、またはフルメニュー
のTC/MediaメニューのFormat Media
（98ページ）を選択する。

2	 Media（A）（スロットA）またはMedia（B）（ス
ロットB）を選択して、フォーマット種別（Full 
FormatまたはQuick Format）を選択する。
確認メッセージが表示されます。

ˎˎ Full Format：メディアのデータ管理情報
だけでなくデータ領域を含む全体を初期化
します。

ˎˎ Quick Format：メディアのデータ管理情
報を初期化します。

	 ［ご注意］
フォーマット対象のメモリーカードに転送対象ファイ
ルが存在する場合は、確認メッセージの下に補足メッ
セージ（表示例：転送対象のファイルが存在します）が
表示されます。この場合は、メモリーカードを初期化
してよいかどうかを確認してから、初期化を実行また
はキャンセルしてください。

3	 Executeを選択する。
実行中はメッセージが表示され、アクセスラ
ンプが赤く点灯します。
フォーマットが終了すると、完了メッセージ
が表示されますので、マルチファンクション
ダイヤルを押して消します。

［ご注意］

ˎˎ メモリーカードをフォーマットすると、記録された映像
データ、セットアップファイルなどを含む、すべてのデー
タが消去されます。
ˎˎ フォーマットの処理時間によっては、実行中のメッセー
ジが表示されない場合があります。

フォーマットできなかったときは

本機で使用できないメモリーカードはフォーマッ
トできません。
警告メッセージが表示されますので、メッセージ
に従って、使用できるメモリーカードに交換して
ください。

本機でフォーマットしたメディアを他
の機器で使用するには

あらかじめバックアップを取り、お使いになる機
器でフォーマットし直して使用してください。

残りの記録可能時間を確認
する

撮影中（記録中/記録待機中）は、ビューファイン
ダー画面（11ページ）のA/Bスロットメディア
残量表示部で、各スロットに装着したメモリー
カードの残量を確認することができます。
現在設定されているビデオフォーマット（記録ビッ
トレート）で撮影した場合に記録可能な時間を、
それぞれのスロット内のメディアの残量から計算
して分単位で表示します。

メモリーカードの交換時期

ˎˎ 記録中に2枚のメモリーカードの残記録可能時
間の合計が5分を切ると、警告メッセージ「メ
ディア残量がわずかです」（Media Near Full）
が表示され、記録/タリーランプの点滅とブザー
音（ヘッドホン出力）で警告します。	
空きのあるメディアに交換してください。
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ˎˎ 記録を継続して、残記録可能時間の合計が0
になると、メッセージが「メディア残量がありま
せん」（Media Full）に変わり記録が停止しま
す。

［ご注意］
1枚のメモリーカードに約600個までのクリップを記録でき
ます。

メモリーカードを修復する

何らかの原因でメモリーカード内のデータに異常
が発生した場合は、メモリーカードの修復が必
要になります。
修復が必要なメモリーカードを挿入したときは、
修復を実行するかどうかを確認するメッセージが
ビューファインダー画面に表示されます。

修復を実行する

マルチファンクションダイヤル（5ページ）で
Executeを選択し、マルチファンクションダイヤ
ルを押します。
実行中メッセージと進捗状況（％）が表示され、
アクセスランプが赤く点灯します。
修復が終了すると、完了メッセージが表示されま
す。

修復できなかったときは

ˎˎ エラーが発生したメモリーカードは修復できま
せん。警告メッセージが表示されますので、メッ
セージに従って別のメモリーカードに交換して
ください。

ˎˎ エラーが発生したメモリーカードは、フォーマッ
トをし直すと再利用できる場合があります。

ˎˎ 一部のクリップのみが修復できない場合もあり
ます。修復できたクリップは再生可能になりま
す。

［ご注意］

ˎˎ 本機で記録されたメディアは、本機で修復してください。
ˎˎ 本機以外で記録されたメディアや、本機と同一機種で
あってもバージョンが異なる機器で記録されたメディア
は、本機では修復できない場合があります。
ˎˎ 2秒以下のクリップは修復できません。
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基本操作手順
基本的な撮影は次の手順で行います。

1	 必要な機器が取り付けられ、電源が供給さ
れていることを確認する。

2	 メモリーカードを入れる。

3	 POWERスイッチをOnにする。
POWERランプが点灯して、ビューファイン
ダーに撮影画面が表示されます。

4	 録画START/STOPボタン（5ページ）を
押す。
記録/タリーランプが点灯して、記録が始ま
ります。

5	 記録を終了するときは、もう一度録画
START/STOPボタンを押す。
記録が停止し、本機はSTBY（記録待機）モー
ドになります。

［ご注意］
電源を入れてから数秒以内に録画START/STOPボタンを
押すと、記録/タリーランプが点灯し録画状態になりますが、
選択している記録フォーマットによっては最初の数秒間はメ
ディアに記録されない場合があります。

メモリーカードを切り替える

メモリーカードが2枚装着されているときは、
SLOT SELECTボタン（6ページ）を押して切り
替えます。
撮影中にメモリーカードA（またはメモリーカード
B）の残量がなくなる直前に、自動的にもう一方
のメモリーカードへの記録に切り替わります（リ
レー記録）。メモリーカードが切り替わるたびに、
記録済みのメモリーカードを新しいメモリーカー
ドに交換することで、中断することなく撮影を続
けられます。

［ご注意］

ˎˎ 再生中にメモリーカードを切り替えることはできません。
またスロットAとスロットBをまたぐ連続再生はできませ
ん。
ˎˎ 切り替え先のスロットに記録可能なメモリーカードが
入っていても、そのメモリーカードにプロキシデータの
みを記録する場合は、メモリーカードは切り替わりませ
ん。

クリップ（記録データ）
記録を停止すると、開始から停止までの画像・音
声と付随データが、1つの「クリップ」としてメモリー
カードに記録されます。

クリップ名について
本機で記録されるクリップの名前は、フルメ
ニューのTC/MediaメニューのClip Name 
Format（97ページ）で設定された形式でつけ
られます。

クリップの最大時間
1クリップあたり6時間までです。
動画の連続撮影可能時間は、クリップの最大記
録時間と同様です。録画時間がクリップの最大時

間を超える場合、録画を継続したまま自動的に新
しいクリップが作られます。新しいクリップはサム
ネイル画面で別のクリップとして確認できます。

リレー記録では複数のクリップに連続記録します
が、約24時間で自動的に停止します。

［ご注意］

ˎˎ 記録中のメモリーカードを取り出さないでください。記
録中にメモリーカードを入れ替えるときは、スロットの
ランプが消灯しているスロットのみ行ってください。
ˎˎ 記録中のメモリーカードの残量が1分未満のときに、も
う一方のスロットに記録可能なメモリーカードが入って
いると、メッセージ「まもなくスロットを切り替えます」
が表示されます。メモリーカードスロットが切り替わる
と消えます。
ˎˎ メモリーカードの残量が1分未満のときに記録を始める
と、リレー記録ができない場合があります。リレー記録
を正しく行うには、記録開始時にメモリーカードの残量
が1分以上あることを確認してください。
ˎˎ 本機を使ってリレー記録した動画は、本機上ではシーム
レス再生できません。
ˎˎ 本機を使ってリレー記録した動画を結合するには、ソフ
トウェア「Catalyst Browse」を使用してください。

音声を聞く

記録される音声をヘッドホンでモニターできます。
ヘッドホン端子（5ページ）にヘッドホンをつ
なぐと、記録される音声をモニターできます。また、
再生時（72ページ）は内蔵スピーカー（6
ページ）またはヘッドホンでモニターできます。
モニターする音声の音量の調整は、Audioス
テータスのVolume（14ページ）、またはフル
メニューのAudioメニュー>Audio Outputの
Volume（103ページ）で行います。
モニターするチャンネルの選択は、Audioステー
タスのMonitor CH（14ページ）、またはフル

メニューのAudioメニュー>Audio Outputの
Monitor CH（103ページ）で行います。

タイムデータ

タイムコードを設定する

記録されるタイムコードは、フルメニューのTC/
MediaメニューのTimecode（97ページ）で設
定します。

ユーザービットを設定する

8桁の16進数をユーザービットとして記録映像に
付加できます。ユーザービットを現在時刻に設
定することも可能です。TC/Mediaメニューの
Users Bit（97ページ）で設定します。

タイムデータを表示する

表示するタイムコードは、TC/Mediaメニューの
TC Display（97ページ）のDisplay Selectで
設定します。
DURATION/TC/U-BIT機能が割り当てられたア
サイナブルボタン（52ページ）を押すと、表示
がタイムコード、ユーザービット、経過時間の順
に切り替わります。

タイムコードの入力/出力を切り替える

TC IN/OUT切り替えスイッチ（4ページ）で、
タイムコードの入力/出力を切り替えることができ
ます。
詳しくは123ページをご覧ください。
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記録内容を確認する（レック
レビュー）

直前に記録したクリップの映像を画面で確認
（レックレビュー）できます。

［ご注意］
記録後にビデオフォーマットを変更したときは、レックレ
ビューはできません。

レックレビューの方法

事前にアサイナブルボタンのいずれかにRec 
Reviewを割り当てておきます。
記録を停止したら、Rec Reviewが割り当てられ
たアサイナブルボタン（52ページ）を押します。
すると、直前に記録したクリップの再生が始まり
ます。
クリップの終わりまで再生すると、レックレビュー
は終了し、STBY（記録待機）モードに戻ります。

レックレビューを中止するには

Rec Reviewが割り当てられたアサイナブルボタ
ンまたはCANCEL/BACKボタンを押します。

レックレビューの設定

TechnicalメニューのRec Review（105ペー
ジ）の設定により、再生開始位置を次のいずれか
に設定できます。

ˎˎ クリップの最後の3秒

ˎˎ クリップの最後の10秒

ˎˎ クリップの先頭から

［メモ］
撮影した複数のクリップから任意のクリップを確認したい
場合は、THUMBNAILボタンを押してサムネイル画面から
クリップを選択して再生を開始することができます。
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撮影時の状況に応じて、ズームを調節します。

電動ズームレンズを装着したとき、グリップリモ
コンまたはハンドル部のズームレバーでズーム操
作ができます。レバーを押し込む量に応じてズー
ムスピードが変化します。
本機は、全画素超解像という画像処理技術によ
るズーム機能を搭載しています。全画素超解像
ズームを有効にすると、単焦点レンズでもズーム
ができるようになります。また、電動ズームレン
ズでは光学望遠端からさらに寄ることができま
す。
全画素超解像ズームの最大倍率は、記録解像度
により異なります。

ˎˎ 記録解像度QFHD/4Kのとき：1.5倍

ˎˎ 記録解像度HDのとき：2倍

ズームの種類を選ぶ

フルメニューのTechnicalメニュー>Zoomの
Zoom Type（105ページ）でズームの種類を設
定します。
装着するレンズの種類によって以下のように異な
ります。

装着する	
レンズ

Zoom Typeの設定
Optical Zoom 
Only

On(Clear Image 
Zoom)

単焦点レ
ンズ/手動
ズームレン
ズ

レバーによるズー
ム操作はできな
い。

全画素超解像
ズームができる。

電動ズーム
レンズ

光学ズームのみ 光学ズームと全画
素超解像ズーム
ができる。

［ご注意］

ˎˎ 以下の場合、全画素超解像ズームは使えません。
–– フルメニューのShootingメニュー >S&Q Motionの
Frame Rate（85ページ）が60fpsを超えるとき
–– フルメニューのProjectメニュー >Rec Formatの
Codec（87ページ）でRAWまたはRAWを含んだ
選択肢を設定中

ˎˎ レンズのSERVO/MANUAL切り替えスイッチを切り替え
ると、全画素超解像ズームの倍率は1倍にリセットされ
ます。
ˎˎ 全画素超解像ズーム中にプッシュオートフォーカス（AF-
S）を実行した場合、画面中央付近を優先したAF動作と
なります。

ハンドルズームを設定する

フルメニューのTechnicalメニューのHandle 
Zoom（105ページ）でハンドル部のズームレバー
の設定を行います。

ズームリングの回転方向を設
定する

一部のEマウントレンズでは、ズームリングの回
転方向を逆にすることができます。
フルメニューのTechnicalメニュー>Lensの
Zoom Ring Direction（106ページ）で設定し
ます。

ズームを調節する
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フォーカスを調節する
撮影時の状況に応じて、フォーカスを自動または
手動で調整します。

フォーカスを手動調節する（マ
ニュアルフォーカス）

フォーカスを手動調整するには、FOCUSスイッチ
（4ページ）を「MAN」に設定します。
撮影状況に応じて、手動でフォーカス合わせが
できます。
以下のようなときに使います。

ˎˎ 水滴の多い被写体

ˎˎ 背景とコントラストの弱い被写体

ˎˎ 意図的にフォーカスを手前の被写体から奥の
被写体に送るとき

［メモ］
手動調節を基本オペレーションとして、オートフォーカスを
補助的に効かせることもできます。
ˎˎ AF乗り移り感度設定を1(Locked)にする
ˎˎ FOCUSスイッチを「AF」に設定する
ˎˎ フォーカスリングを操作する（AF Assist、42ページ）

タッチ操作でフォーカスを合わせる（ス
ポットフォーカス）

マニュアルフォーカス時、ピントを合わせたい位
置をタッチ操作で指定すると、フォーカスを合わ
せることができます。
スポットフォーカスを使用するには、Shootingメ
ニューのFocusのTouch Function in MF（85
ページ）をSpot Focusに設定します。
ピントを合わせたい位置をタップすると、スポッ
トフォーカスマークが表示されます。

［メモ］

ˎˎ スポットフォーカス中にPush AF/Push MFが割り当て
られたアサイナブルボタン（52ページ）押すとスポット
フォーカスを終了し、そのボタンを押している間はオート
フォーカスになります。ボタンから指を離すと、マニュア
ルフォーカスに戻ります。
ˎˎ レンズ側でマニュアルフォーカスに設定されていると、
スポットフォーカスは動作しません。
ˎˎ フルメニューのMonitoringメニュー >De-Squeeze
（99ページ）でOff(1.0x)以外を選択していると、ス
ポットフォーカスは動作しません。
ˎˎ ピント拡大中、またはTechnicalメニューのTouch 
Operation（105ページ）がOffのときは、スポット
フォーカスの位置指定操作はできません。

一時的に自動でフォーカスを合わせる
（プッシュオートフォーカス（AF））

フルメニューのShootingメニュー>Focusの
Push AF Mode（85ページ）でAFを選択し、
マニュアルフォーカス中にPUSH AUTO FOCUS
ボタン（4ページ）を押すと、そのボタンを押
している間はオートフォーカスになります。
フルメニューのShootingメニュー>Focusの
Focus Area（85ページ）で設定したフォーカ
スエリア内でフォーカスを合わせます。
ボタンから指を離すと、マニュアルフォーカスに
戻ります。
マニュアルフォーカス中に、ある被写体から別の
被写体にゆっくりとフォーカス送りするような場
合に有効です。

［メモ］
Push AF/Push MFが割り当てられたアサイナブルボタン
（52ページ）でも同様の動作が可能です。

［ご注意］

ˎˎ レンズ側でマニュアルフォーカスに設定されていると、
プッシュオートフォーカスは動作しません。
ˎˎ フルメニューのMonitoringメニュー >De-Squeeze
（99ページ）でOff(1.0x)以外を選択していると、プッ
シュオートフォーカスは動作しません。

迅速に自動でフォーカスを合わせる
（プッシュオートフォーカス（AF-S））

フルメニューのShootingメニュー>Focusの
Push AF Mode（85ページ）でSingle-shot 
AF(AF-S)を選択し、フルメニューのShootingメ
ニュー>FocusのFocus Area(AF-S)（85ペー
ジ）でフォーカスを合わせる位置を設定します。
マニュアルフォーカス中にPUSH AUTO FOCUS
ボタンを押すと、最速でオートフォーカスを行い
ます。なお、合焦前に離すと中止します。
フォーカスインジケーター表示にてフォーカス合
わせの状況を表示します。

ˎˎ 点灯：フォーカスが合焦した位置で固定されて
います。

ˎˎ 点滅：フォーカスが合っていません。自動で
フォーカスを合わせられないので、構図や
フォーカス設定などを変更してください。
ボタンから指を離すとマニュアルフォーカスに戻
ります。
撮影する前にフォーカスをさっと合わせておきた
いときに使うと便利です。

［メモ］

ˎˎ Push AF/Push MFが割り当てられたアサイナブルボタ
ン（52ページ）でも同様の動作が可能です。
ˎˎ アサイナブルボタン（52ページ）にPush AF Modeを
割り当てることもできます。

ˎˎ アサイナブルボタン（52ページ）にFocus Area(AF-S)
を割り当てることもできます。
ˎˎ フルメニューのMonitoringメニュー >Display On/Off
のFocus Area Ind.(AF-S)（99ページ）で、フォーカ
スエリア枠表示をOn/Offすることができます。
ˎˎ ピント拡大中は拡大表示している位置にフォーカスを合
わせます。

［ご注意］

ˎˎ レンズ側でマニュアルフォーカスに設定されていると、
プッシュオートフォーカスは動作しません。
ˎˎ フォーカスエリア枠はDISPLAYボタンでは非表示になり
ません。
ˎˎ 	全画素超解像ズーム中は、Focus Area(AF-S)の枠位置
設定はできません。また、Push AF-S実行時は中央付
近を優先したAF動作となります。
ˎˎ フルメニューのMonitoringメニュー >De-Squeeze
（99ページ）でOff(1.0x)以外を選択していると、プッ
シュオートフォーカスは動作しません。

拡大表示をしてフォーカスを合わせる
（ピント拡大）

工場出荷時はグリップリモコンのASSIGN4
ボタンとハンドルのASSIGN7ボタンにFocus 
Magnifier ×3/×6が割り当てられています
（52ページ）。
ASSIGN4ボタンまたはASSIGN7ボタンを押す
と、ビューファインダー画面がピント拡大画面に
切り替わり、画面中央が約3倍に拡大されます。
もう一度押すと約6倍に拡大されます。フォーカ
スが合っているかを確認するときに便利です。
もう一度押すと元に戻ります。
ピント拡大中にマルチセレクター（7ページ）
で拡大位置を移動できます。マルチセレクターを
押すと中央に戻ります。
ピント拡大中にプッシュオートフォーカス(AF)を
実行すると、フルメニューのShootingメニュー
>FocusのFocus Area（85ページ）で設定した
フォーカスエリア内でフォーカスを合わせます。
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ピント拡大中にプッシュオートフォーカス(AF-S)
を実行すると、ピント拡大表示している位置に
フォーカスを合わせます。

［ご注意］

ˎˎ ピント拡大で表示されていても、記録される画像やSDI
出力、HDMI出力の画像は拡大されません。
ˎˎ ピント拡大中は、MENUボタン操作など、無効になる操
作があります。
ˎˎ 拡大位置は本機の電源を切ると画面中央に戻ります。

フォーカスを自動調節する
（オートフォーカス）

本機は、高速性に優れる位相差AF方式と、高い
精度でフォーカスを合わせることに優れるコント
ラストAF方式を採用しています。
これらの2つのAF方式を組み合わせることで、高
速性・高精度を両立したオートフォーカスを実現
しています。
フォーカスを自動調整するには、本機のFOCUS
スイッチ（4ページ）を「AUTO」に設定しま
す。レンズにフォーカス切り替えスイッチがある
場合はあらかじめ「AF/MF」または「AF」に設定し
てください。「Full MF」または「MF」の場合、レン
ズは本機からのフォーカス指示を受け付けません
（24ページ）。

［メモ］
フルメニューのShootingメニュー >FocusのAF Assist
（85ページ）をOnに設定すると、オートフォーカス中で
もレンズのフォーカスリングでフォーカスを動かすことがで
きます。

［ご注意］

ˎˎ オートフォーカスに対応したレンズが必要です。
ˎˎ 撮影状況により精度が出ない場合があります。
ˎˎ Aマウントレンズではフォーカスを自動調節できません。
ˎˎ MonitoringメニューのDe-SqueezeのRatio (HDMI/
VF)（99ページ）がOff(1.0x)以外のときは、オート
フォーカスは使用できません。

オートフォーカスの対象領域/位置を
設定する（フォーカスエリア）

フルメニューのShootingメニュー>Focusの
Focus Area（85ページ）でオートフォーカスの
対象とする領域を設定できます。

Flexible Spot：
映像の指定した位置にフォーカスを合わせます。
選択後、マルチセレクター（7ページ）で位
置を指定します。
マルチセレクターを長押しすると中央の位置に戻
ります。

Zone：
指定したゾーン内から自動でフォーカスを合わせ
る位置を探します。
選択後、マルチセレクター（7ページ）で位
置を指定します。
マルチセレクターを長押しすると中央の位置に戻
ります。

Wide：
映像全域からフォーカスを合わせる位置を探しま
す。枠は表示されません。

［メモ］
Focus Areaを割り当てたアサイナブルボタン（52ペー
ジ）でも同様の動作が可能です。
フルメニューのMonitoringメニュー >Display On/Offの
Focus Area Indicator（99ページ）で、フォーカスエリ
ア枠表示をOn/Offすることができます。

［ご注意］
フォーカスエリア枠はDISPLAYボタンでは非表示になりま
せん。

フォーカスエリアをすばやく変更する
(フォーカスセット)

アサイナブルボタン（52ページ）にFocus 
Settingを割り当てると、撮影中などにオート
フォーカスの対象領域（フォーカスエリア）の位置
や大きさをすばやく変更することができます。
フォーカスエリアの設定により動作が変わりま
す。

フルメニューのShootingメニュー
>FocusのFocus Area（85ページ）が
Flexible SpotまたはZoneの場合：
Focus Settingを割り当てたアサイナブルボタン
を押すと、マルチセレクター（7ページ）で
フォーカスエリアの位置を変更することができま
す。
位置変更中にマルチセレクターを押すと、フォー
カスエリアの位置が中央に戻ります。
Focus Settingを割り当てたアサイナブルボタン
を長押しするとフォーカスエリアの大きさを変更
することができます。
大きさを変更後、マルチセレクターを押すと
フォーカスエリアの位置を設定します。
設定の変更が終了したら、Focus Settingを割
り当てたアサイナブルボタンを押して元の画面に
戻ります。
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フルメニューのShootingメニュー
>FocusのFocus Area（85ページ）が
Wideの場合：
Focus Settingを割り当てたアサイナブルボタン
の長押しによるフォーカスエリアの大きさ変更の
み可能です。種別をFlexible SpotまたはZone
に変更すれば、続けて位置変更も可能です。

［メモ］

ˎˎ フルメニューのShootingメニュー >FocusのPush AF 
Mode（85ページ）がSingle-shot AF(AF-S)かつ、
FOCUSスイッチ（4ページ）がMFの場合は、Focus 
Area(AF-S)（85ページ）のフォーカスエリア位置を変
更することができます。
ˎˎ フォーカスエリアの位置変更が可能な場合は、フォーカ
スエリア枠がオレンジ色で表示されます。

フォーカスエリア枠をタッチ操作で移
動する（タッチフォーカスエリア）

Focus Settingを割り当てたアサイナブルボタン
（52ページ）を押すなどしてフォーカスエリア
の表示をオレンジにしたとき、タッチ操作で移動
できます。
タップした場所をフォーカスエリアの中心とし、
フォーカスエリアの位置を移動します。ドラッグ
すると、フォーカスエリアの位置は指の動きに追
従して移動します（10ページ）。

［メモ］
撮像画面ではFocus Settingを割り当てたアサイナブルボ
タンの操作で、タッチフォーカス操作の有効・無効を切り
替えることができます。

任意の位置をタップする

タップした位置をフォーカスエリアの中心として
位置を移動する

ドラッグで指先を追従し、フォーカスエリアの
位置を移動する

［ご注意］

ˎˎ 	タップまたはドラッグした位置がフォーカスエリアの位
置の設定範囲を超えた場合、フォーカスエリアの位置は
設定範囲内の上下左右端に設定されます。
ˎˎ 	以下の場合、この機能は使えません。
–– フルメニューのTechnicalメニューのTouch 
Operation（105ページ）がOffの場合
–– フォーカスエリア枠がグレーまたは非表示の場合

オートフォーカスの動作の調節をする
（AFトランジション速度、AF乗り移り
感度）

AFトランジション速度
フルメニューのShootingメニュー>FocusのAF 
Transition Speed（85ページ）で、被写体が
移り変わる際のフォーカス駆動の速さを設定す
ることができます。
低速側に設定すると被写体の移り変わり時に
ゆっくりとフォーカス送りし、印象的な映像表現
を可能にします。
高速側に設定すると被写体間のフォーカス送り
がすばやくなります。フレームに入った被写体に
すぐにフォーカスが合うので、すばやいフォーカ
ス合わせが要求されるドキュメンタリー撮影など
に効果的です。

乗り移り中
1(低速)：フォーカスがゆっくり動く
・
・
・
7(高速)：フォーカスがすばやく動く

奥の被写体に合焦している

手前の被写体に合焦
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AF乗り移り感度
フルメニューのShootingメニュー>FocusのAF 
Subj. Shift Sens.（85ページ）で、被写体の
乗り移り感度を設定することができます。
粘る側に設定するとフォーカスの合っている被写
体の前に別の被写体が来てもフォーカスが移りに
くくなり、敏感側に設定すると手前に来た被写体
を優先してフォーカスが移りやすくなります。

［メモ］
AF Speed/Sens.を割り当てたアサイナブルボタンを押す
たびに、調整用のレベルバーが以下の順で表示され、AF
トランジション速度とAF乗り移り感度の設定を変更できま
す。
AFトランジション速度→AF乗り移り感度→非表示・・・

AF Subj. Shift Sens.: 1（粘る） AF Subj. Shift Sens.: 5（敏感）

別の被写体にフォーカスが移りにくい 別の被写体にフォーカスが移りやすい

手動でフォーカス対象を変更する（AF 
Assist）

フルメニューのShootingメニュー>FocusのAF 
Assist（85ページ）をOnに設定すると、オー
トフォーカス中でもレンズのフォーカスリングを操
作して任意の被写体にフォーカスを合わせること
ができます。
フォーカスリングの操作を止めると、フォーカス
リングで合わせた被写体にオートフォーカスしま
す（AFアシスト状態）。
フルメニューのShootingメニュー>Focus>AF 
Subj. Shift Sens.（85ページ）の設定に関わ
らず、フォーカスリング操作後はフォーカスが乗
り移りにくくなります。
以下の場合、AFアシスト状態は解除されます。

ˎˎ フォーカスリングで合わせた被写体を見失った
とき

ˎˎ マニュアルフォーカスにしたとき

ˎˎ リアルタイムトラッキングAFを開始したとき

［メモ］

ˎˎ Push AF/Push MFが割り当てられたアサイナブルボタ
ン（52ページ）を使うと、AFアシスト状態を素早く解
除できます。
ˎˎ フォーカスリングを操作すると、リアルタイムトラッキン
グAFは終了します。
ˎˎ 顔/瞳限定AFの場合、フォーカスリングを操作すると一
番近い顔にオートフォーカスします。
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一時的に手動でフォーカスを合わせる
（プッシュマニュアルフォーカス）

オートフォーカス中に、PUSH AUTO FOCUSボ
タン（4ページ）を押すと、そのボタンを押し
ている間はマニュアルフォーカスになります。
ボタンから指を離すと、オートフォーカスに戻り
ます。
被写体の手前を撮影対象でないものが横切ると
きなどに、一時的にオートフォーカスを止めて手
動でフォーカスを合わせることができます。

［メモ］
Push AF/Push MFが割り当てられたアサイナブルボタン
（52ページ）でも同様の動作が可能です。

顔や瞳を検出して追尾する
（顔/瞳検出AF）

人物の顔や瞳を追尾対象として検出し、フォーカ
スエリア内にある顔や瞳にフォーカスを合わせ続
けることができます。
フォーカスモードがAFモードまたはプッシュオー
トフォーカス中のみ使用できます。
顔を検出すると灰色の顔/瞳検出枠が表示され、
オートフォーカス可能と判断されると枠が白色に
なり、追尾が開始されます。さらに瞳を検出し
フォーカスが合うと、瞳に顔/瞳検出枠が表示さ
れます。複数の人物を検出したときは、主な被写
体は自動的に決定します。

［メモ］

ˎˎ フォーカスエリアがZoneまたはFlexible Spotに設定さ
れているときは、設定したフォーカスエリアの範囲に顔
や瞳が重なっているときに、顔/瞳検出枠が白色になり、
その顔や瞳へのオートフォーカスが可能となります。
ˎˎ プッシュオートフォーカス（AF-S）実行時、フォーカスが
合った顔/瞳検出枠は緑色になります。

ShootingメニューのFocusのFace/Eye 
Detection AF（85ページ）で、顔/瞳検出AF
の動作を設定します。

Face/Eye Only AF：
カメラが被写体（人物）の顔や瞳を検出したとき、
人の顔や瞳にフォーカスを合わせて追尾します。
顔や瞳を検出しない間は、AFが一時停止し  
（AF一時停止アイコン）（11ページ）が表示さ
れます。顔や瞳だけにフォーカスを合わせて追尾
したいときに有効なモードです。

Face/Eye Priority AF：
カメラが被写体（人物）の顔や瞳を検出したとき、
人の顔や瞳に優先的にフォーカスを合わせて追
尾します。顔や瞳を検出しないときは、AFモー
ドになります（初期設定）。

Off：
顔/瞳検出AF機能を無効にします。

［ご注意］

ˎˎ Face/Eye Only AFに設定しているときでも、プッシュ
オートフォーカス実行中は、Face/Eye Priority AFにな
ります。
ˎˎ FOCUSスイッチが「MAN」のときは、顔/瞳検出AFでき
ません（プッシュオートフォーカス実行中を除く）。
ˎˎ Face/Eye Only AFに設定した状態で本機の電源を
切った場合、次に電源を入れると自動的にFace/Eye 
Priority AFになります。

顔/瞳検出枠を消す

顔/瞳検出枠の表示/非表示は、フルメニュー
のMonitoringメニュー>Display On/Offの
Face/Eye Detection Frame（99ページ）で
設定できます。

［ご注意］
DISPLAYボタンで非表示、またはFace/Eye Detection 
FrameをOffに設定しているときでも、プッシュオート
フォーカス（AF-S）でフォーカスが合った顔や瞳には緑色の
顔/瞳検出枠が表示されます。

アサイナブルボタンで顔/瞳検出AFの
動作を切り替える

アサイナブルボタン（52ページ）にFace/Eye 
Detection AFを割り当てると、そのボタンを
押すたびに、顔/瞳検出AFの動作がFace/Eye 
Priority AF、Face/Eye Only AF、Offの順に切
り替わります。

ダイレクトメニューで設定する

顔/瞳検出AFの動作は、ダイレクトメニュー
（52ページ）でも切り替えることができます。
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被写体を指定して追尾する
（リアルタイムトラッキング
AF）

タッチ操作や顔検出枠選択操作で指定した被写
体にフォーカスを合わせ続けることができます。
被写体を選択すると白色の追尾枠が表示され、
追尾が開始されます。

［メモ］

ˎˎ フォーカスエリアの設定に関わらず、映像領域全体で追
尾します。
ˎˎ ShootingメニューのFocusのTouch Function in MF
（85ページ）をTracking AFに設定すると、フォーカ
スモードがMFモードの場合でもリアルタイムトラッキン
グAFが可能です。

顔/瞳検出AFの動作モードの設定によって、追
尾対象に対して次のように動作します。

Face/Eye Only AF、Face/Eye Priority 
AF：
指定した被写体にフォーカスを合わせ追尾しま
す。
追尾対象が人物で、顔/瞳を検出した場合は、	
顔/瞳にフォーカスを合わせます。
追尾対象の顔/瞳を検出した場合、追尾対象の
顔を保存します。保存が完了すると （保存され
た追尾顔ありアイコン）（11ページ）が表示さ
れます。

［ご注意］
マニュアルフォーカス中にトラッキングAFを開始した場合
は、追尾対象の顔は保存しません。

Off：
指定した被写体にフォーカスを合わせ追尾します。
追尾対象が人物であっても、顔/瞳の検出は行い
ません。

［ご注意］
レンズ側でマニュアルフォーカスに設定されていると、リア
ルタイムトラッキングAFは動作しません

リアルタイムトラッキングAFを開始す
る

特定の被写体を追尾対象に指定すると、その被
写体に対して追尾が開始されます。

タッチ操作で指定する
次のいずれかの状態のときに、追尾対象とする
被写体をタップします。

ˎˎ フォーカスモードがMFモード、またはプッシュ
マニュアルフォーカス中で、Shootingメニュー
のFocusのTouch Function in MF（85ペー
ジ）がTracking AFのとき

ˎˎ フォーカスモードがAFモード、またはプッシュ
オートフォーカス（AF）中のとき

［ご注意］
TechnicalメニューのTouch Operation（105ページ）が
Offの場合はタッチ操作での指定はできません。

顔/瞳選択カーソルで指定する
ShootingメニューのFocusのMulti Selector 
Function（85ページ）がFace/Eye Sel. 
Cursorのとき、マルチセレクター（7ページ）
で顔/瞳選択カーソル（オレンジ色の下線）を追尾
対象にする被写体に移動して、マルチセレクター
を押し込みます。

他の顔検出枠（灰色） 追尾枠

顔/瞳選択カーソル（オレンジ）

［メモ］

ˎˎ リアルタイムトラッキングAF中に追尾対象を変更するこ
ともできます。
ˎˎ リアルタイムトラッキングAF中にFocus Magnifierを
割り当てたアサイナブルボタン（52ページ）を押すと、
追尾状態を継続したままピント拡大が実行されます。た
だし、ピント拡大中は、追尾対象の指定はできません。

［ご注意］
マニュアルフォーカス中は、顔/瞳選択カーソルでトラッキ
ングを開始できません。

トラッキングAFポインターで指定する
タッチ操作の代わりにマルチセレクターで画面上
の被写体を自由に選ぶことができます。
ShootingメニューのFocusのMulti Selector 
Function（85ページ）がPointerのとき、マル
チセレクター（7ページ）でトラッキングAFポ
インターを追尾対象にする被写体に移動して、マ
ルチセレクターを押し込みます。

顔/瞳枠

トラッキングAFポインター

ˎˎ ShootingメニューのFocusのPointer Color
（85ページ）でトラッキングAFポインターの
色を設定できます。

ˎˎ ShootingメニューのFocusのPointer Border
（85ページ）でトラッキングAFポインターの
縁取りの有無を設定できます。

［メモ］
トラッキングAFポインターの初期位置は表示映像の中央で
す。マルチセレクターを長押しすると初期位置に戻ります。

［ご注意］
リアルタイムトラッキングAF以外の機能でマルチセレク
ター操作が行える状態のとき、トラッキングAFポインター
がグレー表示され、マルチセレクターでトラッキングAFポ
インターを操作できません。

リアルタイムトラッキングAFを終了す
る

タッチ操作で終了する
タッチパネル左上に表示される  （リアルタ
イムトラッキングAF終了）ボタンをタップします。

［メモ］

ˎˎ 以下の場合もリアルタイムトラッキングAFが終了します。
–– FOCUSスイッチまたはレンズ側でAUTO/MANを切
り替えたとき
–– フォーカスモードを変更したとき
–– オートフォーカスアシストを実行したとき
–– フォーカスエリアの設定や顔/瞳検出AFの動作を変
更したとき
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–– Push AF/Push MFを割り当てたアサイナブルボタン
を押したとき
–– 撮影画面内から追尾対象がなくなり、フォーカスが
どこにも合っていない状態が数秒経過したとき

ˎˎ 追尾顔が保存されている（保存された追尾顔ありアイコ
ン「 」が表示されているとき）場合は、撮影映像領域内
に保存された追尾顔が入ると再びリアルタイムトラッキ
ングAFが開始されます。追尾顔を削除するには上記の
リアルタイムトラッキングAF終了の操作を行ってくださ
い。
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明るさを調節する

B

C
D
E

F
H

I

A

アイリス、ゲイン、シャッタースピードを調節した
り、NDフィルターを使って光量を調節したりして、
明るさを調節できます。自動調節することもでき
ます。
明るさを自動調節するときの目標レベルは、フル
メニューのShootingメニュー>Auto Exposure
（82ページ）のLevelで設定します。アサイナ
ブルボタンやアサイナブルダイヤル（52ページ）
にAuto Exposure Levelを割り当てることもで
きます。

［ご注意］

ˎˎ Cine EI/Cine EI Quickではゲインを調節できません。
基準感度に固定されます。また、シャッタースピードに
よる明るさの自動調節はできません。アイリスやNDフィ
ルターによる明るさの自動調節は可能です。
ˎˎ ソフトウェアバージョン4.0より明るさの自動調節は、
LUTを適用した映像が適正露出となるように動作しま
す。

基準感度を選択する

本機では2種類の基準感度を選択することがで
きます。
撮影モードがCustomのときは、Mainステータス
（14ページ）またはCameraステータス（14
ページ）のBase ISO/Sensitivity、またはフル
メニューのShootingメニュー>ISO/Gain/EIの
Base Sensitivity（81ページ）でHighまたは
Lowから選択します。
Cine EI/Flexible ISOでは、Mainステータス
（14ページ）またはCameraステータス（14
ページ）のBase ISO/Sensitivity、またはフル
メニューのShootingメニュー>ISO/Gain/EIの
Base ISO（81ページ）でISO 12800または
ISO 800から選択します。
Cine EI Quickでは、選択したExposure Index
に応じてISO12800またはISO800が自動的に選
択されます。
通常の照明下ではLowまたはISO 800、低照度
の条件ではHighまたはISO 12800を選択してく
ださい。
*	 ステータス画面でも設定可能。

［メモ］
アサイナブルボタンにBase ISO/Sensitivityを割り当てる
こともできます（52ページ）。

アイリスを調節する

アイリスを調節して、明るさを調節できます。

アイリスを自動調節する

被写体に応じて明るさを調整します。対応するレ
ンズが必要です。

1	 レンズにAuto Irisスイッチがついている場
合、AUTOにする。

2	 IRISファンクションボタン（E）を長押ししてダ
イレクトメニュー（52ページ）を表示させ、
Autoを選ぶ。

	 ［メモ］
アサイナブルボタンにAuto Irisを割り当てることもで
きます（52ページ）。

	 ［ご注意］
Aマウントレンズではアイリスを自動調節できません。

アイリスを手動調節する

1	 IRISファンクションボタン（E）を長押ししてダ
イレクトメニュー（52ページ）を表示させ、
Manualを選ぶ。

2	 IRISファンクションボタン（E）を押して、アイ
リス値が白背景で表示された状態にする。

3	 マルチファンクションダイヤルを回して調節
する。

	 ［メモ］

ˎˎ マルチファンクションダイヤルにIRISを割り当てる
と、マルチファンクションダイヤルを常時IRISとして
動作させることもできます（52ページ）。

ˎˎ アサイナブルダイヤルにIRISを割り当てることもでき
ます（52ページ）。

一時的に自動調節する

Push Auto Irisを割り当てたアサイナブルボタン
（52ページ）を押している間、アイリスを自動
調節します。
指を離すと手動アイリスに戻ります。

［ご注意］

ˎˎ レンズのAuto IrisスイッチをMANUALにすると、本機
からのAuto IrisやPush Auto Irisを受け付けなくなりま
す。また、本機からのアイリス手動調節操作も受け付け
なくなります。
ˎˎ ShootingメニューのIrisのBokeh Control（82ペー
ジ）がOnのときは、Push Auto Irisを実行できません。

ゲインを調節する

撮影モードがCustom/Flexible ISOではゲイン
を調節して、明るさを調節できます。

ゲインを自動調節する

ISO/GAINファンクションボタン（H）を長押しして
ダイレクトメニュー（52ページ）を表示させ、
Autoを選ぶ。

［メモ］

ˎˎ ShootingメニューのAuto Exposure（82ページ）の
AGCをOnにしても同様の調節が可能です。
ˎˎ アサイナブルボタンにAGCを割り当てることもできます
（52ページ）。

ゲインを手動調節する

アイリスを固定したまま露出調整したいときや、
AGCによるゲインアップを行いたくないときなど
に使用します。
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1	 ISO/GAINファンクションボタン（H）を長押
ししてダイレクトメニュー（52ページ）を
表示させ、Manualを選ぶ。

2	 ISO/GAINスイッチ（I）でH/M/Lを選択する。
［メモ］

ˎˎ CameraステータスのISO/Gain<L>/<M>/<H> （14
ページ）、またはフルメニューのShootingメニュー
>ISO/Gain/EIのISO/Gain<H>/<M>/<L>（80ペー
ジ）で各スイッチポジションのプリセット値を変更できま
す。
ˎˎ アサイナブルボタンにPush AGCを割り当てると、その
ボタンを押している間だけAGCをOnにできます。

［ご注意］

ˎˎ フルメニューのShootingメニュー >IrisのBokeh 
Control（82ページ）がOnのときは、Push AGCを実
行できません。
ˎˎ Cine EI/Cine EI Quickのときは、Push AGCを実行で
きません。

ゲインを微調整する

1	 ISO/GAINファンクションボタン（H）を押し
て、ゲイン値が白背景で表示された状態に
する。

2	 マルチファンクションダイヤルを回して調節
する。

［メモ］
ISO/GAINスイッチ（I）の設定に応じたゲインプリセット値
を変更します。

ゲインを一時的に微調整する

アサイナブルダイヤル（52ページ）にISO/
Gain/EIを割り当てると、ISO/GAINスイッチ（I）
で設定した値からダイヤルで調整することができ
ます。

被写界深度を変えずにもう一歩露出を追い込み
たいときに便利です。
一時的に微調整した結果は、ISO/GAINスイッチ
（I）および基準感度の切り替えやAGCをOn、電
源をOffにすると無効になります。

［メモ］

ˎˎ マルチファンクションダイヤルに割り当てることもできま
す（52ページ）。
ˎˎ アサイナブルボタンにPush AGCを割り当てると、その
ボタンを押している間だけAGCをOnにできます。

［ご注意］

ˎˎ フルメニューのShootingメニュー >IrisのBokeh 
Control（82ページ）がOnのときは、Push AGCを実
行できません。
ˎˎ Cine EI/Cine EI Quickのときは、Push AGCを実行で
きません。

Exposure Indexを調整する

Cine EI/Cine EI QuickではMLUTをOffに設定
した映像出力を本線として記録することを想定し
ており、EI値に合わせてMLUT On側の映像の明
るさを変化させることで、ポストプロダクション
処理での増感/減感処理結果を撮影時に確認す
ることができます。
EI値の変更は、ISO/GAINスイッチ（I）でH/M/L
を選択することで行えます。
Cine EI QuickではEI値と同時に基準感度を変更
することができます。

［メモ］
CameraステータスのISO/Gain/EI（14ページ）、ま
たはフルメニューのShootingメニュー >ISO/Gain/EIの
Exposure Index<H>/<M>/<L>（80ページ）で各スイッ
チポジションのEI値を変更できます。

Exposure Indexを微調整する

1	 ISO/GAINファンクションボタン（H）を押し
て、EI値が白背景で表示された状態にする。

2	 マルチファンクションダイヤルを回して調節
する。

［メモ］
ISO/GAINスイッチ（I）の設定に応じたEIプリセット値を変
更します。

シャッターを調節する

シャッターを調節して、明るさを調節できます。

シャッターを自動調節する

SHUTTERファンクションボタン（F）を長押しして
ダイレクトメニュー（52ページ）からAutoを
選ぶと、映像の明るさに応じて自動でシャッター
速度または開角度を調整できます。

［メモ］
フルメニューのShootingメニュー >Auto Exposureの
Auto Shutter（83ページ）をOnにしても同様の調節が
可能です。

シャッターを手動調節する

1	 SHUTTERファンクションボタン（F）を長押し
して、ダイレクトメニュー（52ページ）か
らSpeedまたはAngleを選ぶ。

2	 SHUTTERファンクションボタン（F）を押して、
シャッター値が白背景で表示された状態に
する。

3	 マルチファンクションダイヤルを回してシャッ
ター速度を調節する。

［メモ］

ˎˎ 露光時間をフレーム周期に合わせる場合は、手順1で
Offを選択します。
ˎˎ 角度で設定したり、周波数で細かく設定することもでき
ます（81ページ）。

光量を調節する（NDフィル
ター）

撮影状況が明るすぎるときは、NDフィルターを
変更して適切な明るさにすることができます。
本機は2つのNDフィルターモードを備えていま
す。2つのモードはND PRESET/VARIABLEスイッ
チで切り替えます。

プリセットモードで調節する

ND PRESET/VARIABLEスイッチ（A）をPRESET
の位置にして、ND FILTER POSITION上下ボタン
（B）で切り替えます。
Clear：NDなし
1：フルメニューのShootingメニュー>ND Filter
のPreset1（81ページ）で設定した透過率。
2：フルメニューのShootingメニュー>ND Filter
のPreset2（81ページ）で設定した透過率。
3：フルメニューのShootingメニュー>ND Filter
のPreset3（81ページ）で設定した透過率。

バリアブルモードで調節する

ND PRESET/VARIABLEスイッチ（A）を
VARIABLEの位置にします。ND FILTER 
POSITION上下ボタン（B）でCLEARとOnを切り
替えます。
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光量を自動調節する
オートNDフィルターをOnにすると、NDフィル
ターを使った自動露出調節を行います。

1	 ND FILTER POSITION上下ボタン（B）の＋を
押して、NDフィルターをOnにする。

2	 ND VARIABLE AUTOボタン（C）をAutoに
なるまで長押しする。

光量を手動調節する

1	 ND FILTER POSITION上下ボタン（B）の＋を
押して、NDフィルターをOnにする。

2	 ND VARIABLE AUTOボタン（C）をManual
になるまで長押しする。

3	 ND VARIABLEダイヤル（D）を回してフィル
ターの透過率を調節する。

［メモ］
アサイナブルダイヤルにND Filterを割り当てることもでき
ます（52ページ）。

一時的に自動調節する
Push Auto NDが割り当てられたアサイナブルボ
タン（52ページ）を押している間、オートNDフィ
ルターがOnになります。指を離すとオートNDフィ
ルターがOffに戻ります。
ND FILTER POSITION上下ボタン（B）の＋を押し
て、NDフィルターをOnの状態にしておいてくだ
さい。

［ご注意］

ˎˎ 撮影中にCLEARをまたいでNDフィルターを切り替えた
とき、画像内にNDフィルターの枠が入り、音声に動作音
が入ります。
ˎˎ 	ShootingメニューのIrisのBokeh Control（82ペー
ジ）がOnのときは、Push Auto NDを実行できません。

［メモ］

ˎˎ ND VARIABLEダイヤル（D）をND1/4からさらに下に回
すと、CLEARにすることができます。また、CLEARか
らある程度上に回すと、ND1/4にすることができます。
フルメニューのTechnicalメニュー >ND DialのCLEAR 
with Dial（105ページ）で、この動作を無効にすること
ができます。
ˎˎ ND FILTER POSITION上下ボタンの代わりに、ND 
Filter Positionが割り当てられたアサイナブルボタン
（52ページ）を押して設定を変更することもできます。	
プリセットモード：Clear→Preset1→Preset2→	
Preset3→Clear・・・	
バリアブルモード：Clear→On→Clear・・・
ˎˎ Auto ND Filterが割り当てられたアサイナブルボタン
（52ページ）を押してオートNDフィルターをOn/Off
することもできます。
ˎˎ 明るい被写体を撮影するとき、アイリスを極端に絞ると
回折現象が生じフォーカスが甘くなることがあります（ビ
デオカメラでは一般的に起こる現象です）。NDフィルター
を使うことでこの現象を抑え、より良好な撮影結果を得
ることができます。
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G

J

撮影状況に応じて調節モードを選択できます。

ATW（自動追尾ホワイトバラ
ンス）

常に適切なホワイトバランスになるように自動的
に調節します。
光源の色温度が変化すると、ホワイトバランスを
自動的に調節し直します。
WHT BALファンクションボタン（G）を長押しして、
ダイレクトメニュー（52ページ）からATWを
設定します。
フルメニューのShootingメニュー>White 
SettingのATW Speed（84ページ）で、5段
階の調節速度を選択できます。

［メモ］
アサイナブルボタン（52ページ）にATW Hold機能を割
り当てておくと、このボタンを押すことによって、ATWモー
ドでも一時的にATWを停止させ、ホワイトバランスを固定
することができます。

［ご注意］

ˎˎ Cine EI/Cine EI Quickのとき、ATWは使えません。
ˎˎ 照明や被写体の条件によっては、ATWを使用しても適
切な色に調節できないことがあります。	
例：
–– 空、海、地面、草花など単一色の被写体が大部分を
占める場合
–– 色温度が非常に高い/非常に低い光源下の被写体

	 ATWの自動追従の時間が遅い場合や、適切な効果が得
られない場合は、オートホワイトバランスを実行してくだ
さい。

ホワイトバランスを手動調節
する

1	 ホワイトバランスがATWモードになっている
ときは、WHT BALファンクションボタン（G）
を長押ししてダイレクトメニュー（52ペー
ジ）からW:PまたはW:A、W:Bを選ぶ。

2	 WHT BALスイッチ（J）でB/A/PRESETを選
択する。
B: メモリー Bモード
A: メモリーAモード
PRESET: プリセットモード

［メモ］
フルメニューのShootingメニュー >White Settingの
White Switch<B>（84ページ）でATWを選択すると、
メモリー BにATWが割り当てられます。

メモリーA/メモリー B モード
メモリーAまたはメモリー Bに保存されたホワイ
トバランスに調節します。

プリセットモード
色温度をプリセット値（工場出荷時：3200K）に
調節するモードです。

既定のプリセット値に変更する

プリセットモードでは既定のプリセット値に直接
変更することができます。
WHT BALファンクションボタン（G）を長押しして、
ダイレクトメニューで以下から選択する。
Custom：→ 3200K、→ 4300K、→ 5600K、
→ 6300K

Log 撮影：→ 3200K、→ 4300K、→ 5500K

［メモ］
Preset White Selectが割り当てられたアサイナブルボタン
（52ページ）を押して設定を変更することもできます。
Custom：3200K→4300K→5600K→6300K→	
3200K・・・

Log撮影：3200K→4300K→5500K→3200K・・・

任意の色温度に変更する

1	 WHT BALファンクションボタン（G）を押し
て、色温度が白背景で表示された状態にす
る。

2	 マルチファンクションダイヤルを回して調節
する。

［メモ］

ˎˎ プリセットモードでは100K単位で設定できます。
ˎˎ メモリーモードでは、2000K～ 5600Kは20K単位で設
定できます。5600Kより上の値は、5580Kから5600K
の色変化量（ミレッド）が等しくなる間隔で設定できます。
また、フルメニューのShootingメニューのWhite（83
ページ）でTintの調節ができます。

オートホワイトバランスを実行する

メモリーA/メモリーBモードで保存するホワイト
バランスを自動で設定します。

1	 メモリーAモードまたはメモリー Bモードを
選択する。

2	 被写体の照明光源と同じ条件のところに白
い紙などを置き、ズームアップして画面に白
を映す。

3	 明るさを調節する。
「アイリスを手動調節する」（46ページ）
に従って、アイリスを調節してください。

4	 WB SETボタン（4ページ）を押す。
ˎˎ メモリーモードで実行した場合、自動で調
節した結果は手順1で選択したメモリー（A
またはB）に保存されます。

ˎˎ ATWモードで実行した場合、自動調節が
終わると、結果を引き継いでATWを再開
します。ATW Speedの設定に関わらず、
最速でホワイトバランスをあわせたいとき
に使用できます。

［ご注意］
正常に終了しなかったときは画面に約3秒間エラーメッセー
ジが表示されます。繰り返し調整を試みてもエラーメッセー
ジが表示されるときは、ソニーのサービス担当者にご相談
ください。

自然な色合いに調節する（ホワイトバランス）
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本機の入力端子やスイッチ、ダイヤルなどを使い、
収録する音声を設定します。

外部音声の入力端子と切り替えスイッ
チ

INPUT1端子（7ページ）
INPUT2端子（7ページ）
マルチインターフェースシュー（7ページ）
INPUT1スイッチ（LINE/MIC/MIC+48V）
（7ページ）
INPUT2スイッチ（LINE/MIC/MIC+48V）
（7ページ）

録音レベルの設定用スイッチ

CH1（AUTO/MAN）スイッチ（6ページ）
CH2（AUTO/MAN）スイッチ（6ページ）
AUDIO LEVEL（CH1）ダイヤル（6ページ）
AUDIO LEVEL（CH2）ダイヤル（6ページ）

オーディオステータス画面

音声入力機器を選ぶ

1	 オーディオステータス画面のCH1/CH2/
CH3/CH4のSource（14ページ）、また
はフルメニューのAudioメニュー>Audio 
InputのCH1 Input Select～ CH4 Input 
Select（102ページ）で音声入力を切り替え
る。
マルチインターフェースシューに接続され
たマイクやXLRアダプターを使う場合は、
Shoe CH1またはShoe CH2を設定します。
XLRアダプターについては「オーディオ入力端
子を増設する」（51ページ）をご覧くださ
い。

	 ［ご注意］

ˎˎ インターバルレックモード、スロー＆クイックモー
ション撮影では、音声は記録されません。
ˎˎ 本機は環境音収録用のナレーションマイクを内蔵し
ています。他機器とのタイミング合わせなどにご利
用いただけます。その場合はInternal MICを設定し
ます。
ˎˎ ハンドル装着時はハンドル内蔵マイク（7ページ）
のみが有効になり、音声を収録できます。ハンドル
未装着時は本機の環境音収録用ナレーションマイク
（6ページ）を使用することができます。
ˎˎ CH1 Input SelectとCH2 Input Selectが
Internal MICに設定されている場合、CH1とCH2
の録音レベルは共にAUDIO LEVEL(CH1)ダイヤ
ル（6ページ）に連動して調節されます。CH3 
Input SelectとCH4 Input SelectがInternal MIC
に設定されている場合、CH3とCH4の録音レベル
は共にCH3 Input Level（102ページ）に連動して
調節されます。

2	 入力する音源を選ぶ。
INPUT1/INPUT2端子に接続する機器に
合わせて、INPUT1/INPUT2（LINE/MIC/
MIC+48V）スイッチを設定します。

接続機器 スイッチの位置
外部音声機器（ミキサーな
ど）

LINE

ダイナミックマイクや電池内
蔵のマイク

MIC

+48V電源（ファンタム電源）
対応のマイク

MIC+48V

ˎˎ MIC+48Vにしたままで+48V電源に対応し
ていない機器を接続すると、接続した機器
の故障の原因になります。接続前にご確認
ください。

ˎˎ 接続しない端子の雑音が気になるときは、
INPUT1/INPUT2（LINE/MIC/MIC+48V）
スイッチを「LINE」にしてください。

録音レベルを自動調節する

自動調節するチャンネルのCH1/CH2（AUTO/
MAN）スイッチを「AUTO」にします。
CH3/CH4の場合は、オーディオステータス画
面（14ページ）、またはフルメニューのAudio
メニュー>Audio InputのCH3 Level Control、
CH4 Level ControlをAutoに設定します
（102ページ）。

録音レベルを手動調節する

CH1/CH2の録音レベルを手動調節する場合は、
以下の手順で行います。

1	 調節するチャンネルのCH1/CH2（AUTO/
MAN）スイッチを「MAN」にする。

2	 撮影中またはスタンバイ中に、調節するチャ
ンネルのAUDIO LEVEL（CH1）/（CH2）ダイ
ヤルを回して、音量を調節する。

ˎˎ CH3/CH4の場合は、オーディオステータ
ス画面のCH3/CH4（14ページ）、また
はフルメニューのAudioメニュー>Audio 
InputのCH3 Level ControlまたはCH4 
Level ControlをManualに設定し、CH3 
Input LevelまたはCH4 Input Levelで録
音レベルを調節します。

ˎˎ CH1～ CH4を一括してレベル調節するこ
ともできます。Audio Input Levelが割
り当てられたアサイナブルダイヤル（52
ページ）や、オーディオステータス画
面、またはフルメニューのAudioメニュー
>Audio InputのAudio Input Levelで調
節します。

［メモ］
音声入力レベルの確認には、オーディオステータス画面が
便利です（14ページ）。

［ご注意］

ˎˎ Audioメニューの設定の組み合わせによりAudio Input 
Levelの設定が無効になる場合があります。詳細は
142ページの図をご覧ください。
ˎˎ 本機では組み合わせによりさまざまな設定ができます。
詳細は142ページの図をご覧ください。

収録する音声を設定する
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オーディオ入力端子を増設す
る

XLRアダプターXLR-K2M（別売）、XLR-K3M（別
売）を使うと、同時に4系統のXLR音声機器を本
機に接続することができます。
マルチインターフェースシューにXLRアダプター
を装着して、オーディオステータス画面（14
ページ）のCH3のSourceをShoe CH1に、CH4
のSourceをShoe CH2に設定してください。ま
たは、フルメニューのAudioメニュー>Audio 
InputのCH3 Input SelectをShoe CH1に、
CH4 Input SelectをShoe CH2に設定してくだ
さい。
入力にXLRアダプターを選択したチャンネルで
は、重複する本機の機能は無効になります。
XLRアダプターのスイッチやダイヤルで調節してく
ださい。

［ご注意］

ˎˎ 本機はXLR-K3Mのデジタル2chオーディオインター
フェースに対応しています。
ˎˎ AudioメニューのAudio InputのCH3 LevelやCH4 
LevelをAudio Input Levelに設定した場合は、XLRア
ダプターで調節したレベルに本機のAudio Input Level
が掛け合わされます。	
XLRアダプターのスイッチをAUTOに設定した場合も
Audio Input Levelが有効になります。	
Throughに設定した場合は、XLRアダプターで調節した
レベルで記録されます（143ページ）。
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便利な機能
ダイレクトメニュー操作

ビューファインダー画面に表示される本機の状態
や設定を、直接選択して変更することができます。
設定できる項目は、以下のとおりです。

ˎˎ Face/Eye Detection AF

ˎˎ SteadyShot

ˎˎ White Mode

ˎˎ Color Temp

ˎˎ Scene File

ˎˎ ND Filter Position / Auto ND Filter

ˎˎ ND Filter Value

ˎˎ Auto Iris

ˎˎ Iris Value

ˎˎ AGC

ˎˎ Gain Value

ˎˎ ISO Value

ˎˎ Exposure Index Value

ˎˎ Auto Shutter / ECS

ˎˎ Shutter Value

ˎˎ Auto Exposure Mode

ˎˎ Auto Exposure Level

ˎˎ S&Q Motion Frame Rate

1	 マルチファンクションダイヤル、または
Direct Menuが割り当てられたアサイナブル
ボタンを押す。
ダイレクトメニュー操作のできる項目のいず
れかにオレンジのカーソルが表示されます。

2	 マルチファンクションダイヤルで操作したい
項目にカーソルを合わせ、マルチファンクショ
ンダイヤルを押す。
メニューが表示されるか、または項目が白
背景で表示されます。

3	 マルチファンクションダイヤルで設定を選び、
マルチファンクションダイヤルを押す。
メニューまたは白背景が消えて、新しい設定
がオレンジのカーソルで表示されます。
再びDirect Menuが割り当てられたアサイ
ナブルボタンを押すか、何も操作しないで3
秒経過すると、ダイレクトメニューが終了し
ます。

	 ［メモ］

ˎˎ 各種ファンクションボタン（5ページ）を長押し
して、直接設定をする状態にすることもできます。
ˎˎ 白背景で表示された状態では、マルチファンクショ
ンダイヤルをアサイナブルダイヤルのように使うこと
ができます。
ˎˎ 選択操作はマルチセレクター（9ページ）でも行
えます。

アサイナブルボタン/ダイヤル

本機には、機能を割り当てて使用できるアサイナブル
ボタンが9個（6、7、9ページ）あります。
本体のマルチファンクションダイヤル（5ペー
ジ）とハンドルのハンドルアサイナブルダイヤル
（7ページ）、グリップリモコンのグリップア
サイナブルダイヤル（9ページ）にも機能を割
り当てることができます。

ボタンの機能を変更する

フルメニューのProjectメニューのAssignable 
Button（90ページ）を使用します。
割り当てられた機能は、アサイナブルボタンス
テータス画面（15ページ）で確認することがで
きます。

工場出荷時にアサイナブルボタンに割り当
てられている機能
ボタン1	 S&Q Motion
ボタン2	 AF Speed/Sens.
ボタン3	 Focus Setting
ボタン4	 Focus Magnifier x3/x6
ボタン5	 Direct Menu
ボタン6	 Off
ボタン7	 Focus Magnifier x3/x6
ボタン8	 Direct Menu
ボタン9	 Video Signal Monitor
Focus Holdボタン	 Focus Hold

割り当てられる機能
ˎˎ Off

ˎˎ Base ISO/Sensitivity

ˎˎ AGC

ˎˎ Push AGC

ˎˎ ND Filter Position

ˎˎ Auto ND Filter

ˎˎ Push Auto ND

ˎˎ Auto Iris

ˎˎ Push Auto Iris

ˎˎ Bokeh Control

ˎˎ Auto Shutter

ˎˎ Auto Exposure Level

ˎˎ Backlight

ˎˎ Spotlight

ˎˎ Preset White Select

ˎˎ ATW

ˎˎ ATW Hold

ˎˎ AF Speed/Sens.

ˎˎ Focus Setting

ˎˎ Focus Area

ˎˎ Focus Area(AF-S)

ˎˎ Face/Eye Detection AF

ˎˎ Push AF Mode

ˎˎ Push AF/Push MF

ˎˎ Focus Hold

ˎˎ Focus Magnifier x3/x6

ˎˎ Focus Magnifier x3

ˎˎ Focus Magnifier x6

ˎˎ S&Q Motion

ˎˎ SteadyShot

ˎˎ Rec

ˎˎ Picture Cache Rec

ˎˎ Rec Review

ˎˎ Clip Flag OK

ˎˎ Clip Flag NG

ˎˎ Clip Flag Keep

ˎˎ Color Bars

ˎˎ Tally [Front]

ˎˎ DURATION/TC/U-BIT

ˎˎ Display

ˎˎ Lens Info

ˎˎ Video Signal Monitor

ˎˎ Marker

ˎˎ VF Adjust

ˎˎ VF Mode

ˎˎ Gamma Display Assist

ˎˎ Peaking

ˎˎ Zebra

ˎˎ Volume

ˎˎ Thumbnail

ˎˎ Touch Operation

ˎˎ Handle Zoom

ˎˎ NFC

ˎˎ Auto Upload (Proxy)

ˎˎ Direct Menu

ˎˎ User Menu
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ˎˎ Menu

ダイヤルの機能を変更する

本体のマルチファンクションダイヤルと、グリッ
プアサイナブルダイヤル、ハンドルアサイナブル
ダイヤルの機能を変更することができます。

マルチファンクションダイヤルはProjectメ
ニューのMulti Function Dial（92ページ）の
Default Functionで設定します。
工場出荷時にはOffが割り当てられています。

マルチファンクションダイヤルに割り当て
られる機能
ˎˎ Off

ˎˎ ISO/Gain/EI

ˎˎ IRIS

ˎˎ Auto Exposure Level

ˎˎ Audio Input Level

［ご注意］
メニューなどを表示しているときは、本設定は無効になり
ます。

アサイナブルダイヤルは、フルメニューのProject
メニューのAssignable Dial（92ページ）で設
定します。
工場出荷時は、いずれもIRISが割り当てられてい
ます。

［メモ］
RM-30BP（別売）のアサイナブルダイヤルは、Grip/
Remote Dialの設定に従います。

ハンドル/グリップアサイナブルダイヤルに
割り当てられる機能
ˎˎ Off

ˎˎ ISO/Gain/EI

ˎˎ ND Filter

ˎˎ IRIS

ˎˎ Auto Exposure Level

ˎˎ Audio Input Level

ˎˎ Multi Function Dial

割り当てられた機能は、アサイナブルボタンス
テータス画面（15ページ）で確認することがで
きます。

スロー＆クイックモーション

記録フォーマット（87ページ）が下記に設定されているときは、撮像時のフレームレートを再生時の
フレームレートと異なる値に設定することができます。

記録フォーマット フレームレート
システム周波数 イメージャースキャ

ンモード
コーデック ビデオフォーマット

59.94/50/29.97/	
25/23.98

FF RAW 3840×2160P 1-60、100、120
RAW & XAVC-I 3840×2160P 1-60、100、120
XAVC-I 4096×2160P 1-60

3840×2160P 1-60、100、120
1920×1080P 1-60、100、120、

150、180、200、
240

XAVC-L 3840×2160P 1-60、100、120
1920×1080P 1-60、100、120、

150、180、200、
240

S35 XAVC-I 1920×1080P 1-60、100、120
XAVC-L 1920×1080P 1-60、100、120

24 FF XAVC-I 4096×2160P 1-60

S&Q Motionが割り当てられたアサイナブルボタ
ン（52ページ）を押すと、スロー＆クイックモー
ションモードをOn/Offできます。
ボタンを長押しすると、撮像時のフレームレート
を設定できます。

［メモ］
メインステータスのS&Q Frame Rateやプロジェクトス
テータスのRec Function、フルメニューのShootingメ
ニューのS&Q Motionでも設定可能です。

［ご注意］

ˎˎ 記録中、再生中、サムネイル表示中は、スロー＆クイッ
クモーションモードにできません。
ˎˎ スロー＆クイックモーションモードでは、音声は記録で
きません。
ˎˎ スロー＆クイックモーションモードでは、オートアイリス
とオートシャッターは無効になります。

ˎˎ スロー＆クイックモーションモードでは、オートフォーカ
スに以下の制限があります。
–– レンズ機種とシステム周波数、撮像フレームレート
による制限

ソニー製レ
ンズ

システム周波
数

AF可否

SEL16F28
以外

－ 7fps以上で可

SEL16F28 59.94/29.97/	
23.98

30、60、120、
240fpsで可

50.00/25.00 25、50、100、
200fpsで可

24.00 不可
–– また、アイリスをF18以上にするとオートフォーカス
機能が一時停止します。

ˎˎ RAW出力の使用方法は62ページをご覧ください。
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間欠的に映像を記録する（イ
ンターバルレック機能）

本機のメモリーを利用して間欠的に映像を取り込
み、記録するインターバルレック機能は、主に動
きの少ない被写体を撮影するときに有効です。
記録を開始すると、設定したフレーム数（Number 
of Frames）分の映像を、任意のインターバル
（Interval Time）で自動記録できます。

撮影の間隔（Interval Time）

1回に記録する画像フレーム数
（Number of Frames）

インターバルレックを有効にしているときは、撮
影開始前にビデオライトHVL-LBPC（別売）を自
動的に点灯させ、光量、色温度を安定させた状
態で撮影を行うことができます（プリライティン
グ機能）。

［ご注意］

ˎˎ インターバルレックなどの特殊記録機能を複数同時に使
用できません。
ˎˎ インターバルレック使用中に他の特殊記録機能を有効に
すると、インターバルレックは自動的に解除されます。
ˎˎ ビデオフォーマットなどのシステム設定を変更すると、
インターバルレックモードは自動的に解除されます。
ˎˎ 記録中や再生中、サムネイル画面表示中にインターバル
レックの設定を変更することはできません。

設定するには

プロジェクトステータスのRec Functionで
Interval Recを選択し、Number of Framesと
Interval Timeを設定してください。
ビデオライトHVL-LBPC（別売）を使用する場合
は、必要に応じてProjectメニューのInterval 
RecのPre-Lightingで記録開始前のビデオライ
ト点灯時間を設定してください。

［メモ］
フルメニューのProjectメニューのInterval Rec（89ペー
ジ）でも設定できます。

［ご注意］

ˎˎ ビデオライトを記録前に点灯させる場合は、ビデオラ
イトのスイッチをAUTOに設定してください。このとき
TechnicalメニューのVideo Light Set（107ページ）
の設定に従ってビデオライトが自動点灯／消灯します。
ˎˎ ビデオライトのスイッチをONに設定すると、ビデオライ
トは常時点灯します。（ビデオライトは自動点灯／消灯し
ません。）
ˎˎ 各設定により消灯時間が5秒以下になる場合は、ビデオ
ライトは消灯しません。

本機の電源を切るとインターバルレックモー
ドは解除されますが、Number of Frames、
Interval Time、Pre-Lightingの設定は保持さ
れます。次回インターバルレックモードで撮影す
るときに再設定する必要はありません。

撮影するには

録画START/STOPボタンを押すと記録が開始
され、ビューファインダー画面上に「IntRec」と
「IntStby」が交互に表示されます。
プリライティング機能を使用する場合は、記録
が始まる前にビデオライトが点灯します。

撮影を終了するには

記録停止の操作を行います。
撮影を終了すると、その瞬間までメモリーに蓄え
られていた映像がメディアに記録されます。

インターバルレックモードを解除する
には

次のいずれかを実行します。

ˎˎ POWERスイッチをOffにする。

ˎˎ 記録待機中に、プロジェクトステータスのRec 
FunctionをInterval Rec以外に設定する。

また、本機が再起動した場合もインターバルレッ
クモードは解除されます。

記録中の動作制限

ˎˎ 音声は記録されません。

ˎˎ レックレビュー操作は行えません。

本機の電源が切れた場合

ˎˎ 本機のPOWERスイッチをOffにした場合は、
その瞬間までメモリーに蓄えられていた映像を
記録するため、メディアにアクセスしてから、
自動的に電源が切れます。

ˎˎ 記録中にバッテリーを取り外したり、DC電源
コードを引き抜いたり、ACアダプター側の電
源を切ったりした場合は、その瞬間以前に撮
影したショット（最大10秒）が記録されないこ
とがあります。バッテリー交換の際は充分ご注
意ください。

数秒前の映像から記録する
（ピクチャーキャッシュレック
機能）

ピクチャーキャッシュレック機能を使用すると、カ
メラが捉えた映像を、指定した時間内蔵キャッシュ
メモリーに蓄えておくことによって、記録開始操作
以前にさかのぼって記録することができます。
プロジェクトステータスのPicture Cache Recで
Onを選択し、キャッシュサイズを設定します。

Cache Sizeの設定 蓄積時間（目安）
Short 5秒
Medium 10秒
Long 20秒
Max 各記録フォーマットでの最

大値

［メモ］

ˎˎ 蓄積時間は、撮影フレームレートや記録フォーマットに
より短くなる場合があります。プロジェクトステータスの
Picture Cache Rec欄、またはキャッシュサイズ設定画
面右下の表示でご確認ください。
ˎˎ フルメニューのProjectメニューのPicture Cache Rec
（89ページ）でも設定できます。
ˎˎ アサイナブルボタン（52ページ）でPicture Cache 
RecのOn/Offを切り替えることもできます。

［ご注意］

ˎˎ ピクチャーキャッシュレックは、インターバルレック、2
スロット同時記録、プロキシ記録との併用はできません。
ピクチャーキャッシュレックをOnにすると、これらの機
能は強制的にOffになります。
ˎˎ 記録中、レックレビュー中は、ピクチャーキャッシュレッ
クモードにできません。
ˎˎ ピクチャーキャッシュレックがOnのときは、タイムコー
ドがRegenやRec Runに設定されていてもFree Run
モードで記録されます（97ページ）。
ˎˎ ピクチャーキャッシュレック中はOutput Formatの設
定を変更できない場合があります。この場合、一度ピク
チャーキャッシュレックをOffにしてから変更操作を行っ
てください。
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ピクチャーキャッシュレックを実行す
る

Picture Cache RecがOnのとき、ビューファイ
ンダー画面上に「●Cache」（●は緑）が点灯しま
す。
録画START/STOPボタンを押すと記録が開始さ
れ、キャッシュメモリーに蓄積されている映像か
らメモリーカードに書き込まれます。

ピクチャーキャッシュレック機能を解
除するには

プロジェクトステータスのPicture Cache Recを
Offにするか、Picture Cache Rec機能を割り当
てたアサイナブルボタンを押します。

［ご注意］

ˎˎ 記録フォーマットや基本ルックが変更されると、それま
で蓄えていた映像をクリアし、新たに蓄積を開始します。
したがって、変更直後に記録を開始しても、フォーマッ
ト変更前の映像はピクチャーキャッシュレックできませ
ん。
ˎˎ メモリーカード挿入直後にピクチャーキャッシュレックの
開始/終了操作を行った場合は、データがカードに記録
されないことがあります。
ˎˎ 映像の蓄積は、ピクチャーキャッシュレック機能をOnに
してから開始されます。したがって、Onにする前の映像
はピクチャーキャッシュレックできません。
ˎˎ 再生、レックレビュー、サムネイル画面表示など、メモリー
カードにアクセスしている間は映像を蓄えないため、こ
の間の映像はピクチャーキャッシュレックできません。

メモリーカードAとメモリー
カードBの両方に記録するに
は（2スロット同時記録）

ProjectステータスのSimul Rec（15ページ）、
またはフルメニューのProjectメニュー>Simul 
RecのSetting（89ページ）をOnにすると、メ
モリーカードAとメモリーカードBの両方に同時に
記録できます。

メモリーカードAとメモリーカードBの
記録操作を別々に行う

録画START/STOPボタンとハンドル録画
START/STOPボタンで、それぞれ別のメモリー
カードを記録開始／停止することができます。
工場出荷時は、どちらのボタンもメモリーカード
AとメモリーカードBの両方に同時に記録するよ
うに設定されています。

ˎˎ “Rec Button:[SlotA SlotB] Handle Rec 
Button:[SlotA SlotB]”

それぞれのボタンで別のメモリーカードへ記録す
るように設定したとき、SDI/HDMI Rec Control
（90ページ）の記録開始／停止制御は、スロッ
トAの記録状態に従います。

設定を変えるには

ProjectメニューのSimul RecのRec Button Set
（89ページ）を選択します。

Rec Button Setの設定 ボタンとメモリーカード
“Rec Button:[SlotA 
SlotB] Handle Rec 
Button:[SlotA SlotB]”

どちらのボタンを押し
ても、メモリーカードA
とメモリーカードBに同
時に記録を開始/停止す
る。

“Rec Button:[SlotA] 
Handle Rec Button: 
[SlotB]”

録画START/STOPボタ
ンを押したときはメモ
リーカードAに、ハンド
ル録画START/STOPボ
タンを押したときはメモ
リーカードBに、記録を
開始/停止する。

“Rec Button:[SlotB] 
Handle Rec 
Button:[SlotA]”

録画START/STOPボタ
ンを押したときはメモ
リーカードBに、ハンド
ル録画START/STOPボ
タンを押したときはメモ
リーカードAに、記録を
開始/停止する。

［メモ］
グリップリモコンやLANCリモコンの録画ボタンは、本機
の録画START/STOPボタンと同じ動作をします。

ハンドル録画START/STOPボタンの
誤操作を防止するには

ハンドルHOLDスイッチをHOLD方向に操作しま
す。

［ご注意］
フルメニューのTechnicalメニュー >HOLD Switch 
Setting（105ページ）でwith Rec ButtonがOffの場合
は、ハンドルHOLDスイッチは機能しません。Onにするか、
Handle HOLD SwitchをRec Button Onlyにしてご利用
ください。

ハンドルの録画START/STOPボタン以外の
ズームレバーやボタンなどを有効にしたい場合
は、HOLD Switch SettingのHandle HOLD 
SwitchをRec Button Onlyにします。

ファイル名について

2スロット同時記録の場合は、生成されるクリッ
プはどちらのメディアも同じクリップ名になりま
す。通常記録でスロットAに記録した場合のクリッ
プ名と同じになります。

映像信号モニター

MonitoringメニューのDisplay On/Offの
Video Signal Monitor（100ページ）で、ビュー
ファインダー画面に表示する映像信号の種類を
ウェーブフォーム、ベクトルスコープ、ヒストグラ
ムのいずれかに設定できます。
オレンジの線はゼブラレベルの設定値を表しま
す。
Video Signal Monitorを割り当てたアサイナブ
ルボタン（52ページ）でも設定できます。

モニター対象の表示

Log撮影のときは、モニター対象を示す情報とし
て、色域設定（25ページ）またはモニター LUT
の設定（86ページ）が映像信号モニターの右上
に表示されます。
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ガンマ表示アシスト機能

撮影モード（25ページ）がCustomでTarget 
DisplayをHDR(HLG)にしたとき、モニタリング
ステータスのGamma Display Assist*をOnに
すると、ビューファインダーをHDR撮影しやすい
表示にすることができます。
*	 フルメニューのMonitoringメニュー>Gamma Display 
AssistのSetting（101ページ）でも設定可能。

ガンマ表示アシスト機能有効時に
ビューファインダーの表示を選択する

ガンマ表示アシスト機能が有効なときにビュー
ファインダーのHDR映像の表示方法を次の2種
類から選択できます。

HDRの低輝度部分や高輝度部分のコント
ラストを保持して表示する
HDRの表現力を活かし、明るめの露出、または
暗めの露出で撮影した場合にも、黒つぶれや白
飛びを起こさずに映像をビューファインダーに表
示できます。その反面、全体のコントラストは少
し低くなります。
この表示方法を使用するには、フルメニュー
のProjectメニュー>HDR SettingのVF SDR 
Preview（89ページ）をOffにします。

HDRからSDRへの変換を想定して簡易変
換されたSDRを表示
いままでのSDRと同様の感覚でのカメラオペレー
ションが可能です。
HDRとSDRのゲイン差をSDR Gainで設定するこ
とで、HDR映像の明るさを設定できます。

この表示方法を使用するには次の設定を行いま
す。

1	 フルメニューのProjectメニュー>HDR 
SettingのVF SDR Preview（89ページ）
をOnにする。

2	 フルメニューのProjectメニュー>HDR 
SettingのSDR Gain（89ページ）で、
HDRモード時のSDRゲイン値を調節する。

［メモ］
撮影後、SR Live Metadataを使用してHDR映像からSDR
に変換する場合、変換にSDR Gainが適用され、撮影時に
ビューファインダーで確認していた露出のSDR映像に変換
されます。

クリップフラグ

Clip Flagボタン（5ページ）を押すと、Add 
OK が実行されクリップにOKのクリップフラグが
付けられます。
2回続けて押すとDelete Clip Flagが実行され、
OKのクリップフラグが消えます。

［メモ］

ˎˎ クリップフラグ機能を割り当てたアサイナブルボタン使
用してクリップフラグを付けることもできます（52ペー
ジ）。
ˎˎ フルメニューのThumbnailメニューのSet Clip Flag
（104ページ）でクリップフラグを付けることもできます
（73ページ）。
ˎˎ サムネイル画面をクリップフラグの種類別に表示するこ
とができます（フィルタードクリップサムネイル画面）。詳
細は「クリップ操作」（73ページ）をご覧ください。

ブリージング補正

フルメニューのTechnicalメニュー>Lensの
Breathing Compensation（106ページ）で、
レンズのブリージング補正を行うかどうかを設定
できます。
ブリージングとは、フォーカス位置が変化すると
画角変動が起こる現象です。
ブリージング補正を実行すると、画角が一定にな
るよう電子的に画像が切り出され、ブリージング
のない撮影が可能になります。

［ご注意］

ˎˎ ブリージング補正を有効にすると、画角と画質がわずか
に変化します。
ˎˎ レンズによっては、ブリージング補正を有効に設定して
いても画角の変化を補正しきれない場合があります。
ˎˎ ブリージング補正に非対応のレンズが装着されている場
合は補正できません。
ˎˎ 以下のいずれかの条件では、本機能はOffに固定されま
す。
–– Technicalメニュー >LensのDistortion Comp.がOff
–– Shootingメニュー >S&Q MotionのSettingがOn
–– Projectメニュー >Rec FormatのCodecがRAWまた
はRAWを含んだ選択肢を設定中
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ボケを調節する（ボケ調節機
能）

アイリス操作にNDフィルターやゲインを連動さ
せて、ボケ具合を簡単に調節することができます。

ボケ調節機能のOn/Offを切り替える

本機能は露出の手動調節時のみ有効にすること
ができます。NDフィルターをバリアブルモードに
し、アイリス、ゲイン、シャッター、NDフィルター
を手動調節に設定してください。
フルメニューのShootingメニュー>IrisのBokeh 
Control（82ページ）で、ボケ調節機能のOn/
Offを切り替えることができます。
ボケ調節機能がOnの状態では、NDフィルター

およびゲインの表示に アイコンが表示されま
す。 

［メモ］
Bokeh Controlを割り当てたアサイナブルボタン（52
ページ）で、ボケ調節機能のOn/Offを切り替えることもで
きます。

ボケ具合を調節する

1	 ボケ調節機能をOnにする。

2	 アイリスを開放端にする。 

3	 NDフィルターを1/128に設定する。 

4	 ゲインを0dBにして、照明で適正露出にする。 

5	 フォーカスを合わせる。

6	 アイリスを調節する。
ボケ具合が変化します。

［メモ］

ˎˎ ボケ調節機能がOnの場合は、アイリス調節による露出
変化をNDフィルターおよびゲインが連動し相殺すること
で、ボケ具合を変化させることができます。
ˎˎ ボケ調節はアイリス操作に対して、まずNDフィルターか
ら連動します。NDフィルターが変化できなくなった際に、
ゲインが連動します。
ˎˎ MFのときは一旦アイリスを開けて、ピントを合わせてお
くことをお勧めします。
ˎˎ ボケ調節機能の代わりにオートNDフィルターを使用す
ると、NDフィルターが被写体の明るさの変化に追従し
ます。

ゲイン連動中の表示について

ボケ調節機能がOnのとき、アイリスを調整する
とゲインが変化することがあります。
ゲインが連動して変化した際は、画面上に注意

メッセージが表示され、ゲイン表示の アイコ
ンが点滅します。 

［ご注意］

ˎˎ 本機と通信できるEマウントレンズでのみ本機能は有効
です。
ˎˎ 本機能はソニー製のEマウントレンズでIrisリングを使っ
た操作で最大限の効果を得られます。
ˎˎ 操作スピード、レンズ、撮影設定、被写体によって見え
方が異なり、明るさが変化して見える場合があります。
撮影前のカメラテストを強くお勧めします。
ˎˎ アイリスを絞った後に開くとき、または開いた後に絞る
とき、のように操作方向を変更する際には明るさが変化
する場合があります。その場合は、あらかじめ余分に操
作してから少し戻して明るさを確認してから、撮影を開
始してください。	
例）F8から絞りを開いて背景をぼかしていく撮影をした
い場合、事前にF8よりも余分に絞った後に再度F8まで
開いてから明るさを確認し、撮影を開始してください。

ˎˎ ボケ調節の操作はゆっくり行ってください。操作を速くす
る場合は画の変化を確認しながら徐々にお試しください。
ˎˎ ボケ調節はすべての撮影条件で映像の品位を保証する
ものではありません。

ˎˎ 下記の操作をおこなったとき、ボケ調節機能がOffにな
ります。
–– 本機の電源をOffにしたとき
–– アイリス、ゲイン、シャッター、NDフィルターのい
ずれかをAutoにしたとき
–– 撮影モードを切り替えたとき
–– NDフィルターをクリアまたはプリセットモードにし
たとき
–– レンズを取り外したとき
–– 周波数切り替えなど、再起動を行ったとき

デスクイーズ表示設定

シネマスコープサイズの映像コンテンツを制作す
る場合、アナモフィックレンズを使用して撮影し
ます。
使用するアナモフィックレンズの倍率に合わせた
デスクイーズ表示設定をすると、直接被写体を見
たときと同じ縦横比に調整された映像をHDMI出
力したり、ビューファインダー画面に表示したり
することができます。
デスクイーズ表示は、Monitoringメニューの
De-SqueezeのRatio (HDMI/VF)（99ペー
ジ）で設定します。

［ご注意］
RAW出力時およびSD信号出力時は、HDMI出力映像はデ
スクイーズ表示されません。
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プロキシ記録をする
本機は高解像度のオリジナルクリップの動画をメ
モリーカードに記録しながら、低解像度のプロキ
シクリップを同時に記録できます。
プロキシクリップを短時間で自動分割して、記
録終了前でもファイルの転送を行うことができま
す。

˜˜ 使用可能なメモリーカードや、メモリーカードのフォー
マット方法、残容量の確認方法については「メモリー
カードを使う」（27ページ）をご覧ください。

撮影前の設定

1	 ProjectステータスのProxy Rec（15ペー
ジ）、またはフルメニューのProjectメニュー
のProxy Recで、Setting（89ページ）を
Onにする。

2	 メモリーカードをCFexpress Type A/SD
カードスロット（6ページ）に差し込む。

ˎˎ CFexpressカードの場合はラベルを左に
する。

ˎˎ SDカードの場合はラベルを右にして切り
欠き部を下にする。

［ご注意］

ˎˎ プロキシ記録は、S&Q Motionと同時にOnにすること
はできません。S&Q MotionをOnにしている間、プロ
キシ記録は一時的にOffになります。S&Q Motionを
Offにするとプロキシ記録はOnに戻ります。
ˎˎ プロキシ記録は、インターバルレックと同時にOnにする
ことはできません。プロキシ記録をOnにすると、これら
の機能は強制的にOffになります。

プロキシ記録で撮影する

撮影前に必要な設定が終わったら、録画START/
STOPボタンを押すと記録を開始します。

［ご注意］

ˎˎ メモリーカードにアクセス中に本機の電源を切ったりメ
モリーカードを抜いた場合はデータは保証されません。
メモリーカードに記録されたすべてのデータが壊れる可
能性があります。電源を切ったり、メモリーカードを抜
くときは、必ず使用するメモリーカードのアクセスランプ
が消灯していることを確認してから操作してください。
ˎˎ 出し入れ時にはメモリーカードの飛び出しにご注意くだ
さい。

撮影を終了するには、記録停止の操作を行いま
す。

プロキシ記録時のオーディオ
チャンネルを設定する

フルメニューのProjectメニュー>Proxy Recの
Audio Channel（89ページ）で、プロキシク
リップに記録するオーディオチャンネルを設定で
きます。

プロキシクリップを分割記録
し、転送する

オートアップロードの設定をChunkにすること
で、プロキシクリップが分割記録され、オリジナ
ルクリップの記録終了前にプロキシクリップを転
送することが可能になります。

分割記録したプロキシクリップの転送について
は、「クリップを自動転送する」（69ページ）、
「Creators' App for enterpriseを使用する」
（70ページ）をご覧ください。

1	 Projectメニュー>Proxy RecのChunk
（89ページ）で、分割記録時間を選択す
る。
30s：30秒単位でプロキシクリップを分割し
て記録します（初期設定値）。
1min：1分単位でプロキシクリップを分割し
て記録します。
2min：2分単位でプロキシクリップを分割し
て記録します。

2	 NetworkメニューのFile Transferで、Auto 
Upload (Proxy)（111ページ）をChunkに
する。
オリジナルクリップはスロットAのメディアに
記録され、分割記録したプロキシクリップは
スロットBのメディアに記録されます。

3	 プロキシ記録を開始する。
設定した分割記録時間ごとにプロキシクリッ
プが転送ジョブとしてジョブリストに登録さ
れます。

［ご注意］

ˎˎ Auto Upload (Proxy)をChunkに設定しない場合、プ
ロキシの分割記録は行われません。
ˎˎ スロットBのメディアは分割したプロキシクリップの記録
専用となるため、リレー記録や2スロット同時記録はで
きません。

記録されるファイルについて

拡張子は「.mp4」です。
タイムコードも同時に記録されます。

ファイルの保存先について

記録したファイルは、以下のディレクトリーに保
存されます。

記録メディア フォルダパス
SDXC /PRIVATE/XDROOT/

GENERAL/PXTMP
CFexpress Type A /XDROOT/GENERAL/

PXTMP

ファイル名について

メモリーカードに記録されるクリップ名+S03とな
ります。ただし、プロキシクリップを分割記録し、
転送する場合には、オリジナルクリップ名＋分割
番号＋S03となります。
クリップ名については、フルメニューの	
TC/MediaメニューのClip Name Format
（97ページ）をご覧ください。



3章　撮影59

好みのルックで撮影する
本機の撮影モード（25ページ）がCustomのと
きは、基本ルックをベースにブラックやマトリク
スなどの調節を加えてルックを構成します。

ブラック

：

マトリクス

ルック

基本ルック

これらの設定をSceneファイルに保存すること
で、内容の異なるルックを簡単に選ぶことができ
ます。
本機は、計6個のプリセットのルックを用意して
います。

ルックを選ぶ

1	 撮影画面でマルチファンクションダイヤルを
押す。

2	 （Sceneファイル）アイコンを選ぶ。

3	 マルチファンクションダイヤルを押す。

4	 メニューから好みのルックを選択し、マルチ
ファンクションダイヤルを押す。

［メモ］

ˎˎ 工場出荷時は、以下がプリセットされています。

Shooting Mode Custom

Target Display SDR(BT.709) HDR(HLG)

Sceneファイル 1 S-Cinetone HLG Live

Sceneファイル 2 Standard HLG Natural

Sceneファイル 3 Still 未登録

Sceneファイル 4 ITU709 未登録

Sceneファイル 5 709tone 未登録

Sceneファイル 6～ 16 未登録 未登録

ˎˎ MainステータスのScene File（14ページ）、または
フルメニューのPaint/Lookメニュー >Scene Fileの
Recall（94ページ）でもルックを選択することができ
ます。なお、プリセットのルックはScene FileのPreset 
Recallでも呼び出せます。

好みの基本ルックをインポー
トする

本機は、PCなどで作成した3D LUTファイルを、
基本ルックとしてメモリーカードまたはクラウド
サービスから最大16個までインポートすることが
できます。

ˎˎ ファイル形式：Catalyst BrowseやRAW 
Viewer、Blackmagic Design Pty. Ltd.製
DaVinci Resolve*で生成される17格子または
33格子のCUBEファイル（*.cube）
*	Resolve V9.0、V10.0およびV11.0にて確認

ˎˎ 入力色域/ガンマ：S-Gamut3.Cine/S-Log3
またはS-Gamut3/S-Log3

メモリーカードからインポートする

3D LUTファイルをメモリーカードからインポート
します。

1	 PCなどで記録メディアの所定のフォルダに、
3D LUTファイルを保存する。
記録メディア フォルダパス
SDXC /PRIVATE/SONY/PRO/

LUT/
CFexpress 
Type A

/SONY/PRO/LUT/

2	 3D LUTファイルを保存した記録メディアを、
CFexpress Type A/SDカードスロット（B）
に差し込む。

3	 フルメニューのPaint/Lookメニュー>Base 
LookのImport from Media(B)（94ペー
ジ）を選択する。

4	 インポート先を選択する。

5	 インポートする3D LUTファイルを選択する。
画面の指示に従ってください。本機は3D LUT
ファイルを基本ルックとして取り扱います。

6	 フルメニューのPaint/Lookメニュー>Base 
LookのSelect（94ページ）でインポート
した3D LUTファイルを選択する。

7	 インポートした3D LUTファイルの属性に合
わせて、フルメニューのPaint/Lookメニュー
>Base LookのInputとOutput（94ペー
ジ）を設定する。

クラウドサービスからインポートする

3D LUTファイルをクラウドサービスからインポー
トします。

1	 本機をスマートフォンアプリ「Creators' App 
for enterprise」に接続する（70ページ）。

2	 フルメニューのPaint/Lookメニュー>Base 
LookのImport from Cloud(Private)また
はImport from Cloud(Share)（94ペー
ジ）を選択する。

3	 インポート先を選択する。

4	 インポートする3D LUTファイルを選択する。
画面の指示に従ってください。本機は3D LUT
ファイルを基本ルックとして取り扱います。
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5	 フルメニューのPaint/Lookメニュー>Base 
LookのSelect（94ページ）でインポート
した3D LUTファイルを選択する。

6	 インポートした3D LUTファイルの属性に合
わせて、フルメニューのPaint/Lookメニュー
>Base LookのInputとOutput（94ペー
ジ）を設定する。

「Monitor & Control」アプリケーショ
ンからインポートする

3D LUTファイルを「Monitor & Control」アプリ
ケーションからインポートします。操作方法につ
いては、「Monitor & Control」アプリケーション
のヘルプをご覧ください。
本機を「Monitor & Control」アプリケーション
に接続する方法については、「デバイスとLAN接
続する」（63ページ）をご覧ください。

［ご注意］
「Monitor & Control」アプリケーションから3D LUTファイ
ルをインポートすることにより本機で使用中のBase Look
が変更された場合は、映像が乱れることがあります。

露出不足を調節する

インポートした基本ルックを使って自動露出をし
たときに露出不足の傾向がある場合は、Paint/
LookメニューのBase LookのAE Level Offset
（94ページ）で調節してください。

［ご注意］

ˎˎ 3D LUTファイルをインポートしただけでは映像に反映さ
れません。フルメニューのPaint/Lookメニュー >Base 
LookのSelect（94ページ）でインポートした3D LUT
ファイルを読み出してください。
ˎˎ Inputを正しく設定しないと、本来のルックになりませ
ん。

ˎˎ 設定項目Input、Output、AE Level Offsetは、
Selectで選択された基本ルックに適用されます。複
数の3D LUTファイルをインポートした場合は、各3D 
LUTファイルをSelectで選択し、Input、Output、AE 
Level Offsetをそれぞれ設定してください。
ˎˎ 設定したInput、Output、AE Level Offsetは、3D 
LUTファイルごとに保存されます。
ˎˎ インポートした3D LUTファイルは、SDR(BT.709)/
HDR(HLG)/Log撮影共通の基本ルック/LUT選択肢と
なりますが、これらのモードに応じた色域・ガンマ変換
は行いません。
ˎˎ フルメニューのMaintenanceメニューのAll Resetの
Reset（112ページ）を実行しても3D LUTファイルは削
除されません。

ルックをカスタマイズする

フルメニューのPaint/LookメニューのMatrixな
どの各設定項目で、基本ルックを基にルックをカ
スタマイズすることができます。各設定項目の詳
細は94ページを参照してください。
設定するときは、本機をテレビやモニターにつな
いで、画像を確認しながら調節してください。

［ご注意］
3D LUTファイルをインポートして映像に適用したとき、
Paint/LookメニューのMatrixなどの基本ルック以外の各
設定が変更されていると、3D LUTファイルに定義された
通りのルックになりません。フルメニューのPaint/Lookメ
ニュー >Reset Paint SettingsのReset without Base 
Look（94ページ）で、カスタマイズされた設定値をまと
めてリセットできます。

ルックを保存する

フルメニューのPaint/Lookメニュー>Scene 
FileのStore（94ページ）で、現在のルックを
Sceneファイルとして内部メモリーに保存できま
す。
撮影画面からダイレクトメニューの操作で簡単に
呼び出せるようになります。

［ご注意］

ˎˎ ルックを保存せずにほかのルックを選択すると、保存前
のルックは破棄されます。
ˎˎ フルメニューのMaintenanceメニュー >All Resetの
Reset（112ページ）を実行しても、Sceneファイルは
削除されません。

［メモ］
プリセットのSceneファイルも上書きできます。
プリセットのSceneファイルを復元するには、フルメニュー
のPaint/Lookメニュー >Scene FileのPreset Recall
（94ページ）で復元したいルックを読み出したあと、
Scene FileのStoreでSceneファイルに保存してください。

保存したルックを削除する

フルメニューのPaint/Lookメニュー>Scene 
FileのDelete（94ページ）で、内部メモリーに
保存されているSceneファイルを削除できます。

［メモ］
削除すると、ダイレクトメニューに表示されなくなります。

基本ルックを削除する

フルメニューのPaint/Lookメニュー>Base 
LookのDelete（94ページ）で、インポートし
た3D LUTファイルを削除できます。
フルメニューのPaint/Lookメニュー>Base 
LookのDelete All（94ページ）で、すべての
3D LUTファイルを削除できます。

［ご注意］

ˎˎ 削除する前に、その基本ルックがSceneファイルで使用
されていないことをご確認ください。使用されている基
本ルックを削除した場合、該当するSceneファイルのルッ
クは不適切なものになります。
ˎˎ インポートした3D LUTファイルは、フルメニューの
MaintenanceメニューのAll ResetのReset（112ペー
ジ）を実行しても削除されません。
ˎˎ 削除した基本ルックは、Log撮影でもLUTとして使えな
くなります（61ページ）。
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ポストプロダクションでルックを調節する前提で撮影する
撮影モードのLog撮影を選択し、暗部から明部
まで諧調を均等に記録すると、ポストプロダク
ションで局所的に暗部や明部の諧調を復元する
など細かい調節を行うことができます。
しかし、この記録映像を普通のモニターで見ると、
全体にコントラストが低いため、フォーカスや露
出などの調節が困難です。
本機では、モニター映像にLUTを適用して撮影
時の各種調節を補助することができます。また、
再生映像にLUTを適用して仕上がりを確認するこ
ともできます。
LUTは以下の系統別に適用されます。ただし、
適用されるLUTは1種類です。

ˎˎ SDI出力およびHDMI出力

ˎˎ VFおよびProxy、ストリーミング

ˎˎ 記録メディアに記録される映像

VF映像にLUTを適用する

1	 MENUボタンを押してMonitoringステータ
スを表示する。

2	 VF行のGamut/Gamma列を選ぶ。

3	 OnまたはOffを選ぶ。

［ご注意］

ˎˎ VFのLUT On/Off設定は、Proxyファイルやストリーミ
ング映像にも作用します。
ˎˎ ピント拡大中は、ガンマ表示アシストになります。

［メモ］

ˎˎ フルメニューのShootingメニュー >LUT On/OffのVF/
Proxy/Stream（86ページ）でも設定できます。
ˎˎ SDI/HDMIもVFと同様に設定できます。
ˎˎ 記録メディアの映像については、フルメニューの
Shootingメニュー >LUT On/OffのInternal Rec
（86ページ）で設定できます。

LUTを変更する

1	 MENUボタンを押して、Monitoringステー
タスを表示する。

2	 Base Look/LUT欄を選ぶ。

3	 基本ルックのリストから、適用するLUTを選
ぶ。

［メモ］

ˎˎ 本機にはプリセットのLUTとして、s709、709(800%)、
S-Log3が用意されています。
ˎˎ 3D LUTファイルをインポートして適用することもで
きます。詳しくは、「好みの基本ルックをインポート
する」（59ページ）および「基本ルックを削除する」
（60ページ）をご覧ください。
ˎˎ フルメニューのPaint/Lookメニュー >Base Lookの
Select（94ページ）でも設定できます。

記録する映像情報の暗部・
明部の配分を変える

Cine EI/Cine EI Quickでは、明部より暗部の諧
調を優先したい場合など、Exposure Indexを
基準感度から変更すると、暗部・明部の配分を
変えた撮影ができます。

1	 VF映像にLUTを適用する（61ページ）。

2	 MENUボタンを押して、Cameraステータス
を表示する。

3	 Exposure IndexのL/M/H欄を設定する。
それぞれの値が、ISO/GAINスイッチ
（5ページ）のL/M/Hポジションに割り
当てられます。

4	 適用するExposure IndexをISO/GAINス
イッチで選ぶ。

5	 VF映像が適正になるように露出を調節す
る。

［ご注意］
ピント拡大中はガンマ表示アシストになります。ガンマ表
示アシストにはExposure Indexは適用されません。

［メモ］

ˎˎ フルメニューのShootingメニュー >ISO/Gain/EIの
Exposure Index（80ページ）でも設定できます。
ˎˎ 設定値の後半部の数値は、明部（18%グレーの高輝度側）
に何段分の輝度情報を割り当てるかを表しています。こ
れより明るい領域は白飛びします。	
例）「400EI / 5.0E」：5.0段分を高輝度側に割り当てる。

ˎˎ 撮影中に暗部・明部の諧調を確認する目的で使うことも
できます。たとえばMポジションに基準感度、Lポジショ
ンに2段マイナス、Hポジションに2段プラスの値を設定し
ておき、ISO/GAINスイッチを切り替えて確認します。確
認後、Mポジションに戻し忘れないよう、ご注意ください。

3D LUTファイルをメタデータ
として記録する

撮影時にモニター映像に適用していた3D LUT
ファイル（CUBEファイル）を、クリップにメタデー
タとして記録することができます。
この機能を有効にするには、フルメニューの
ProjectメニューのCine EI/Flex.ISO Setで
Embed LUT File（88ページ）をOnに設定し
ます。
記録開始時に選択していた3D LUTファイル
（CUBEファイル）をメタデータとして記録します。
ただし、以下の場合はメタデータとして記録する
ことはできません。

ˎˎ 過去のバージョンでインポートされた3D LUT
ファイル（Base Look選択時、ファイル名の前
に「！」が表示されているファイル）を選択して
いる場合

ˎˎ 保存が可能な3D LUTファイルを選択時に、適
用するLUTデータを変更した直後に記録を開
始した場合

ˎˎ フルメニューのShootingメニュー>LUT On/
OffのInternal Rec（86ページ）がMLUT 
Onの場合

［ご注意］
1つのクリップに記録できるメタデータは1つのみです。

［メモ］
使用した3D LUTファイルは、メディアの所定のフォルダに
保存されます。

記録メディア フォルダパス

SDXC /XDROOT/GENERAL/LUT

CFexpress Type A
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本機のSDI OUT端子やHDMI OUT端子から出力
したRAW動画信号を、対応する外部レコーダー
に記録できます。

SDI OUT端子から記録する

1	 外部RAWレコーダーを本機のSDI OUT端子
に接続する。

2	 Projectステータス（15ページ）、また
はフルメニューのProjectメニュー>Base 
SettingのShooting Mode（87ページ）
でCine EIを選択する。

3	 ProjectステータスのImager Scan、また
はフルメニューのProjectメニュー>Rec 
FormatのImager Scan Mode（87ペー
ジ）で画角（FFのみ）を選択する。

4	 Projectステータス、またはフルメニュー
のProjectメニュー>Rec FormatのCodec
（87ページ）でRAWを選択する。
RAW&XAVC-Iなどを選ぶと、外部RAWレ
コーダーでの記録と同時に、本機のメモリー
カードに動画を記録することができます。

5	 Projectステータス、またはフルメニュー
のProjectメニュー>Rec FormatのRAW 
Output Format（87ページ）で解像度を
選択する。

6	 外部レコーダーの電源が入っていることを確
認し、本機の録画START/STOPボタンを押
す。

	 ［ご注意］
本機の録画START/STOPボタンを使わずに外部レ
コーダーで録画操作を行うと、正常に記録されない場
合があります。

サポートをしているRAW出力フォーマットは以下
のとおりです。

システム
周波数

Codec RAW Output 
Format

59.94/
50/
29.97/
25/
23.98

RAW 4096×2160
3840×2160

RAW & XAVC-I 4096×2160
3840×2160

24 RAW 4096×2160
RAW & XAVC-I 4096×2160

HDMI OUT端子から記録す
る

1	 外部RAWレコーダーを本機のHDMI OUT端
子に接続する。

2	 Projectステータス（15ページ）、また
はフルメニューのProjectメニュー>Base 
SettingのShooting Mode（87ページ）
でCine EIを選択する。

3	 ProjectステータスのImager Scan、また
はフルメニューのProjectメニュー>Rec 
FormatのImager Scan Mode（87ペー
ジ）で画角（FFのみ）を選択する。

4	 Projectステータス、またはフルメニュー
のProjectメニュー>Rec FormatのCodec
（87ページ）でRAW(HDMI)を選択する。
RAW(HDMI) & XAVC-Iを選ぶと、外部
RAWレコーダーでの記録と同時に、本機の
メモリーカードに動画を記録することができ
ます。

5	 外部レコーダーの電源が入っていることを確
認し、本機の録画START/STOPボタンを押
す。

［ご注意］
本機の録画START/STOPボタンを使わずに外部レコーダー
で録画操作を行うと、正常に記録されない場合があります。

サポートをしているRAW出力フォーマットは以下
のとおりです。

システム
周波数

Codec RAW Output 
Format

59.94/
50/
29.97/
25/
23.98

RAW(HDMI) 4240×2392
RAW(HDMI) & 
XAVC-I

4240×2392

記録状態表示

フルメニューのMonitoringメニューのDisplay 
On/Off（99ページ）で、RAW Output 
Control StatusがOnに設定されている場合は、
ビューファインダー画面にRAW動画の記録状態
がアイコンで表示されます。

［ご注意］
本機はSDI OUT端子から記録制御信号を出力しますが、
外部レコーダーの状態を取得することはできません。その
ため、本機でRAW動画の記録中と表示していても、実際
に記録していないことがあります。正確な動作状態は外部
レコーダー上の表示で確認してください。

［メモ］
RAW Output Formatの設定値も表示されます。

スロー＆クイックモーション
記録

ShootingメニューのS&Q Motionで、Setting
がOnに設定されている場合は、スロー＆クイッ
クモーションモードでRAW動画を記録します。
撮影可能なフレームレートは53ページをご覧
ください。

［ご注意］
HDMI OUT端子からのスロー＆クイックモーション記録に
は対応していません。

RAW動画を記録する
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デバイスとLAN接続する
本機のLAN機能を使用して、スマートフォンやタ
ブレットなどのデバイスと本機をLAN接続するこ
とができます。
LAN接続されたデバイスと本機の間では、
「Monitor & Control」アプリケーションを用い
て、以下が可能です。

ˎˎ 映像をモニタリング	
本機のカメラ映像や再生映像を、「Monitor & 
Control」アプリケーションを使ってデバイスで
モニタリングすることができます。

ˎˎ リモート操作	
本機とLAN接続されたスマートフォンやタブ
レットから本機をリモート操作することができ
ます。

ˎˎ ファイル転送	
本機のメモリーカードに記録したプロキシファ
イル（低解像度）やオリジナルファイル（高解像
度）を、LAN経由でサーバーに転送することが
できます。

	 ［ご注意］

ˎˎ 本機では、「Content Browser Mobile」アプリケー
ションによるリモート操作などは行えますが、映像の
モニタリングはできません。
ˎˎ 以下の設定のときは映像をモニタリングできません。
–– システム周波数が24
–– インターバルレックモード

ˎˎ 本機の無線LANモジュールが故障した場合は、フ
ルメニューのNetworkメニュー >Wireless LANの
Setting（108ページ）をOffにしてください。無線
LANモジュールが故障した場合でも、本機の撮影・
録再機能は正常に動作します。

「Monitor & Control」アプリケーショ
ン

デバイスの画面で本機の映像をモニタリングしな
がら、リモート操作や本機の設定をすることが
できるアプリケーションを用意しています。

˜˜「Monitor & Control」アプリケーションについては、
お買い上げ店またはソニーのサービス窓口にご確認く
ださい。

ユーザー名とパスワードを設
定する

ネットワーク機能をご利用の際は、まず本機に
ユーザー名とパスワードを設定してください。

1	 フルメニューのNetworkメニュー>Access 
AuthenticationのUser Name（108ペー
ジ）を設定する。

2	 フルメニューのNetworkメニュー>Access 
AuthenticationのInput Password（108
ページ）を設定する。

	 ［メモ］

ˎˎ パスワードを自動生成することもできます。Input 
Passwordの代わりにGenerate Passwordを実行
します。
ˎˎ Show Settingsでユーザー名やパスワードを、文字
やQRコードで見ることができます。

	 ［ご注意］
QRコードやパスワードを他者に盗み見られないよう、
ご注意ください。

無線LANアクセスポイント
モード（Access Pointモード）
で接続する

本機をアクセスポイントとしてデバイスと無線
LAN 接続します。

スマートフォン/タブレット

NFC機能搭載のデバイスでワンタッチ
接続する

［メモ］
「Monitor & Control」アプリケーションはNFC機能による
LAN接続には対応していません。NFC機能を利用してLAN
接続する場合は、「Content Browser Mobile」アプリケー
ションを用います。

デバイスがNFCをサポートしている場合には、
NFCを利用したワンタッチ接続が可能です。

1	 デバイスの「設定」を起動して「その他の設
定」を選び、「NFC/おサイフケータイ設定」
の「NFC R/W P2P」または「Reader/Writer, 
P2P」にチェックを入れる。

2	 本機の電源を入れる。

3	 NFC機能を有効にする。
NFCを割り当てたアサイナブルボタンを長
押し（3秒間）するか、Networkメニューの
Wireless LANのNFCを実行して、NFC接続
モードにしてください。
画面に  が表示されているときのみNFC機
能を使用できます。

4	 本機とデバイスをタッチする。
デバイスが本機に接続され、「Content 
Browser Mobile」が起動します。

	 ［ご注意］

ˎˎ 一部の  が付いているデバイスはNFCに対応し
ています。詳しくはデバイスの取扱説明書でご確認
ください。
ˎˎ あらかじめデバイスのスリープおよび画面ロックを
解除してください。
ˎˎ デバイスで「Content Browser Mobile」が起動す
るまで（1～2秒）動かさずにタッチし続けてください。
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WPS機能搭載のデバイスで接続する

デバイスがWPSをサポートしている場合には、
WPSでの接続が可能です。

1	 フルメニューのNetworkメニュー
>Wireless LANのSettingで、Access 
Point Modeを選択する。

2	 フルメニューのNetworkメニュー
>Wireless LANのWPSを実行する。

3	 デバイスのNetwork設定/Wi-Fi設定を開
き、Wi-FiをOnにする。

4	 Wi-Fi NetworkのSSID一覧から、本機
のSSIDを選択し、詳細Optionを表示し、
WPS Push Buttonを選択して接続する。

	 ［ご注意］

ˎˎ 使用する機器によっては、操作が異なる場合があり
ます。
ˎˎ 本機のSSIDおよびPasswordは、フルメニュー
のNetworkメニュー >AP Mode Settingsの
Camera SSID & Password（108ページ）で表示
してご確認ください。

5	 Monitor & Controlアプリケーションで接
続する。

	 ［メモ］
本機に接続するための情報は、フルメニューの
Networkメニュー >Access Authenticationの
Show Settings（108ページ）で確認できます。

デバイスでSSID、Passwordを入力し
て接続する

デバイス側で本機のSSIDとPasswordを入力し
て接続します。

1	 フルメニューのNetworkメニュー
>Wireless LANのSettingで、Access 
Point Modeを選択する。

2	 デバイスのNetwork設定/Wi-Fi設定を開
き、Wi-FiをOnにする。

3	 Wi-Fi NetworkのSSID一覧から、本機の
SSIDを選択し、Passwordを入力して接続
する。
本機のSSIDおよびPasswordは、Network
メニューのAP Mode SettingsのCamera 
SSID & Password（108ページ）でご確認
ください。

	 ［ご注意］
使用する機器によっては、操作が異なる場合がありま
す。

4	 Monitor & Controlアプリケーションで接
続する。

	 ［メモ］
本機に接続するための情報は、フルメニューの
Networkメニュー >Access Authenticationの
Show Settings（108ページ）で確認できます。

無線LANステーションモード
（Stationモード）で接続する

本機をクライアントとして既存の無線LANのアク
セスポイントに接続します。デバイスとはアクセ
スポイント経由で接続します。
接続したアクセスポイントの履歴は、過去10件
まで記憶されます。
接続履歴はALLファイルに保存されますが、アク
セスのパスワードは保存されないため、ALLファ
イル読み込み後の再接続の際にはパスワードの
入力が必要となります。

スマートフォン/
タブレット

アクセスポイント

コンピューター

WPS機能を使ってアクセスポイントに
接続する

アクセスポイントがWPS機能対応の場合は、簡
単な設定で接続することができます。

1	 アクセスポイントの電源を入れる。

2	 本機の電源を入れる。

3	 フルメニューのNetworkメニュー
>Wireless LANのSettingで、Station 
Modeを選択する。

4	 フルメニューのNetworkメニュー>ST 
Mode SettingsのCamera Remote 
Control（109ページ）で、Enableを選択
する。

5	 フルメニューのNetworkメニュー
>Wireless LANのWPSを実行する。

6	 アクセスポイントのWPS ボタンを押す。
WPS ボタンの操作については、アクセスポ
イントの取扱説明書をご覧ください。
接続が完了すると、ビューファインダー画面
のネットワーク状態表示のアイコンが強度1
以上で点灯します。

	 ［ご注意］
接続に失敗した場合は手順1からやり直してください。

7	 デバイスをアクセスポイントに接続する。
接続のしかたについては、各機器の取扱説
明書をご覧ください。
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8	 デバイスでMonitor & Controlアプリケー
ションを実行し、本機を選ぶ。

	 ［メモ］
本機に接続するための情報は、フルメニューの
Networkメニュー >Access Authenticationの
Show Settings（108ページ）で確認できます。

アクセスポイント自動検出機能を使っ
て接続する

1	「WPS機能を使ってアクセスポイントに接続
する」（64ページ）の手順1～ 3を行う。

2	 フルメニューのNetworkメニュー>ST 
Mode SettingsのScan Networks（109
ページ）で、Executeを選択する。
本機が接続先の検出を開始します。
接続先の候補が見つかると一覧表示されま
す。

3	 一覧から接続先を選択する。
ネットワーク（アクセスポイント）詳細設定画
面が表示されます。SSIDには選択した接続
先が表示されます。

4	 Passwordを選択し、パスワード入力画面
で接続先のアクセスポイントのパスワードを
入力する。
接続履歴にあるSSIDを選択すると、パスワー
ドを含んだ設定値が自動的に設定されます。
パスワードを設定したら、ネットワーク（アク
セスポイント）詳細設定画面に戻ります。

5	 以下の接続設定を行う。
ˎˎ DHCP	
DHCPを設定します。	

Onにすると、自動的に本機にIPアドレスを
割り当てます。	
手動で本機のIPアドレスを入力する場合
は、Offにします。

ˎˎ IP Address	
本機のIPアドレスを入力します。	
DHCPがOffのときに有効です。

ˎˎ Subnet Mask	
本機のサブネットマスクを入力します。	
DHCPがOffのときに有効です。

ˎˎ Gateway	
アクセスポイントのゲートウェイを入力します。	
DHCPがOffのときに有効です。

ˎˎ DNS Auto	
DNS自動取得設定をします。	
Onにすると、自動的にDNSサーバーのア
ドレスを取得します。DHCPがOnのときに
有効です。

ˎˎ Primary DNS Server	
アクセスポイントのプライマリーDNSサー
バーを入力します。	
DNS AutoがOffのときに有効です。

ˎˎ Secondary DNS Server	
アクセスポイントのセカンダリーDNSサー
バーを入力します。	
DNS AutoがOffのときに有効です。

6	 設定が完了したらConnectを選択し、アク
セスポイントに接続する。

7	 デバイスをアクセスポイントに接続する。
接続のしかたについては、各機器の取扱説
明書をご覧ください。

8	 デバイスでMonitor & Controlアプリケー
ションを実行し、本機を選ぶ。

	 ［メモ］
本機に接続するための情報は、フルメニューの
Networkメニュー >Access Authenticationの
Show Settings（108ページ）で確認できます。

アクセスポイントの情報を手動で入力
して接続する

1	「WPS機能を使ってアクセスポイントに接続
する」（64ページ）の手順1～ 3を行う。

2	 フルメニューのNetworkメニュー>ST 
Mode SettingsのManual Register（110
ページ）で、Executeを選択する。
決定すると、ネットワーク（アクセスポイント）
詳細設定画面が表示されます。

3	 以下の接続設定を行う。
ˎˎ SSID	
接続先のアクセスポイントのSSIDを入力し
ます。

ˎˎ Security	
暗号化方式を選択します。

ˎˎ Password	
接続先のアクセスポイントのパスワードを
入力します。

ˎˎ DHCP	
DHCPを設定します。	
Onにすると、自動的に本機にIPアドレスを
割り当てます。	
手動で本機のIPアドレスを入力する場合
は、Offにします。

ˎˎ IP Address	
本機のIPアドレスを入力します。	
DHCPがOffのときに有効です。

ˎˎ Subnet Mask	
本機のサブネットマスクを入力します。	
DHCPがOffのときに有効です。

ˎˎ Gateway	
ゲートウェイのアドレスを入力します。	
DHCPがOffのときに有効です。

ˎˎ DNS Auto	
DNS自動取得設定をします。	
Onにすると、自動的にDNSサーバーのア
ドレスを取得します。DHCPがOnのときに
有効です。

ˎˎ Primary DNS Server	
プライマリーDNSサーバーのアドレスを入
力します。	
DNS AutoがOffのときに有効です。

ˎˎ Secondary DNS Server	
セカンダリーDNSサーバーのアドレスを入
力します。	
DNS AutoがOffのときに有効です。

4	 設定が完了したらConnectを選択し、アク
セスポイントに接続する。

5	 デバイスをアクセスポイントに接続する。
接続のしかたについては、各機器の取扱説
明書をご覧ください。

6	 デバイスでMonitor & Controlアプリケー
ションを実行し、本機を選ぶ。

	 ［メモ］
本機に接続するための情報は、フルメニューの
Networkメニュー >Access Authenticationの
Show Settings（108ページ）で確認できます。
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本機は、USBテザリング、無線LAN、有線LAN
でインターネットに接続することができます。
あらかじめ本機にユーザー名とパスワードを設定
してください（63ページ）。

［ご注意］
本機の無線LANモジュールが故障した場合は、フルメニュー
のNetworkメニュー >Wireless LANのSetting（108ペー
ジ）をOffにしてください。無線LANモジュールが故障した
場合でも、本機の撮影・録再機能は正常に動作します。

USBテザリングを使用して接
続する

USBケーブルで本機とスマートフォンを接続し、
スマートフォンの回線を使用してインターネットに
接続できます。

スマートフォンを本機に取り付ける

本機のUSB-C端子（7ページ）にUSBケーブ
ルを接続し、スマートフォンを接続します。

［ご注意］

ˎˎ スマートフォンの取り付け/取り外しは、本機の電源を
切った状態で行ってください。
ˎˎ USBハブを介してスマートフォンを取り付けた場合、
USBテザリングは使用できません。
ˎˎ USB/マルチ端子（7ページ）にコンピューターが接続
されている場合、USBテザリングは使用できません。

本機のUSBテザリング機能を有効に
する

1	 本機の電源を入れる。

2	 Networkステータスまたはフルメニューの
NetworkメニューのModemで、Setting
（110ページ）をOnに設定する。

スマートフォンの通信設定をする

スマートフォンのテザリング通信を有効に設定し
ます。
詳しくは、スマートフォンの取扱説明書をご覧く
ださい。

スマートフォンからの操作を有効にす
る

USBケーブルで接続したスマートフォンで
Monitor & Controlアプリケーションを使用して
本機を遠隔操作できます。

1	 フルメニューのNetworkメニュー>Modem
のCamera Remote Control（110ページ）
をEnableに設定する。

2	 スマートフォンでMonitor & Controlアプリ
ケーションを実行し、本機を選ぶ。

	 ［メモ］
Monitor & Controlアプリケーションが本機に接続
するための情報は、フルメニューのNetworkメニュー
>Access AuthenticationのShow Settings（108
ページ）で確認できます。

無線LANステーションモード
（Wi-Fi Stationモード）で接
続する

Wi‑Fiルーター（別売）またはスマートフォンの
Wi-Fiテザリングを使用することによって、Wi-Fi
ステーションモードでインターネットに接続する
ことができます。

Wi‑Fiルーターまたはデバイスへは、「無線LAN
ステーションモード（Stationモード）で接続する」
（64ページ）の手順で接続します。

スマートフォン/
タブレット

Wi‑Fiルーター

コンピューター

インターネット

スマートフォン/
タブレット

インターネット

LANケーブルを使用して接続
する

本機のUSB-C端子（7ページ）に取り付けた
有線LANアダプター（別売）の有線LAN端子と
Wi‑Fiルーター（別売）をLANケーブルで接続す
ることによって、インターネットに接続すること
ができます。

スマートフォン/
タブレット

コンピューター

Wi-Fiルーター

有線LAN	
アダプター

インターネット

インターネットに接続する
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LANケーブルの接続と有線LAN設定

1	 本機のUSB-C端子に有線LANアダプターを
取り付ける。

2	 有線LANアダプターの有線LAN端子と
Wi‑FiルーターをLANケーブルで接続する。

3	 本機の電源を入れる。

4	 Networkステータスまたはフルメニューの
Networkメニュー>Wired LANのSetting
（110ページ）をOnに設定する。

5	 NetworkメニューのWired LANのDetail 
Setting（110ページ）で、接続設定を行う。

ˎˎ DHCP	
DHCPを設定します。	
Onにすると、自動的に本機にIPアドレスを
割り当てます。	
手動で本機のIPアドレスを入力する場合
は、Offにします。

ˎˎ IP Address	
本機のIPアドレスを入力します。	
DHCPがOffのときに有効です。

ˎˎ Subnet Mask	
本機のサブネットマスクを入力します。	
DHCPがOffのときに有効です。

ˎˎ Gateway	
ゲートウェイのアドレスを入力します。	
DHCPがOffのときに有効です。

ˎˎ DNS Auto	
DNS自動取得設定をします。	
Onにすると、自動的にDNSサーバーのア
ドレスを取得します。DHCPがOnのときに

有効です。

ˎˎ Primary DNS Server	
プライマリーDNSサーバーのアドレスを入
力します。	
DNS AutoがOffのときに有効です。

ˎˎ Secondary DNS Server	
セカンダリーDNSサーバーのアドレスを入
力します。	
DNS AutoがOffのときに有効です。

6	 設定が完了したらSetを選択し、設定内容を
確定する。

［ご注意］

ˎˎ 接続設定を変更した場合、必ずSetを選択してください。
Setを選択しなかった場合は設定した内容が反映されま
せん。
ˎˎ USB有線LANアダプターはType-C型をご使用ください。
ギガビットイーサネット対応アダプターのご使用をおすす
めします。ただし、すべての製品の動作を保証するもの
ではありません。
ˎˎ USB/マルチ端子（7ページ）にコンピューターが接続
されている場合、USB有線LANアダプター（別売）は使
用できません。
ˎˎ 有線LANアダプター（別売）の機種によっては本機内蔵
のWi-Fi通信機能に影響を及ぼすことがあります。

有線LANを経由したスマートフォンか
らの操作を有効にする

有線LANで接続したWi-Fiルーターの先から、ス
マートフォンでMonitor & Controlアプリケー
ションを使用して本機を遠隔操作する場合は、
フルメニューのNetworkメニュー>Wired LAN
のCamera Remote Control（110ページ）を
Enableに設定します。
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ファイルを転送する
本機に記録したプロキシクリップやオリジナルク
リップを、スマートフォンやアクセスポイント経
由で接続したインターネット上のサーバーやロー
カルネット上のサーバーへ転送することができま
す。

準備する

ネットワークに接続する

「インターネットに接続する」（66ページ）また
は「デバイスとLAN接続する」（63ページ）の
手順に従って、本機をインターネットまたはロー
カルネットワークに接続します。

クリップの転送先を登録する

あらかじめクリップを転送するサーバーを登録し
ておきます。

1	 フルメニューのNetworkメニューのFile 
Transferで、Server Settings1（または
Server Settings2、Server Settings3）を
選択する。
転送先設定画面が表示されます。

2	 転送先設定画面の各項目を設定する。
Display Name
転送先のリストに表示されるサーバー名を入
力します。
Service
サーバーの種類を表示します。
「FTP」：FTP サーバー
Host Name
サーバーのアドレスを入力します。

Port
サーバーに接続する際のポート番号を入力し
ます。
User Name
ユーザー名を入力します。
Password
パスワードを入力します。
Passive Mode
パッシブモードのON/OFFを行います。
Destination Directory
転送先ディレクトリー名を入力します。

	 ［ご注意］

ˎˎ オリジナルクリップは、転送先として指定したディ
レクトリー内の“Main”フォルダーに転送されます。
ˎˎ 編集時、編集不可能な文字は“□”で表示されます。
この文字を含むディレクトリー名を編集した場合の
動作は保証されません。	
もし編集してしまった場合は、すべての文字を削除
して入力し直してください。
ˎˎ 転送先サーバーで使用できない文字をDestination 
Directoryに入力した場合、ファイルはユーザーの
ホームディレクトリーに転送されます。使用できな
い文字はサーバーによって異なります。
Using Secure Protocol
セキュアなFTP転送を行うかどうかを設定し
ます。
Root Certificate
証明書の読み込みや消去を行います。

ˎˎ Load	
手順3でSetを選択すると、CA証明書を読
み込みます。

*	 読み込む証明書はPEM形式で、CFexpress Type 
A/SDカードスロット（B）に挿入したメモリーカード
のルートディレクトリーに“certification.pem”の
ファイル名で書き込んでおいてください。

ˎˎ Clear	
手順3でSetを選択すると、CA証明書をク
リアします。

ˎˎ None	
読み込み/消去を行いません。

	 ［ご注意］

ˎˎ CA証明書を読み込む際は、本機の時刻を正しく設
定してください。
ˎˎ XAVC-I 4096×2160P/3840×2160P 
59.94/50Pで記録中は、Loadは選択できません。
ˎˎ 低電圧時には、CA証明書をLoad/Clearすること
はできません。
Root Certificate Status
証明書の読み込み状態を表示します。
Reset
Server Settingsの設定を初期値に戻しま
す。

3	 設定が完了したらSetを選択し、設定内容を
確定する。
設定完了後は、必ずSetを選択してください。
Setを選択しなかった場合、設定した内容が
反映されません。

クリップを選んで転送する

本機のメモリーカードに記録したプロキシクリッ
プやオリジナルクリップをサーバーに転送します。
転送操作は、サムネイル画面から行います。

［ご注意］
分割記録したプロキシクリップは自動転送専用ファイルに
なるため、選んで転送はできません。

サムネイル画面からメモリーカードの
プロキシクリップを転送する

1	 本機をインターネットに接続する（66ペー
ジ）。

2	 THUMBNAILボタンを押してサムネイル画面
を表示させる。

	 ［メモ］
フィルタードクリップサムネイル画面（73ページ）で
も操作できます。

3	 フルメニューのThumbnailメニューの
Transfer Clip (Proxy)で、Select Clipを選
択する。

4	 転送したいクリップを選択し、最後にMENU
ボタンを押す。
転送実行の確認画面が表示されます。

5	 Executeを選択する。
選択したオリジナルクリップに対応するプロ
キシクリップが転送ジョブとして登録され、
転送が開始されます。
転送ジョブへの登録が完了すると、登録結
果画面が表示されます。
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6	 OKを選択する。

クリップを一括転送するには
手順3でSelect Clipではなく、All Clipsを選択
するとオリジナルクリップに対応するプロキシク
リップが一括転送されます。

［ご注意］
転送できるジョブの上限は200件です。

サムネイル画面からメモリーカードの
オリジナルクリップを転送する

［ご注意］
オリジナルクリップは、転送先として指定したディレクト
リー内の“Main”フォルダーに転送されます。

1	 本機をインターネットに接続する（66ペー
ジ）。

2	 THUMBNAILボタンを押してサムネイル画面
を表示させる。

	 ［メモ］
フィルタードクリップサムネイル画面（73ページ）で
も操作できます。

3	 フルメニューのThumbnailメニューの
Transfer Clipで、Select Clipを選択する。

4	 転送したいクリップを選択し、最後にMENU
ボタンを押す。
転送実行の確認画面が表示されます。

5	 Executeを選択する。
選択したクリップが転送ジョブとして登録さ
れ、転送が開始されます。
転送ジョブへの登録が完了すると、登録結
果画面が表示されます。

6	 OKを選択する。

クリップを一括転送するには
手順3でSelect Clipではなく、All Clipsを選択
するとクリップが一括転送されます。

［ご注意］
転送できるジョブの上限は200件です。

ファイル転送の確認をする

フルメニューのNetworkメニューのFile 
TransferでView Job List（111ページ）を選択
すると、ファイル転送の状態を確認することがで
きます。
Monitor & Controlアプリケーションの画面から
ファイル転送の状態を確認することもできます。

［メモ］
フルメニューのNetworkメニューのFile TransferでAuto 
Upload（111ページ）またはAuto Upload (Proxy)
（111ページ）をOnに設定すると、ネットワーク接続状態
の場合、記録終了時にDefault Upload Server（111ペー
ジ）で設定されたサーバーに対して自動的にオリジナルク
リップやプロキシクリップを送信します。オリジナルクリッ
プとプロキシクリップの両方を自動転送設定している場合
には、プロキシクリップが優先して自動転送されます。

［ご注意］

ˎˎ 転送ジョブは200件まで登録可能です。
ˎˎ ジョブリストは本機の電源を切っても保持されますが、
POWERスイッチをSTANDBYにせずにバッテリーパック
を取り外すなどして電源を切った場合には、最大で10分
間分程度の進捗情報が喪失する可能性があります。
ˎˎ バッテリー電圧低下状態に陥った後に追加されたジョブ
については、ジョブリスト上に保存されません。
ˎˎ ファイル転送中に転送がエラーになると、転送先サー
バーの設定や状態によっては、同じ名前のクリップが転
送できなくなることがあります。その場合は転送先サー
バーの設定や状態を確認してください。

クリップを自動転送する

オリジナルクリップを自動転送する

記録終了時にオリジナルクリップを指定した
サーバーに転送します。この機能を有効にする
には、フルメニューのNetworkメニューのFile 
TransferでAuto Upload（111ページ）をOnに
設定します。

プロキシクリップを自動転送する

記録終了時にプロキシクリップを指定したサー
バーに転送します。この機能を有効にするに
は、フルメニューのNetworkメニューのFile 
TransferでAuto Upload (Proxy) （111ペー
ジ）をOnに設定します。
また、Auto Upload (Proxy)をChunkに設定す
ると、プロキシクリップを分割記録して、記録継
続中でも指定したサーバーに順次転送すること
ができます。分割記録したプロキシクリップの自
動転送は、他のファイル転送ジョブよりも優先さ
れて行われます。
設定方法については、「プロキシクリップを分割
記録し、転送する」（58ページ）をご覧くださ
い。

セキュアなFTP転送を行うに
は

ファイル転送先サーバーとの接続にFTPSの
Explicitモード（FTPES）を使用することで、ファ
イルを暗号化して転送することができます。

セキュアなFTP転送の設定

セキュアなFTP転送を行うには、ファイル転送先
サーバーの設定で、Using Secure Protocolを
ONに設定し、証明書の読み込みを行います。
設定方法については、「クリップの転送先を登録
する」（68ページ）をご覧ください。
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Creators' App for enterpriseを使用する
本機はスマートフォンアプリ「Creators' App for 
enterprise」と連携して、クラウドサービス「C3 
Portal」へのファイル転送を簡単に行うことがで
きます。
あらかじめC3 Portalのアカウントを取得し、ス
マートフォンにCreators' App for enterpriseを
インストールしてください。
クラウドサービス「C3 Portal」のアカウント取得
については、所属組織の管理者にお問い合わせ
ください。

［ご注意］

ˎˎ お住まいの地域によってはサービスを提供していない場
合があります。
ˎˎ Creators' App for enterpriseの操作方法については、
Creators' App for enterpriseのヘルプをご覧くださ
い。

クリップをC3 Portalへ転送
する

1	 NetworkメニューのSetup for Mobile 
Appで、Setup（108ページ）を選択する。
自動変更される項目の確認画面が表示され
ます。
Networkメニューの設定が次のように自動
変更されます。

ˎˎ Wired LAN>Setting：Off

ˎˎ Modem>Setting：On

ˎˎ Modem>Camera Remote Control：
Enable

ˎˎ Access Authentication>Input 
Password：未設定の場合自動生成

2	 設定内容を確認してOKを選択する。

設定が開始されます。設定中は「Now 
changing」のメッセージが表示されます。
設定が正常に終了すると、ビューファイン
ダーに次の画面が表示されます。

アクセス認証の下記の情報を表示します。
ユーザー名、パスワード、フィンガープリント、
カムコーダーのモデル名、シリアル番号

	 ［メモ］
本画面は映像出力へ出力されません。

	 ［ご注意］
パスワードを盗み見られたり、QRコードの画像を流出
させないように注意してください。

3	 スマートフォンでCreators' App for 
enterpriseを実行し、クラウドサービスに
サインインする。

4	 本機のUSB-C端子とスマートフォンを、USB
ケーブルで接続する。

5	 スマートフォンの画面でUSBテザリングを有
効にする。
設定方法については、「USBテザリングを使
用して接続する」（66ページ）をご覧くだ
さい。
お使いのスマートフォンにより、操作が異な
ります。スマートフォンの取扱説明書をご確
認ください。

6	 Creators' App for enterpriseの画面の指
示に従って、ビューファインダーに表示され
たQRコードを撮影する。
スマートフォンから本機へファイル転送の設
定情報が送られ、次のメッセージが表示さ
れます。

7	 OKを選択する。
設定の読み込みが開始されます。
設定の読み込みが正常に終了すると、
「Network File loaded.」のメッセージが表
示されます。

［ご注意］

ˎˎ Creators' App for enterpriseは、本機のNetworkメ
ニューのFile Transfer（111ページ）の設定を書き換え
ます。
ˎˎ Root Certificateは自動では設定できません。手動で
設定してください。

オリジナルクリップを転送する

NetworkメニューのFile TransferのAuto 
Upload（111ページ）をOnにすると、オリジナ
ルクリップをC3 Portalへ転送できます。
記録を終了するたびに、C3 Portalのアカウント
に紐づけされた場所へクリップが転送されます。

プロキシクリップを転送する

NetworkメニューのFile TransferのAuto 
Upload (Proxy)（111ページ）をOnにすると、
プロキシクリップをC3 Portalへ転送できます。
記録を終了するたびに、C3 Portalのアカウント
に紐づけされた場所へクリップが転送されます。

Auto Upload (Proxy)がChunkに設定されてい
る場合は、記録開始後一定時間ごとに分割され
たプロキシクリップが転送されます。設定方法に
ついては、「プロキシクリップを分割記録し、転
送する」（58ページ）をご覧ください。

任意のクリップを転送する

「クリップを選んで転送する」（68ページ）を
ご覧ください。

［メモ］

ˎˎ 本機が送信したファイルは、Creators' App for 
enterpriseでキャッシュされながらC3 Portalへ転送
されます。本機のファイル転送状態表示は、Creators' 
App for enterpriseへの転送状況を示しています。
ˎˎ 本機からスマートフォンのCreators' App for 
enterpriseへファイル転送が終了した後は、本機の電
源を切ることができますが、スマートフォンからのファイ
ル転送は継続している場合があります。スマートフォン
の電池残量にはご注意ください。

C3 Portalを使用したその他
の機能

3D LUTファイルを管理する

C3 Portal側で保存された3D LUTファイルを本
機にインポートできます。「クラウドサービスから
インポートする」（59ページ）をご覧ください。

Allファイルを管理する

本機で作成したAllファイルをC3 Portalに
保存したり、読み出したりして利用できます。
「Allファイルをクラウドサービスに保存する」
（120ページ）、「Allファイルをクラウドサービ
スから読み込む」（121ページ）をご覧ください。
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サムネイル画面
THUMBNAILボタン（5ページ）を押すと、メモリーカードに収録されているクリップが、サムネイル（縮小画）画面に表示されます。
サムネイル画面で選択したクリップから再生を開始することができます。再生画像は、ビューファインダー、外部ビデオモニターに表示できます。
THUMBNAILボタンを押すと、サムネイル画面を終了し、撮影画面に戻ります。

［ご注意］
サムネイル画面には、現在選択している記録フォーマットで収録されたクリップのみが表示されます。収録したはずのクリップが表示されないときは、記録フォーマットをご確認ください。また、メディアのフォーマット（初期化）などを行う際にはご注
意ください。

画面の構成

画面下部には、カーソル位置のクリップの情報が表示されます。

4 5

6

3

1

2

現在選択されているメモリーカードをハイライト表示
（プロテクトされている場合は右にロックマーク表示）

カーソル（黄色）

クリップ番号／クリップ総数

1.	 サムネイル（縮小画）
各クリップの代表画像です。記録時にはクリップの
先頭フレームが自動的に代表画に設定されます。
サムネイルの下にはクリップ/フレーム情報が表示
されます。フルメニューのThumbnailメニュー
>Customize View（104ページ）のThumbnail 
Captionで表示内容を変更できます。

2.	クリップ名
選択されているクリップのクリップ名が表示され
ます。

3.	 記録時のビデオフォーマット
選択したクリップのファイルフォーマットが表示さ
れます。

4.	特殊記録撮影情報
特殊記録モードで記録されたクリップの場合の
み、そのモードが表示されます。
スロー＆クイックモーション記録されたクリップ
の場合は、右側にフレームレートが表示されます。

5.	 クリップの収録時間（Duration）

6.	作成日時
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クリップの再生
記録したクリップを再生する

本機が記録停止中のときは、記録したクリップを
再生することができます。

1	 再生するメモリーカードを入れる。

2	 THUMBNAILボタンを押す。

3	 マルチセレクター（7ページ）またはマル
チファンクションダイヤル（5ページ）を
操作して、再生を開始したいクリップのサム
ネイルにカーソルを合わせる。

4	 マルチセレクターの決定ボタンまたはマルチ
ファンクションダイヤルを押す。
選択したクリップの先頭から再生が始まりま
す。

再生操作は次のボタンで行います。
マルチセレクターの決定ボタンまたはマルチフ
ァンクションダイヤル押し：	
再生を一時停止します。	
もう一度押すと再生に戻ります。

マルチセレクターの左ボタン /右ボタン押し：	
クリップの先頭または前後のクリップに移
動します。

マルチセレクターの左ボタン /右ボタン長押し：	
高速再生します。	
長押しをやめると標準再生に戻ります。

CANCEL/BACKボタン：	
再生を停止し、記録停止状態にします。

［ご注意］

ˎˎ クリップとクリップの境界では、一時的に画像が乱れた
り、静止画になる場合があります。またこの間は操作が
できません。
ˎˎ サムネイル画面でクリップを選択して再生を開始すると、
クリップの先頭部分の再生映像が乱れる場合がありま
す。クリップの先頭から乱れのない映像で再生するには、
一度再生モードにした後で一時停止にし、マルチセレク
ターの左ボタンを押してクリップの先頭に戻して再生を
行ってください。

［メモ］
撮影モードをLog撮影にした状態で収録したクリップを再
生すると、撮影時に使用したEI値およびLUTを適用します。
適用するLUTは、メタデータ保存された3D LUTファイル
の情報から判断されます。
撮影時に、フルメニューのProjectメニュー >Cine EI/
Flex.ISO SetのEmbed LUT File（88ページ）をOnにし
て記録したクリップの場合で、撮影時に使用した3D LUT
ファイルが本機にインストールされていたら、そのLUTを適
用して再生します。
撮影時に、フルメニューのProjectメニュー >Cine EI/
Flex.ISO SetのEmbed LUT File（88ページ）をOffに
して記録したクリップを再生した場合は、フルメニューの
Paint/Lookメニュー >Base LookのSelect（94ページ）
で選択されているLUTを適用します。
撮影時に使用された3D LUTファイルが本機にインストール
されていない場合も同様です。
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サムネイル画面では、フルメニューのThumbnail
メニューを使用してクリップの操作や詳細情報の
確認などが可能です。
MENUボタンを長押ししてThumbnailを選択す
ると、Thumbnailメニュー（104ページ）が表
示されます。

Thumbnailメニューの操作
方法

マルチセレクター（7ページ）またはマルチファ
ンクションダイヤル（5ページ）を操作して機
能を選択し、マルチセレクターの決定ボタンまた
はマルチファンクションダイヤルを押してくださ
い。
CANCEL/BACKボタン（5ページ）を押すと、
操作前の画面に戻ります。

［ご注意］
メニューを表示させたときの状態によって選択できない項
目があります。

クリップ操作メニュー

ˎˎ Display Clip Properties

ˎˎ Set Clip Flag

ˎˎ Lock/Unlock Clip

ˎˎ Delete Clip

ˎˎ Transfer Clip

ˎˎ Transfer Clip (Proxy)

ˎˎ Filter Clips

ˎˎ Customize View

クリップ操作メニューについて詳しくは、
Thumbnailメニュー（104ページ）をご覧くだ
さい。

クリップの詳細情報画面を表示する

ThumbnailメニューのDisplay Clip Properties
（104ページ）を選択すると、クリップの詳細情
報画面を表示されます。
マルチセレクターの左ボタン/右ボタンを押すと、
前後のクリップへ移動することができます。

クリップフラグを付ける

クリップにクリップフラグ（OK、NG、KPマーク）
を付けると、クリップフラグを基準にクリップを
絞り込んで表示することができます。
クリップフラグを付けたいクリップのサムネイル
を選択し、フルメニューのThumbnailメニュー
のSet Clip Flag（104ページ）からクリップフラ
グを選びます。

設定値 付加されるクリップフラグ
Add OK OK
Add NG NG
Add KEEP KP

［メモ］

ˎˎ クリップフラグ機能を割り当てたアサイナブルボタン使
用してクリップフラグを付けることもできます（52ペー
ジ）。
ˎˎ Clip Flagボタン（5ページ）を押すと、選択したク
リップのサムネイルにOKのクリップフラグが付けられま
す（56ページ）。

フィルタードクリップサムネイル画面を
表示する

フルメニューのThumbnailメニューのFilter 
Clips（104ページ）で表示したいフラグを選ぶ
と、指定したフラグの付いているクリップのみを
表示することができます。
すべてのクリップを表示するには、Allを選んでく
ださい。

［メモ］
DISPLAYボタンでフィルターを順に切り替えることもでき
ます。

クリップを削除する

メモリーカードからクリップを削除することがで
きます。
フルメニューのThumbnailメニューのDelete 
ClipからSelect ClipまたはAll Clipsを選びます。
Select Clip：	
任意のクリップを削除します。1度に複数の
クリップを選択することもできます。

All Clips：	
表示されているすべてのクリップを削除し
ます。

サムネイル画面の情報を変更する

サムネイルの下に表示されるクリップ／フレーム
情報を変更します。

フルメニューのThumbnailメニューの
Customize View>Thumbnail Captionから、
表示したい内容を選びます。
Date Time：	
作成日時または最終変更日時

Time Code：	
タイムコード

Duration：	
収録時間

Sequential Number：	
サムネイル番号

クリップ操作
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フルメニューの構成と階層
MENUボタンを長押しすると、撮影や再生に必
要な各種設定を行うフルメニューがビューファイ
ンダー画面に表示されます（外部ビデオモニター
に表示させることもできます）。下記のメニュー
から選択して設定します。

メニュー構成

Userメニュー
任意の設定を集めたメニュー	
Edit User Menuから編集できます。

Edit Userメニュー
Userメニューの編集に関する設定

Shootingメニュー
撮影に関する設定

Projectメニュー
プロジェクトの基本的な設定

Paint/Lookメニュー
画質に関する設定

TC/Mediaメニュー
タイムコードと記録メディアに関する設定

Monitoringメニュー
ビデオ出力やビューファインダー出力に関す
る設定

Audioメニュー
音声に関する設定

Thumbnailメニュー
サムネイル表示に関する設定

Technicalメニュー
技術的な内容の設定

Networkメニュー
ネットワークに関する設定

Maintenanceメニュー
時計や言語設定などの機器設定 フルメニューの階層

User	
（工場出荷時の設
定）

Base Setting
Focus
S&Q Motion
LUT On/Off
Simul Rec
Proxy Rec
Interval Rec
Assignable Button
Assignable Dial
Multi Function Dial
All File
Clip Name Format
Format Media
VF Setting
Zebra
Zoom
Menu Settings

Edit User Menu Add Item
Customize Reset

Shooting ISO/Gain/EI
ND Filter
Shutter
Iris
Auto Exposure
White
White Setting
Offset White
Focus
S&Q Motion
LUT On/Off
Noise Suppression
Flicker Reduce
SteadyShot

Project Base Setting
Rec Format
Cine EI/Flex.ISO Set
HDR Setting
Simul Rec
Proxy Rec
Interval Rec
Picture Cache Rec
SDI/HDMI Rec Control
Assignable Button
Assignable Dial
Multi Function Dial
User File
All File
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Paint/Look Scene File
Base Look
Reset Paint Settings
Black
Knee
Detail
Matrix
Multi Matrix

TC/Media Timecode
TC Display
Users Bit
HDMI TC Out
Clip Name Format
Update Media
Format Media

Monitoring Output On/Off
Output Format
De-Squeeze
Output Display
Display On/Off
Marker
VF Setting
Gamma Display Assist
Peaking
Zebra

Audio Audio Input
Audio Output

Thumbnail Display Clip Properties
Set Clip Flag
Lock/Unlock Clip
Delete Clip
Transfer Clip
Transfer Clip (Proxy)
Filter Clips
Customize View

Technical Color Bars
ND Dial
Tally
HOLD Switch Setting
Touch Operation
Rec Review
Zoom
Handle Zoom
Menu Settings
Menu Page On/Off
Fan Control
Lens
Video Light Set
APR
Camera Battery Alarm
Camera DC IN Alarm

Network Access Authentication
Wireless LAN
AP Mode Settings
ST Mode Settings
Wired LAN
Modem
File Transfer
Network Reset

Maintenance Language
Clock Set
All Reset
Hours Meter
Version
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フルメニューの操作方法
MENUボタンを長押しすると、詳細な設定を行う
フルメニューがビューファインダー画面に表示さ
れます（外部ビデオモニターに表示させることもで
きます）。

メニュー操作部

MENUボタン（5ページ）
長押しするとフルメニューを表示します。フ
ルメニューの表示中に押すと非表示にしま
す。

マルチセレクター（8方向＋決定）（7ページ）
8方向ボタンを押すと、カーソルが上下左右
に移動して、メニュー項目や設定値を選択
できます。
マルチセレクターの決定ボタンを押すと、選
択している項目を決定します。

マルチファンクションダイヤル（5ページ）
マルチファンクションダイヤルを回すとカーソ
ルが上下に移動して、メニュー項目や設定値
を選択できます。
マルチファンクションダイヤルを押すと、選
択している項目を決定します。

CANCEL/BACKボタン（5ページ）
1つ前の階層に戻ります。確定前の変更はキャ
ンセルされます。

［ご注意］

ˎˎ ピント拡大（39ページ）になっていると、フルメニュー
は操作できません。
ˎˎ メニューを表示させたときの状態によって選択できない
項目があります。

メニューを設定する

8方向ボタンを押すか、またはマルチファンクショ
ンダイヤルを回して設定したい項目にカーソルを
合わせ、決定ボタンまたはマルチファンクション
ダイヤルを押して決定します。

ˎˎ 選択項目が表示される選択肢エリアは最大8
行表示です。選択肢が一度に表示できない場
合は、カーソルを上下に移動すると表示がスク
ロールします。

ˎˎ 選択肢の範囲が大きい項目の場合	
（例：－99 ～ +99）は、選択肢エリアは表示
されません。文字がハイライト表示になり設定
変更が可能な状態であることを示します。

ˎˎ 実行項目でExecuteを選択した場合は、対応
する機能が実行されます。

ˎˎ 実行前に確認が必要な項目を選択すると、一
旦メニューが消え、確認メッセージが表示され
ます。メッセージに従って、実行するかキャン
セルするかを選択してください。

文字列を入力する

ファイル名など、文字列を設定する項目を選択し
た場合は、文字列の入力画面が表示されます。

1

2 3

1	 8方向ボタンを押すか、またはマルチファン
クションダイヤルを回して入力したい文字タ
イプを選択し、決定する。
ABC：英大文字
abc：英小文字
123：数字
!#$：特殊文字

2	 選んだ文字タイプから文字を選択し、決定
する。
カーソルが次の欄に移動します。
Space：カーソルの位置にスペースを入力し
ます。

/：カーソル位置を移動します。
BS：カーソルの左の文字を削除します。

3	 入力が終わったら、Doneを選択し、決定す
る。
文字列を確定して、入力画面が消えます。

メニューのロックと解除

フルメニューの表示をロックして、Userメニュー
だけを表示させることができます。
ステータス画面では設定変更できなくなります。

メニューをロックする

1	 マルチファンクションダイヤルを押しながら
MENUボタンを長押しする。

2	 TechnicalメニューのMenu Settingsの
User Menu with Lockを選択する。

	 ［ご注意］
MENUボタンのみを長押しして通常のフルメニューを
表示した場合、TechnicalメニューのMenu Settings
にはUser Menu Onlyが表示されますが、マルチファ
ンクションダイヤルを押しながらMENUボタンを長押
しすると、User Menu with Lockが表示されます。

3	 Onを選択して決定ボタンまたはマルチファ
ンクションダイヤルを押す。
ビューファインダー画面の表示が、暗証番号
入力画面に切り替わります。

4	 任意の番号を入力する。
0000 ～ 9999の4桁の数値が入力できま
す。初期値は0000となっています。
数値を入力し、決定ボタンまたはマルチファ
ンクションダイヤルを押すと、カーソルが次
の桁に移動します。
すべての桁を入力したら、カーソルがSETに
移動します。
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5	 決定ボタンまたはマルチファンクションダイ
ヤルを押す。
入力が確定します。
設定が完了したメッセージが表示され、
Userメニュー表示に切り替わります。

メニューのロックを解除する

1	 マルチファンクションダイヤルを押しながら
MENUボタンを長押しする。

2	 UserメニューのMenu SettingsのUser 
Menu with Lockを選択する。

	 ［ご注意］
MENUボタンのみを長押しして通常のフルメニューを
表示した場合、TechnicalメニューのMenu Settings
にはUser Menu Onlyが表示されますが、マルチファ
ンクションダイヤルを押しながらMENUボタンを長押
しすると、User Menu with Lockが表示されます。

3	 Offを選択して決定ボタンまたはマルチファ
ンクションダイヤルを押す。
ビューファインダー画面の表示が、暗証番号
入力画面に切り替わります。

4	 メニューをロックしたときの番号を入力す
る。
数値を入力し、決定ボタンまたはマルチファ
ンクションダイヤルを押すと、カーソルが次
の桁に移動します。
すべての桁を入力したら、カーソルがSetに
移動します。

5	 決定ボタンまたはマルチファンクションダイ
ヤルを押す。
入力が確定します。
メニューをロックしたときの暗証番号と入力
した番号が一致した場合、ロックが解除で
きたことのメニュー表示に切り替わります。

［ご注意］

ˎˎ メニューをロックしたときの暗証番号と入力した番号が
不一致の場合は、ロックを解除できません。
ˎˎ 暗証番号は、忘れたときのため、手元に記録を残すこと
をお勧めします。忘れたときはサービス窓口にお問い合
わせください。
ˎˎ 下表のフルメニューのメニュー項目をUserメニューに登
録せずにメニューをロックした場合、同機能をアサイナ
ブルボタンに設定することはできません。
ˎˎ 下表の機能をアサイナブルボタンにアサインしていた場
合は、メニューをロックした時点でアサイナブルの設定
が強制的にOffになります。

フルメニューのメニュー
項目

アサイナブルボタン
の選択肢

Shooting>ISO/Gain/
EI>Base Sensitivity、
Shooting>ISO/Gain/
EI>Base ISO

Base ISO/
Sensitivity

Shooting>Auto 
Exposure>AGC

AGC

― Auto ND Filter
Shooting>Iris>Bokeh 
Control

Bokeh Control

Shooting>Auto 
Exposure>Auto 
Shutter

Auto Shutter

Shooting>Auto 
Exposure>Level

Auto Exposure 
Level

Shooting>Auto 
Exposure>Mode

Backlight

Shooting>Auto 
Exposure>Mode

Spotlight

フルメニューのメニュー
項目

アサイナブルボタン
の選択肢

Shooting>White>	
Preset White

Preset White 
Select

Shooting>Focus>	
AF Transition Speed、
Shooting>Focus>	
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting>Focus>	
Focus Area

Focus Area

Shooting>Focus>	
Focus Area(AF-S)

Focus Area(AF-S)

Shooting>Focus>	
Face/Eye Detection 
AF

Face/Eye 
Detection AF

Shooting>Focus>	
Push AF Mode

Push AF Mode

Shooting>S&Q 
Motion>Setting

S&Q Motion

Shooting>	
SteadyShot>Setting

SteadyShot

Project>Picture 
Cache Rec>Setting

Picture Cache Rec

Technical>Rec 
Review>Setting

Rec Review

Thumbnail>Set Clip 
Flag>Add OK

Clip Flag OK

Thumbnail>Set Clip 
Flag>Add NG

Clip Flag NG

Thumbnail>Set Clip 
Flag>Add KEEP

Clip Flag Keep

Technical>Color 
Bars>Setting

Color Bars

Monitoring>Display 
On/Off>Lens Info

Lens Info

Monitoring>Display 
On/Off>Video Signal 
Monitor

Video Signal 
Monitor

Monitoring>	
Marker>Setting

Marker

フルメニューのメニュー
項目

アサイナブルボタン
の選択肢

Monitoring>VF 
Setting>Color Mode

VF Mode

Monitoring>Gamma 
Display 
Assist>Setting

Gamma Display 
Assist

Monitoring>	
Peaking>Setting

Peaking

Monitoring>	
Zebra>Setting

Zebra

Audio>Audio 
Output>Volume

Volume

Technical>Touch 
Operation>Setting

Touch Operation

Technical>Handle 
Zoom>Setting

Handle Zoom

Network>Wireless 
LAN>NFC

NFC

Network>File 
Transfer>Auto 
Upload (Proxy)

Auto Upload 
(Proxy)

User User Menu
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Userメニュー
各メニュー項目および対応する機能は以下のとおりです。

User
メニュー項目 内容
Base Setting Project > Base Settingの内容。
Focus Shooting > Focusの内容。
S&Q Motion Shooting > S&Q Motionの内容。
LUT On/Off Shooting > LUT On/Offの内容。
Simul Rec Project > Simul Recの内容。
Proxy Rec Project > Proxy Recの内容。
Interval Rec Project > Interval Recの内容。
Assignable Button Project > Assignable Buttonの内容。
Assignable Dial Project > Assignable Dialの内容。
Multi Function Dial Project > Multi Function Dialの内容。
All File Project > All Fileの内容。
Clip Name Format TC/Media > Clip Name Formatの内容。
Format Media TC/Media > Format Mediaの内容。
VF Setting Monitoring > VF Settingの内容。
Zebra Monitoring > Zebraの内容。
Zoom Technical > Zoomの内容。
Menu Settings Technical > Menu Settingsの内容。
Edit User Menu Edit Userメニューを表示する。

［ご注意］

UserメニューはEdit Userメニューによってメニュー項目の追加や削除ができます。設定できる項目数は20が上限です。
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Edit Userメニュー
UserメニューでEdit User Menuを選択すると、Edit Userメニューが第1階層に表示されます。

Edit User
メニュー項目 細目と設定値 内容
Add Item
Userメニュー項目の追加

Userメニューに第2階層の項目を追加
する。

Customize Reset
Userメニュー項目のリ
セット

Userメニューの登録項目を工場出荷
時の状態に戻す。

編集中に選択した第2階
層の項目

Delete Userメニューに登録した第2階層の項
目を削除する。

Move Userメニューに登録した項目を並べ替
える。

Edit Sub Item Userメニューに登録した第3階層の項
目に属する細目を編集（登録・削除）す
る。
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Shootingメニュー
各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Shooting>ISO/Gain/EI
ゲインに関する設定を行います。

メニュー項目 細目と設定値 内容
Mode ISO/dB ゲイン設定モードを選択する。

［ご注意］
Log撮影のときは、本設定はISOに固定されます。

ISO/
Gain<H>

設定項目について詳しくは、「ISO/Gainメ
ニューの設定値と初期値」（113ページ）を
ご覧ください。

ゲインのプリセット値<H>を設定する。

［ご注意］
Cine EI/Cine EI Quickのときは、本機能を設定
できません。

ISO/
Gain<M>

設定項目について詳しくは、「ISO/Gainメ
ニューの設定値と初期値」（113ページ）を
ご覧ください。

ゲインのプリセット値<M>を設定する。

［ご注意］
Cine EI/Cine EI Quickのときは、本機能を設定
できません。

ISO/Gain<L> 設定項目について詳しくは、「ISO/Gainメ
ニューの設定値と初期値」（113ページ）を
ご覧ください。

ゲインのプリセット値<L>を設定する。

［ご注意］
Cine EI/Cine EI Quickのときは、本機能を設定
できません。

Shooting>ISO/Gain/EI
ゲインに関する設定を行います。

メニュー項目 細目と設定値 内容
Exposure 
Index<H>

Cine EI時
Base ISOがISO 800のとき
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E

Base ISOがISO 12800のとき
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Exposure Index<H>を設定する。
Cine EI/Cine EI Quick時のみ有効です。
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Shooting>ISO/Gain/EI
ゲインに関する設定を行います。

メニュー項目 細目と設定値 内容
Exposure 
Index<H>

Cine EI Quick時
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Exposure 
Index<M>

設定値はExposure Index<H>と同じです。
Cine EI時
Base ISOがISO 800のとき
1000EI / 6.3E

Base ISOがISO 12800のとき
16000EI / 6.3E

Cine EI Quick時
800EI / 6.0E

Exposure Index<M>を設定する。

Shooting>ISO/Gain/EI
ゲインに関する設定を行います。

メニュー項目 細目と設定値 内容
Exposure 
Index<L>

設定値はExposure Index<H>と同じです。
Cine EI時
Base ISOがISO 800のとき
800EI / 6.0E

Base ISOがISO 12800のとき
12800EI / 6.0E

Cine EI Quick時
800EI / 6.0E

Exposure Index<L>を設定する。

Shockless 
Gain

On / Off ショックレスゲイン機能をOn/Offする。

Base 
Sensitivity

High / Low Custom用の基準感度を設定する。

Base ISO ISO 12800 / ISO 800 Flexible ISO/Cine EI用の基準ISO感度を
設定する。

［ご注意］
Cine EI Quickのときは、本機能を設定できませ
ん。Exposure Indexに連動してBase ISO感度
が自動で設定されます。

Shooting>ND Filter
NDフィルターのプリセット値を設定します。

メニュー項目 細目と設定値 内容
Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 NDフィルターのプリセット1の値を設定す

る。
Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 NDフィルターのプリセット2の値を設定す

る。
Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 NDフィルターのプリセット3の値を設定す

る。

Shooting>Shutter
電子シャッターの動作を設定します。

メニュー項目 細目と設定値 内容
Mode Speed / Angle 電子シャッターのモードを選択する。

動きの速い被写体を鮮明に撮影したい場合
などに使用する。秒数でシャッター速度を
設定するSpeed（スピード）モードと開角度
でシャッター速度を設定するAngle（角度）
モードを選択する。
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Shooting>Shutter
電子シャッターの動作を設定します。

メニュー項目 細目と設定値 内容
Shutter 
Speed 	
On/Off

On / Off Speedモード選択時の露光時間を、
Shutter Speedの設定値に従うかフル露光
にするかを設定する。

Shutter 
Speed

64F ～ 1/8000
設定値は、選択されている記録フォーマット
のシステム周波数によって異なります。
59.94P：	
64F / 32F / 16F / 8F / 7F / 6F / 5F / 	
4F / 3F / 2F / 1/50 / 1/60 / 1/100 / 	
1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

50P：	
64F / 32F / 16F / 8F / 7F / 6F / 5F / 	
4F / 3F / 2F / 1/50 / 1/60 / 1/100 / 	
1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

29.97P：	
64F / 32F / 16F / 8F / 7F / 6F / 5F / 
4F / 3F / 2F / 1/30 / 1/40 / 1/50 / 
1/60 / 1/100 / 1/120 / 1/125 / 	
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

25P：	
64F / 32F / 16F / 8F / 7F / 6F / 5F / 
4F / 3F / 2F / 1/25 / 1/33 / 1/50 / 
1/60 / 1/100 / 1/120 / 1/125 / 	
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

24P/23.98P：	
64F / 32F / 16F / 8F / 7F / 6F / 5F / 
4F / 3F / 2F / 1/24 / 1/32 / 1/48 / 
1/50 / 1/60 / 1/96 / 1/100 / 1/120 / 	
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

Speedモード選択時、シャッタースピード
を設定する。

Shutter 
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 	
3F / 2F / 360.0° / 300.0° / 270.0° / 	
240.0° / 216.0° / 210.0° / 180.0° / 	
172.8° / 150.0° / 144.0° / 120.0° / 	
90.0° / 86.4° / 72.0° / 45.0° / 30.0° / 
22.5° / 11.25° / 5.6°

Angleモード 選択時、開角度を設定する。

Shooting>Shutter
電子シャッターの動作を設定します。

メニュー項目 細目と設定値 内容
ECS On/Off On / Off Extended Clear Scanの設定をOn/Offす

る。
ECS 
Frequency

23.99 ～ 8000
設定値は、選択されている記録フォーマット
のシステム周波数によって異なります。
初期値は以下のとおりです。
59.94P：60.00
50P：50.00
29.97P：30.00
23.98P：23.99
25P：25.02
24P：24.02

ECSモード 選択時、ECS周波数を設定する。

Shooting>Iris
ボケ調節機能の設定を行います。

メニュー項目 細目と設定値 内容
Bokeh 
Control

On / Off ボケ調節機能をOn/Offする。

Shooting>Auto Exposure
自動露出調整の設定を行います。

メニュー項目 細目と設定値 内容
Level +3.0 / +2.75 / +2.5 / +2.25 / +2.0 / 	

+1.75 / +1.5 / +1.25 / +1.0 / +0.75 / 	
+0.5 / +0.25 / ±0 / –0.25 / –0.5 / 	
–0.75 / –1.0 / –1.25 / –1.5 / –1.75 / 	
–2.0 / –2.25 / –2.5 / –2.75 / –3.0

自動検出した露出に対する明暗レベルを設
定する。

Mode Backlight / Standard / Spotlight 自動露出調整の動作モードを設定する。
Backlight:	
バックライトモード（中心となる被写体
が逆光のとき、黒沈みを軽減するモー
ド）

Standard:	
標準モード

Spotlight:	
スポットライトモード（中心となる被写
体にスポットライトが当たっていると
き、白潰れを軽減するモード）

Speed －99 ～ +99（±0） 自動露出調整の調整スピードを設定する。
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Shooting>Auto Exposure
自動露出調整の設定を行います。

メニュー項目 細目と設定値 内容
AGC On / Off AGC（オートゲインコントロール）機能を

On/Offする。

［ご注意］
Cine EI/Cine EI Quickのときは、本設定はOff
に固定されます。

AGC Limit 設定項目について詳しくは、「AGC Limitメ
ニューの設定値と初期値」（116ページ）を
ご覧ください。

AGC機能の最大ゲインを設定する。

［ご注意］
Cine EI/Cine EI Quickのときは、本機能を設定
できません。

AGC Point F2.8 / F4 / F5.6 AGC機能がOnのとき、AGCを動作させ始
めるアイリスのF値を設定する。

［ご注意］
Cine EI/Cine EI Quickのときは、本機能を設定
できません。

Auto 
Shutter

On / Off オートシャッターコントロール機能をOn/
Offする。

［ご注意］
Cine EI/Cine EI Quickのときは、本設定はOff
に固定されます。

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 オートシャッター機能の最速シャッタース
ピードを設定する。

［ご注意］
Cine EI/Cine EI Quickのときは、本機能を設定
できません。

A.SHT Point F5.6 / F8 / F11 / F16 オートシャッターを動作させ始めるアイリス
のF値を設定する。

［ご注意］
Cine EI/Cine EI Quickのときは、本機能を設定
できません。

Clip High 
light

On / Off 高輝度部の検出を無視して、高輝度に対す
る反応を鈍くさせる機能をOn/Offする。

Detect 
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 被写体の明るさに追従して露出を自動調整
する測光範囲を選択する。（露出を手動調
整しているときは無効）

Shooting>Auto Exposure
自動露出調整の設定を行います。

メニュー項目 細目と設定値 内容
Detect 
Window 
Indication

On / Off 測光範囲の表示をOn/Offする。

Custom 
Width

40 ～ 999（500） 測光範囲の幅を設定する。

Custom 
Height

70 ～ 999（500） 測光範囲の高さを設定する。

Custom H 
Position

－479 ～ +479（±0） 測光範囲の水平位置を設定する。

Custom V 
Position

－464 ～ +464（±0） 測光範囲の垂直位置を設定する。

Shooting>White
ホワイトバランスの設定を行います。

メニュー項目 細目と設定値 内容

Preset 
White

2000K ～ 15000K（3200K） ホワイトバランスのプリセット値を設定す
る。

Color Temp 
<A>

2000K ～ 15000K（3200K） メモリーAに保存されたホワイトバランスの
色温度を設定する。

［ご注意］
Color Tempは、R/B Gain操作時に2000Kや
15000Kでクリップされるため、R/B Gain値の
正確なColor Temp値を表示できない場合があり
ます。

Tint<A> －99 ～ +99（±0） ホワイトメモリーAに保存されたホワイトバ
ランスのTint値を設定する。

［ご注意］
Tintは、R/B Gain操作時に±99でクリップされ
るため、R/B Gain値の正確なTint値を表示でき
ない場合があります。

R Gain <A> －99.0 ～ +99.0（±0.0） メモリーAに保存されたホワイトバランスの
Rゲイン値を設定する。

B Gain <A> －99.0 ～ +99.0（±0.0） メモリーAに保存されたホワイトバランスの
Bゲイン値を設定する。
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Shooting>White
ホワイトバランスの設定を行います。

メニュー項目 細目と設定値 内容

Color Temp 
<B>

2000K ～ 15000K（3200K） メモリー Bに保存されたホワイトバランスの
色温度を設定する。

［ご注意］
Color Tempは、R/B Gain操作時に2000Kや
15000Kでクリップされるため、R/B Gain値の
正確なColor Temp値を表示できない場合があり
ます。

Tint<B> －99 ～ +99（±0） ホワイトメモリー Bに保存されたホワイトバ
ランスのTint値を設定する。

［ご注意］
Tintは、R/B Gain操作時に±99でクリップされ
るため、R/B Gain値の正確なTint値を表示でき
ない場合があります。

R Gain <B> －99.0 ～ +99.0（±0.0） メモリー Bに保存されたホワイトバランスの
Rゲイン値を設定する。

B Gain <B> －99.0 ～ +99.0（±0.0） メモリー Bに保存されたホワイトバランスの
Bゲイン値を設定する。

Shooting>White Setting
ホワイトバランスの調整を行います。

メニュー項目 細目と設定値 内容

Shockless 
White

Off / 1 / 2 / 3 ホワイトバランスモード切り替え時のホワイ
トバランス変化速度を設定する。
Off：瞬時に切り替わる。
1～ 3：数字が大きいほどゆっくり切り替わ
る。

ATW Speed 1 / 2 / 3 / 4 / 5 ATWモード時の反応速度を設定する。
1：最も反応速度が速い。

White 
Switch<B>

Memory / ATW WHT BALスイッチをBに設定したときに選
択されるホワイトバランス調整モードを選
択する。

［ご注意］
Cine EI/Cine EI Quickのときは、本設定は
Memoryに固定されます。

Shooting>White Setting
ホワイトバランスの調整を行います。

メニュー項目 細目と設定値 内容

Filter White 
Memory

On / Off NDフィルターごとにホワイトバランスメモ
リー領域を設定する機能をOn/Offする。
On：NDフィルターごとにホワイトバランス
メモリーを設定する。

	 [メモ]
プリセットモードのときはCLEAR/1/2/3の4
組、バリアブルモードのときはCLEARとOn
の2組となります。

Off：各NDフィルターでホワイトバランスメ
モリーは共通。

Shooting>Offset White
ホワイトバランスのオフセットの設定を行います。

メニュー項目 細目と設定値 内容
Offset White 
<A>

On / Off メモリーAのホワイトバランスにオフセット
値を付加する（On）か付加しないか（Off）を
選択する。

［ご注意］
撮影モードがLog撮影のときは、本設定はOffに
固定されます。

Offset Color 
Temp<A>

－99 ～＋99（±0） Offset White <A>がOnの場合に、メモ
リーAのホワイトバランスに付加する色温
度方向のオフセットを設定する。

Offset 
Tint<A>

－99 ～＋99（±0） Offset White <A>がOnの場合に、メモ
リーAのホワイトバランスに付加するTint方
向のオフセットを設定する。

Offset White 
<B>

On / Off メモリー Bのホワイトバランスにオフセット
値を付加する（On）か付加しないか（Off）を
選択する。

［ご注意］
撮影モードがLog撮影のときは、本設定はOffに
固定されます。

Offset Color 
Temp<B>

－99 ～＋99（±0） Offset White <B>がOnの場合に、メモ
リー Bのホワイトバランスに付加する色温
度方向のオフセットを設定する。

Offset 
Tint<B>

－99 ～＋99（±0） Offset White <B>がOnの場合に、メモ
リー Bのホワイトバランスに付加するTint方
向のオフセットを設定する。
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Shooting>Offset White
ホワイトバランスのオフセットの設定を行います。

メニュー項目 細目と設定値 内容
Offset White 
<ATW>

On / Off ATWのホワイトバランスにオフセット値を
付加する（On）か付加しないか（Off）を選択
する。

Offset Color 
Temp	
<ATW>

－99 ～＋99（±0） Offset White <ATW>がOnの場合に、
ATWのホワイトバランスに付加する色温度
方向のオフセットを設定する。

Offset 
Tint<ATW>

－99 ～＋99（±0） Offset White <ATW>がOnの場合に、
ATWのホワイトバランスに付加するTint方
向のオフセットを設定する。

Shooting>Focus
フォーカスの設定を行います。

メニュー項目 細目と設定値 内容
AF 
Transition 
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6 / 7(Fast) オートフォーカス中の被写体が移り変わる
際のフォーカス駆動の速さを設定する。

AF Subj. 
Shift Sens.

1(Locked On) / 2 / 3 / 4 / 5(Responsive) オートフォーカス中の被写体の乗り移り感
度を設定する。

Focus Area Wide / Zone / Flexible Spot オートフォーカス、プッシュオートフォーカ
ス（AF）の対象とする領域を設定する（40
ページ）。
Wide：	
映像全域からフォーカスを合わせる位
置を探す。

Zone：	
指定したゾーン内から自動でフォーカス
を合わせる点を探す。

Flexible Spot：	
映像の指定した位置にフォーカスを合
わせる。

Focus Area 
(AF-S)

Flexible Spot プッシュオートフォーカス（AF-S）の対象と
する領域を設定する。

Face/Eye 
Detection 
AF

Face/Eye Only AF / 	
Face/Eye Priority AF / Off

顔検出AFの有効/無効を設定する。

Push AF 
Mode

AF / Single-shot AF(AF-S) マニュアルフォーカス中のプッシュオート
フォーカスのモードを設定する。

Shooting>Focus
フォーカスの設定を行います。

メニュー項目 細目と設定値 内容
Touch 
Function in 
MF

Tracking AF / Spot Focus マニュアルフォーカス時にタッチパネルを
タップしたときの動作を設定する。

Multi 
Selector 
Function

Face/Eye Sel. Cursor / Pointer マルチセレクター操作によるリアルタイムト
ラッキングAFの追尾対象の指定方法を設
定する。

Pointer 
Color

Orange / White / Yellow / Cyan / 
Green / Magenta / Red / Blue

リアルタイムトラッキングAFの追尾対象の
指定に使用するポインターの色を設定する。

Pointer 
Border

On / Off リアルタイムトラッキングAFの追尾対象の
指定に使用するポインターの縁取りをOn/
Offする。

AF Assist On / Off Onに設定すると、オートフォーカス時、一
時的に手動でフォーカスを合わせることが
できる。

Shooting>S&Q Motion
スロー＆クイックモーションモードの設定を行います（53ページ）。

メニュー項目 細目と設定値 内容

Setting On / Off スロー＆クイックモーションモードをOn/
Offする。
Onのとき、以下の機能が無効になります。
ˎˎ オートアイリス
ˎˎ オートフォーカス

Frame Rate 1fps ～ 60fps / 100fps / 120fps / 	
150fps / 180fps / 200fps / 240fps

スロー＆クイックモーション撮影時のフレー
ムレートを設定する。

［ご注意］
設定値の範囲は、選択されているシステム周波数
やコーデック、ビデオフォーマットによって異なり
ます。
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Shooting>LUT On/Off
LUTの設定を行います。

メニュー項目 細目と設定値 内容

SDI/HDMI MLUT On / MLUT Off SDIおよびHDMI出力映像にMonitor LUT
を適用するか選択する。

VF/Proxy/
Stream

MLUT On / MLUT Off VF、ProxyおよびStreamの出力映像に
Monitor LUTを適用するか選択する。

Internal Rec MLUT On / MLUT Off 内蔵記録映像にMonitor LUTを適用する
か選択する。

Shooting>Noise Suppression
ノイズサプレスの設定を行います。

［メモ］
Setting(Custom)とLevel(Custom)の設定値はそれぞれTarget Displayの設定に反映されます（119ページ）。

メニュー項目 細目と設定値 内容
Setting	
(Custom)

On / Off Custom時のノイズサプレス機能をOn/
Offする。

［ご注意］
Log撮影のときは、本機能を設定できません。

Level	
(Custom)

Low / Mid / High Custom時のノイズサプレスのレベルを設
定する。

［ご注意］
Log撮影のときは、本機能を設定できません。

Setting 	
(Cine EI/
Flex. ISO)

On / Off Log撮影時のノイズサプレス機能をOn/
Offする。

［ご注意］
Customのときは、本機能を設定できません。

Level 	
(Cine EI/
Flex. ISO)

Low / Mid / High Log撮影時のノイズサプレスのレベルを設
定する。

［ご注意］
Customのときは、本機能を設定できません。

Shooting>Flicker Reduce
フリッカー補正の設定を行います。

メニュー項目 細目と設定値 内容
Mode Auto / On / Off フリッカー補正モードを設定する。
Frequency 50Hz / 60Hz フリッカーの原因となる照明の電源周波数

を設定する。

Shooting>SteadyShot
手ブレ補正の設定を行います。

メニュー項目 細目と設定値 内容
Setting Active / Standard / Off 手ブレ補正機能を設定する。

［ご注意］
対応レンズ装着時のみ設定できます。
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各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Project>Base Setting
基本設定を行います。

メニュー項目 細目と設定値 内容
Shooting 
Mode

Custom / Flexible ISO / Cine EI Quick / 
Cine EI

撮影モードを設定する。（25ページ）

Target 
Display

SDR(BT.709) / HDR(HLG) Custom時の記録/出力の映像規格を設定
する。

Project>Rec Format
記録フォーマットの設定を行います。

メニュー項目 細目と設定値 内容
Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 システム周波数を選択する。
Imager Scan 
Mode

FF / S35 イメージャーサイズを選択する。

Codec RAW / RAW & XAVC-I / RAW(HDMI) / 	
RAW(HDMI) & XAVC-I / XAVC-I / 
XAVC-L

クリップの記録・再生コーデックを設定す
る。

RAW Output 
Format

FrequencyとCodecの設定に応じて変わる。 RAW出力する画像サイズを設定する。

［ご注意］
CodecがRAW & XAVC-Iのときは、Video 
FormatがRAW Output Formatに連動して切り
替わります。

Frequency Codec 選択肢
59.94/
50/
29.97/
25/
23.98

RAW 4096×2160
3840×2160

RAW & 
XAVC-I

4096×2160
3840×2160

RAW(HDMI) 4240×2392
RAW(HDMI) 
& XAVC-I

4240×2392

24 RAW 4096×2160
RAW & 
XAVC-I

4096×2160

Project>Rec Format
記録フォーマットの設定を行います。

メニュー項目 細目と設定値 内容
Video 
Format

FrequencyとCodecの設定に応じて変わる。 画像サイズ・ビットレートを設定する。
Frequency Codec 選択肢
59.94 RAW/

RAW(HDMI)
―

RAW & 
XAVC-I

4096×2160P
3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P
3840×2160P
1920×1080P

XAVC-L 3840×2160P
1920×1080P 
50
1920×1080P 
35

50 RAW/
RAW(HDMI)

―

RAW & 
XAVC-I

4096×2160P
3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P
3840×2160P
1920×1080P

XAVC-L 3840×2160P
1920×1080P 
50
1920×1080P 
35

Projectメニュー



6章　メニュー表示と詳細設定：Projectメニュー88

Project>Rec Format
記録フォーマットの設定を行います。

メニュー項目 細目と設定値 内容
Video 
Format

29.97 RAW/
RAW(HDMI)

―

RAW & 
XAVC-I

4096×2160P
3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P
3840×2160P
1920×1080P

XAVC-L 3840×2160P
1920×1080P 
50
1920×1080P 
35

25 RAW/
RAW(HDMI)

―

RAW & 
XAVC-I

4096×2160P
3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P
3840×2160P
1920×1080P

XAVC-L 3840×2160P
1920×1080P 
50
1920×1080P 
35

Project>Rec Format
記録フォーマットの設定を行います。

メニュー項目 細目と設定値 内容
Video 
Format

23.98 RAW/
RAW(HDMI)

―

RAW & 
XAVC-I

4096×2160P
3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P
3840×2160P
1920×1080P

XAVC-L 3840×2160P
1920×1080P 
50
1920×1080P 
35

24 RAW/
RAW(HDMI)

―

RAW & 
XAVC-I

4096×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

Project>Cine EI/Flex.ISO Set
Log撮影（Cine EI、Cine EI Quick、Flexible ISO）の設定を行います。

メニュー項目 細目と設定値 内容
Color Gamut S-Gamut3/SLog3 / 	

S-Gamut3.Cine/SLog3
Log撮影時の色域を設定する。

Embed LUT 
File

On / Off 3D LUTファイル（CUBEファイル）のメタデー
タ記録をOn/Offする。
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Project>HDR Setting
HDRモードの設定を行います。

メニュー項目 細目と設定値 内容
VF SDR 
Preview

On / Off HDRモード時でガンマ表示アシストが有効
なときビューファインダー映像を簡易的に
HDRからSDRに変換した映像で表示する
機能をOn/Offする。

［メモ］
Onのときはビューファインダー映像にSDR Gain
が適用されます。

SDR Gain 0dB ～ －15dB（－6dB） HDRモード時でVF SDR PreviewがOnの
とき、ビューファインダーに適用されるSDR 
Gainの値を設定する。

Project>Simul Rec
同時記録の設定を行います（55ページ）。

メニュー項目 細目と設定値 内容
Setting On / Off 本線同時記録機能のOn/Offと記録先メ

ディアを一括設定する。
Rec Button 
Set

Rec Button:[SlotA SlotB] Handle 
Rec Button:[SlotA SlotB] / Rec 
Button:[SlotA] Handle Rec Button: 
[SlotB] / Rec Button:[SlotB] Handle Rec 
Button:[SlotA]

記録メディアごとに録画ボタンの割り当て
を行う。

Project>Proxy Rec
プロキシ記録モードの設定を行います。

メニュー項目 細目と設定値 内容
Setting On / Off プロキシ記録モードをOn/Offする。
Audio 
Channel

CH1/CH2 / CH3/CH4 プロキシデータに記録するオーディオチャ
ンネルを選択する。

Chunk 30s / 1min / 2min プロキシファイルの分割記録時間を選択す
る。

Project>Interval Rec
インターバルレックの設定を行います（54ページ）。

メニュー項目 細目と設定値 内容
Setting On / Off インターバルレックモードをOn/Offする。

（この設定をOnにすると、他の特殊記録
モードの設定がOffになる。）

Interval 
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 	
20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 	
20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

Interval Recの設定がOnの場合に、イン
ターバル撮影時の録画間隔（インターバル）
を設定する。

Number of 
Frames

1frame / 2frames / 3frames / 	
6frames / 9frames / 12frames
選択されているビデオフォーマットのフレー
ム周波数によって設定値が異なります。
59.94P/50P：	
2frames / 6frames / 12frames

29.97P/25P/24P/23.98P：	
1frame / 3frames / 6frames / 
9frames

Interval Recの設定がOnの場合に、イン
ターバル撮影時の1回の記録フレーム数を
設定する。

Pre-Lighting Off / 2 s / 5 s / 10 s インターバルレック撮影開始時にビデオラ
イトを点灯させる場合は何秒前に点灯させ
るかを選択する。

［メモ］
HVL-LBPC（別売）使用時のみ有効な設定です。

Project>Picture Cache Rec
ピクチャーキャッシュレックモードの設定を行います（54ページ）。

メニュー項目 細目と設定値 内容
Setting On / Off ピクチャーキャッシュレックモードをOn/

Offする。
Cache Size Short / Medium / Long / Max ピクチャーキャッシュメモリーに画像を蓄

積する時間（キャッシュレック開始時にさか
のぼる時間）を設定する。

Cache Rec 
Time

ピクチャーキャッシュメモリーに画像を蓄
積する時間（キャッシュレック開始時にさか
のぼる時間）を表示する。
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Project>SDI/HDMI Rec Control
SDI/HDMI記録制御の設定を行います。

メニュー項目 細目と設定値 内容
Setting Off / SDI/HDMI Remote I/F / Parallel 

Rec
SDI/HDMI出力信号による外部接続機器の
記録/停止制御を設定する。
Off：	
リモート制御しない。

SDI/HDMI Remote I/F：	
本機にメディアを挿入していない状態
で、外部接続機器の記録/停止制御が
可能。本機のメディアとフレーム精度で
同期しない。

Parallel Rec：	
本機にメディアを挿入している状態で、
外部接続機器の記録/停止制御が可
能。本機のメディアとフレーム精度で同
期する。

［ご注意］
HDMI出力信号による制御を行う場合は、フルメ
ニューのTC/Mediaメニュー >HDMI TC Outの
Setting（97ページ）をOnに設定してください。

Project>Assignable Button
アサイナブルボタンへの機能割り当て設定を行います。

メニュー項目 細目と設定値 内容
<1> ～ <9>、
Focus Hold 
Button

Off / Base ISO/Sensitivity / AGC / 
Push AGC / ND Filter Position / Auto 
ND Filter / Push Auto ND / Auto Iris / 
Push Auto Iris / Bokeh Control / 
Auto Shutter / Auto Exposure Level / 
Backlight / Spotlight / Preset White 
Select / ATW / ATW Hold / AF 
Speed/Sens. / Focus Setting / Focus 
Area / Focus Area(AF-S) / Face/Eye 
Detection AF / Push AF Mode / Push 
AF/Push MF / Focus Hold / Focus 
Magnifier x3/x6 / Focus Magnifier x3 / 
Focus Magnifier x6 / S&Q Motion / 
SteadyShot / Rec / Picture Cache 
Rec / Rec Review / Clip Flag OK / 
Clip Flag NG / Clip Flag Keep / Color 
Bars / Tally [Front] / DURATION/
TC/U-BIT / Display / Lens Info / 
Video Signal Monitor / Marker / VF 
Adjust / VF Mode / Gamma Display 
Assist / Peaking / Zebra / Volume / 
Thumbnail / Touch Operation / Handle 
Zoom / NFC / Auto Upload (Proxy) / 
Direct Menu / User Menu / Menu

アサイナブルボタンに機能を割り当てる。
Base ISO/Sensitivity：	
イメージセンサーの基準感度の切り替え

AGC：	
AGC機能のOn/Off切り替え

Push AGC：	
ボタンを押している間、AGC機能を有
効にする

ND Filter Position：	
NDフィルターの切り替え

Auto ND Filter：	
オートNDフィルターのOn/Off即時切
り替え

Push Auto ND：	
ボタンを押している間、オートNDフィ
ルター機能を有効にする

Auto Iris：	
アイリス機能のOn/Off切り替え

Push Auto Iris：	
ボタンを押している間、オートアイリス
機能を有効にする

Bokeh Control：	
ボケ調節モードのOn/Off切り替え

Auto Shutter：	
オートシャッター機能のOn/Off切り替え

Auto Exposure Level：	
Auto Exposure Levelのダイレクトメ
ニューを開始/終了する

Backlight：	
Backlight/Standard切り替え

Spotlight：	
Spotlight/Standard切り替え

Preset White Select：	
ホワイトバランス プリセットモード値の
切り替え

ATW：	
ATW機能のOn/Off切り替え

ATW Hold：	
ATW機能の動作を一時ホールド
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Project>Assignable Button
アサイナブルボタンへの機能割り当て設定を行います。

メニュー項目 細目と設定値 内容
<1> ～ <9>、
Focus Hold 
Button

AF Speed/Sens.:	
AFトランジション速度の設定とAF乗り
移り感度の設定の切り替え

Focus Setting：	
フォーカスエリアの設定を行う

Focus Area：	
AF、プッシュ AF用のフォーカスエリア
の設定を行う

Focus Area(AF-S) ：	
プッシュ AF(AF-S)用のフォーカスエリ
アの設定を行う

Face/Eye Detection AF：	
顔/瞳検出AFの設定を切り替える

Push AF Mode：	
Push AFのモード設定を切り替える

Push AF/Push MF：	
フォーカスモードがMF時、ボタンを押
している間はAFになる	
フォーカスモードがAF時、ボタンを押
している間はMFになる

Focus Hold：	
フォーカスモードがAF時、ボタンを押
している間フォーカスを固定する

Focus Magnifier x3/x6：
Focus Magnifier x3：
Focus Magnifier x6：	
ピント拡大機能のOn/Off切り替え

S&Q Motion：	
スロー＆クイックモーション機能のOn/
Off切り替え	
長押しで撮影時のフレームレートの設
定

SteadyShot：	
Active / Standard / Off切り替え

Rec：	
記録の開始または停止

Picture Cache Rec：	
ピクチャーキャッシュレックモードの
On/Off切り替え

Rec Review：	
レックレビューのOn/Off切り替え

Project>Assignable Button
アサイナブルボタンへの機能割り当て設定を行います。

メニュー項目 細目と設定値 内容
<1> ～ <9>、
Focus Hold 
Button

Clip Flag OK：	
Add OKを実行する	
2回続けて押すとDelete Clip Flagを実
行する

Clip Flag NG：	
Add NGを実行する	
2回続けて押すとDelete Clip Flagを実
行する

Clip Flag Keep：	
Add Keepを実行する	
2回続けて押すとDelete Clip Flagを実
行する

Color Bars：	
カラーバーのOn/Off切り替え

Tally [Front]：	
記録/タリーランプ（Front）の点灯、点
滅機能のOn/Off切り替え

DURATION/TC/U-BIT：	
Time Code/Users Bit/Duration切り
替え

Display：	
画面表示のOn/Off切り替え

Lens Info：	
被写界深度表示の切り替え

Video Signal Monitor：	
映像信号モニター（波形モニターなど）
の表示切り替え

Marker：	
マーカー機能のOn/Off切り替え

VF Adjust：	
ビューファインダー画面の明るさ調節用
レベルバーの表示

VF Mode：	
ビューファインダー画面のカラー/モノ
クロ切り替え

Gamma Display Assist：	
ガンマ表示アシスト機能の切り替え

Peaking：	
ピーキング機能のOn/Off切り替え

Zebra：	
ゼブラ機能のOn/Off切り替え
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Project>Assignable Button
アサイナブルボタンへの機能割り当て設定を行います。

メニュー項目 細目と設定値 内容
<1> ～ <9>、
Focus Hold 
Button

Volume：	
ヘッドホン端子および本体内蔵スピー
カーのモニター音声レベルを調整する

Thumbnail：	
サムネイル画面の開始/終了

Touch Operation:	
タッチ操作のOn/Off切り替え

Handle Zoom：	
ハンドルズーム動作の切り替え

NFC：	
NFC機能の実行

Auto Upload (Proxy)：	
プロキシファイルの自動転送のOn/
Off/Chunk切り替え

Direct Menu：	
ダイレクトメニューの開始/終了

User Menu：	
Userメニューの開始/終了

Menu：	
フルメニューの開始/終了

Project>Assignable Dial
アサイナブルダイヤルへの機能割り当て、回転方向の設定を行います。

メニュー項目 細目と設定値 内容
Grip/
Remote Dial

Off / ISO/Gain/EI / ND Filter / IRIS / 
Auto Exposure Level / Audio Input 
Level / Multi Function Dial

グリップアサイナブルダイヤルに機能を割り
当てる。
ISO/Gain/EI：	
ゲインまたはEIを調節する

ND Filter：	
NDフィルターを調節する

IRIS：	
アイリスを調節する

Auto Exposure Level：	
自動露出レベルを調節する

Audio Input Level：	
録音レベルを調節する

Multi Function Dial：	
マルチファンクションダイヤルとして動
作する

Project>Assignable Dial
アサイナブルダイヤルへの機能割り当て、回転方向の設定を行います。

メニュー項目 細目と設定値 内容
Grip Dial 
Direction

Normal / Opposite グリップアサイナブルダイヤルの回転方向
を設定する。
Normal：順方向に回転する
Opposite：逆方向に回転する

Handle Dial Off / ISO/Gain/EI / ND Filter / IRIS / 
Auto Exposure Level / Audio Input 
Level / Multi Function Dial

ハンドルアサイナブルダイヤルに機能を割り
当てる。
ISO/Gain/EI：	
ゲインまたはEIを調節する

ND Filter：	
NDフィルターを調節する

IRIS：	
アイリスを調節する

Auto Exposure Level：	
自動露出レベルを調節する

Audio Input Level：	
録音レベルを調節する

Multi Function Dial：	
マルチファンクションダイヤルとして動
作する

Handle Dial 
Direction

Normal / Opposite ハンドルアサイナブルダイヤルの回転方向
を設定する。
Normal：順方向に回転する
Opposite：逆方向に回転する

Project>Multi Function Dial
マルチファンクションダイヤルへの機能割り当て設定を行います。

メニュー項目 細目と設定値 内容
Default 
Function

Off / IRIS / ISO/Gain/EI / Auto 
Exposure Level / Audio Input Level

マルチファンクションダイヤルのデフォルト
機能を割り当てる。
IRIS：	
アイリスを調節する

ISO/Gain/EI：	
ゲインまたはEIを調節する

Auto Exposure Level：	
自動露出レベルを調節する

Audio Input Level：	
録音レベルを調節する
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Project>User File
ユーザーファイルの操作に関する設定を行います。

メニュー項目 細目と設定値 内容
Load from 
Media(B)

Execute / Cancel ユーザーファイルの設定をCFexpress 
Type A/SDカードスロット（B）に挿入した
メモリーカードから読み込む。
Execute：実行

Save to 
Media(B)

Execute / Cancel ユーザーファイルの設定をCFexpress 
Type A/SDカードスロット（B）に挿入した
メモリーカードに保存する。
Execute：実行

File ID ユーザーファイルのFile ID表示と編集を行
う画面を表示する。

Load 
Customize 
Data

On / Off Load from Media(B)の実行時にUserメ
ニューの構成カスタマイズ情報を読み込む
かどうかを設定する。

Load White 
Data

On / Off Load from Media(B)の実行時にホワイト
バランス情報を読み込むかどうかを設定す
る。

Project>All File
Allファイルに関する設定を行います。

メニュー項目 細目と設定値 内容
Load from 
Media(B)

Execute / Cancel Allファイルの設定をCFexpress Type A/
SDカードスロット（B）に挿入したメモリー
カードから読み込む。
Execute：実行

Load from 
Cloud(Private)

Execute / Cancel クラウドサービス「C3 Portal」（個人）にアッ
プロードしたAllファイルを読み込む。
Execute：実行

Load from 
Cloud(Share)

Execute / Cancel クラウドサービス「C3 Portal」（共通）にアッ
プロードしたAllファイルを読み込む。
Execute：実行

Save to 
Media(B)

Execute / Cancel Allファイルの設定をCFexpress Type A/
SDカードスロット（B）に挿入したメモリー
カードに保存する。
Execute：実行

Save to 
Cloud(Private)

Execute / Cancel Allファイルの設定をクラウドサービス「C3 
Portal」（個人）に保存する。
Execute：実行

Project>All File
Allファイルに関する設定を行います。

メニュー項目 細目と設定値 内容
Save to 
Cloud(Share)

Execute / Cancel Allファイルの設定をクラウドサービス「C3 
Portal」（共通）に保存する。
Execute：実行

File ID ファイルに名前を付ける。
Load 
Network 
Data

On / Off Load from Media(B)、Load from 
Cloud(Private)およびLoad from 
Cloud(Share)の実行時に、Networkメ
ニューの設定情報を読み込むかどうかを設
定する。
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Paint/Lookメニュー
各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Paint/Look>Scene File
Sceneファイルに関する設定を行います。

	 ［ご注意］
撮影モードがCustomのときのみ有効です。

メニュー項目 細目と設定値 内容
Recall 内蔵メモリーに保存されているSceneファイ

ルを読み込み、現在の画質設定に適用する。
Store 現在の画質設定状態をSceneファイルとし

て内蔵メモリーに保存する。
Delete 内蔵メモリーに保存されているSceneファイ

ルを削除する。
Preset Recall Shooting ModeがCustomで、Target 

DisplayがSDR(BT.709)のとき
S-Cinetone / Standard / Still / 
ITU709 / 709tone / Cancel

Shooting ModeがCustomで、Target 
DisplayがHDR(HLG)のとき
HLG Live / HLG Natural / Cancel

プリセット画質（書き換え不可）を現在の画
質設定に適用する。

Paint/Look>Base Look
基本ルックに関する設定を行います。

メニュー項目 細目と設定値 内容
Select Shooting ModeがCustomで、Target 

DisplayがSDR(BT.709)のとき
S-Cinetone / Standard / Still / 
ITU709 / 709tone / User1 ～ User16

Shooting ModeがCustomで、Target 
DisplayがHDR(HLG)のとき
HLG Live / HLG Natural / 	
User1 ～ User16

Log撮影のとき
s709 / 709(800) / S-Log3 / 	
User1 ～ User16

基本ルックを選択する。

Delete 選択した基本ルックを削除する。
Delete All すべての基本ルックを削除する。
Import from 
Media(B)

Execute / Cancel CFexpress Type A/SDカードスロット（B）
に挿入したメモリーカードから基本ルック
ファイルを読み込む。
Execute：実行

Paint/Look>Base Look
基本ルックに関する設定を行います。

メニュー項目 細目と設定値 内容
Import from 
Cloud(Private)

Execute / Cancel クラウドサービス「C3 Portal」（個人）にアッ
プロードした基本ルックファイルを読み込
む。
Execute：実行

Import from 
Cloud(Share)

Execute / Cancel クラウドサービス「C3 Portal」（共通）にアッ
プロードした基本ルックファイルを読み込
む。
Execute：実行

Input S-Gamut3/SLog3 / 	
S-Gamut3.Cine/SLog3

Selectで選択している基本ルックの入力
Gamutを設定する。

Output BT.709 / HLG Selectで選択している基本ルックの出力色
域を設定する。

AE Level 
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV / 
5/3EV / 2EV

Selectで選択している基本ルックの露出基
準値を設定する。

Paint/Look>Reset Paint Settings
基本ルック以外のPaint/Lookメニューの設定値をリセットします。

	 ［ご注意］
撮影モードがCustomのときのみ有効です。

メニュー項目 細目と設定値 内容
Reset 
without Base 
Look

Execute / Cancel 基本ルック以外のPaint/Lookメニューの設
定値のリセットを実行する。
Execute：実行

Paint/Look>Black
ブラックの設定を行います。

	 ［ご注意］
撮影モードがCustomのときのみ有効です。

メニュー項目 細目と設定値 内容
Master 
Black

－99.0 ～ +99.0（±0.0） マスターブラックレベルを設定する。

R Black －99.0 ～ +99.0（±0.0） Rブラックレベルを設定する。
B Black －99.0 ～ +99.0（±0.0） Bブラックレベルを設定する。
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Paint/Look>Knee
ニー補正の設定を行います。

	 ［ご注意］
撮影モードがCustomのときのみ有効です。

メニュー項目 細目と設定値 内容

Setting Target DisplayがSDR(BT.709)のとき
On / Off / ---

Target DisplayがHDR(HLG)のとき
On / Off / ---

ニー補正機能をOn/Offする。

［メモ］
Base Look設定のSelectがStandard、
ITU709、709tone、HLG LiveまたはHLG 
Naturalのときのみ有効です。

Auto Knee Target DisplayがSDR(BT.709)のとき
On / Off / ---

Target DisplayがHDR(HLG)のとき
On / Off / ---

オートニー機能をOn/Offする。

［メモ］
ニー補正のSettingがOnで、Base Look設定の
SelectがStandard、ITU709または709toneの
ときのみ有効です。 

Point 75%～ 109%（90%） ニーポイントを設定する。
Slope －99 ～＋99（±0） ニースロープを設定する。

Paint/Look>Detail
ディテール調整の設定を行います。

	 ［ご注意］
撮影モードがCustomのときのみ有効です。

メニュー項目 細目と設定値 内容

Setting On / Off ディテール機能をOn/Offする。
Level －7～＋7（±0） ディテールレベルを設定する。
Manual 
Setting

On / Off / --- ディテール手動調整機能をOn/Offする。

V/H Balance －2～＋2（±0） ディテール手動調整時に垂直（V）/水平（H）
ディテールのバランスを設定する。

B/W 
Balance

Type1 / Type2 / Type3 / Type4 / Type5 ディテール手動調整時に下側（B）/上側（W）
ディテールのバランスを設定する。

Limit 0 ～ 7 ディテール手動調整時にディテールのリミッ
トレベルを設定する。

Crispening 0～7 ディテール手動調整時にクリスプニングレ
ベルを設定する。

High Light 
Detail

0～ 4 ディテール手動調整時に高輝度部分のディ
テールレベルを設定する。

Paint/Look>Matrix
マトリクス補正の設定を行います。

	 ［ご注意］
撮影モードがCustomのときのみ有効です。

メニュー項目 細目と設定値 内容
User Matrix On / Off ユーザーマトリクス補正機能をOn/Offす

る。
User Matrix 
Level

－99 ～＋99（±0） 映像全域の色の濃さ（サチュレーション）を
調整する。

User Matrix 
Phase

－99 ～＋99（±0） 映像全域の色合い（フェーズ）を調整する。

User Matrix 
R-G

－99 ～＋99（±0） R-Gのユーザーマトリクスを任意に設定す
る。

User Matrix 
R-B

－99 ～＋99（±0） R-Bのユーザーマトリクスを任意に設定す
る。

User Matrix 
G-R

－99 ～＋99（±0） G-Rのユーザーマトリクスを任意に設定す
る。

User Matrix 
G-B

－99 ～＋99（±0） G-Bのユーザーマトリクスを任意に設定す
る。

User Matrix 
B-R

－99 ～＋99（±0） B-Rのユーザーマトリクスを任意に設定す
る。

User Matrix 
B-G

－99 ～＋99（±0） B-Gのユーザーマトリクスを任意に設定す
る。
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Paint/Look>Multi Matrix
マルチマトリクス補正の設定を行います。

	 ［ご注意］
撮影モードがCustomのときのみ有効です。

メニュー項目 細目と設定値 内容

Setting On / Off Multi Matrix補正機能をOn/Offする。
Area 
Indication

On / Off Multi Matrixを設定中に補正対象となって
いる色軸が分かるように、対象領域を見分
ける表示機能をOn/Offする。
On：	
Axisで指定されている色の領域以外を
白黒で表示する

Off：	
通常表示

［メモ］

ˎˎ マルチマトリクス補正の各設定画面を表示して
いるときにDISPLAYボタン（6ページ）を押
すと、On/Offを切り替えることができます。
ˎˎ 記録動作中、および、ピクチャーキャッシュレッ
ク機能がOnのときは、本設定はOff固定とな
ります。
ˎˎ Multi Matrixの設定メニューから他の画面に
移動すると、本設定は自動的にOffになります。

［ご注意］

ˎˎ 対象領域を見分ける表示機能をOnにしている
ときは、表示されている映像が記録映像や出
力映像にも出力されます。
ˎˎ ピクチャーキャッシュレック機能がOnのとき
は、Area Indicationの設定を変更できませ
ん。

Reset Execute / Cancel 各色軸の色相（ヒュー）と飽和度（サチュレー
ション）の設定値をすべて初期値にする。

Axis B / B+ / MG－ / MG / MG+ / R / R+ / 	
YL－ / YL / YL+ / G－ / G / G+ / CY / 	
CY+ / B－

調整対象の色軸を選択する。

Hue －99 ～＋99（±0） Axisで選択した調整対象の色軸の色相
（ヒュー）を設定する。

Saturation －99 ～＋99（±0） Axisで選択した調整対象の色軸の飽和度
（サチュレーション）を設定する。
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TC/Mediaメニュー
各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

TC/Media>Timecode
タイムコードの設定を行います。

メニュー項目 細目と設定値 内容

Mode Preset / Regen / Clock タイムコードの歩進モードを設定する。
Preset（プリセット）：	
設定された値から歩進する。

Regen（リジェネ）：	
前のクリップのタイムコードに続けて歩
進する。

Clock（クロック）：	
内蔵時計をタイムコードとして使用す
る。

Run Rec Run / Free Run Rec Run：記録時のみ歩進する。
Free Run：記録に関係なく常に歩進する。

Setting タイムコードを任意の値に設定する。
SET：決定

Reset Execute / Cancel タイムコードを00:00:00:00にリセットす
る。
Execute：実行

TC Format DF / NDF タイムコードのフォーマットを設定する。
DF：ドロップフレーム
NDF：ノンドロップフレーム

TC/Media>TC Display
タイムデータ表示の設定を行います。

メニュー項目 細目と設定値 内容

Display 
Select

Timecode / Users Bit / Duration タイムデータの表示を切り替える。

TC/Media>Users Bit
ユーザービットに関する設定を行います。

メニュー項目 細目と設定値 内容

Mode Fix / Time ユーザービットのモードを設定する。
Fix：ユーザービットに任意の固定値を使用
する。

Time：ユーザービットに現在の時分秒を使
用する。

Setting ユーザービットを任意の値に設定する。

TC/Media>HDMI TC Out
HDMI利用時のタイムコード出力に関する設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off HDMIを利用して、他の業務用機器にタイ
ムコードを出力するかどうかを設定する。

TC/Media>Clip Name Format
クリップの名称や削除に関する設定を行います。

メニュー項目 細目と設定値 内容

Auto 
Naming

Cam ID + Reel# / Title クリップ名の設定方法を選択する。
Cam ID + Reel#:	
Camera ID + Reel Number + Shot 
Number + 年月日 + ランダム文字列

Title:	
Title Prefixで設定した任意文字列 + 
クリップ番号

Camera ID A ～ Z クリップ名の生成時のカメラIDを設定する。

［ご注意］
Auto NamingがCam ID + Reel#に設定されて
いる場合のみ設定できます。

Reel 
Number

001 ～ 999 クリップ名の生成時のReel Numberの数
字部分を設定する。

［ご注意］
Auto NamingがCam ID + Reel#に設定されて
いる場合のみ設定できます。

Camera 
Position

C / L / R クリップ名の生成時のShot Numberの先
頭文字部分を選択する。

［ご注意］
Auto NamingがCam ID + Reel#に設定されて
いる場合のみ設定できます。
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TC/Media>Clip Name Format
クリップの名称や削除に関する設定を行います。

メニュー項目 細目と設定値 内容

Title Prefix nnn_（nnnはシリアル番号の下3桁） クリップ名のタイトル部分（4～ 46文字）を
設定する。
文字列の入力画面を呼び出す。

文字列の入力画面の構成
文字選択エリア（3行）:	
Title Prefixエリアのカーソル位置に挿
入する文字を選択する。	
!#$%()+.-.;=@[ ]^_~0123456789	
abcdefghijklmnopqrstuvwxyz	
ABCDEFGHIJKLMNOPQRSTUVW	
XYZ

カーソル操作エリア（1行）：	
Space: カーソル位置にスペースを挿入
する。	
: カーソルを左に移動する。	
: カーソルを右に移動する。	
BS: カーソル位置の左の文字を削除す
る。

Title Prefixエリア（1行）：	
タイトルを入力するエリア。

タイトルを設定するには
1.	 マルチセレクター（7ページ）を使っ
て、文字選択エリアからTitle Prefixエ
リアのカーソル位置に入れる文字を選択
（ハイライト表示）し、マルチセレクター
の決定ボタンを押す。（選択した文字が
入り、カーソルが右に移動する。）

2.	 手順1を繰り返し、タイトルを設定する。
（必要に応じて、BSを使用する。）

3.	 タイトル名の設定が終わったら、Done
を選択して文字列の入力画面を閉じる。

Number Set 0001 ～ 9999 クリップ名の最後の番号部分（4桁）を設定
する。

TC/Media>Update Media
メモリーカード内の管理ファイルを更新します。

メニュー項目 細目と設定値 内容

Media(A) Execute / Cancel スロットAのメモリーカード内の管理ファイ
ルを更新する。
Execute：実行

Media(B) Execute / Cancel スロットBのメモリーカード内の管理ファイ
ルを更新する。
Execute：実行

TC/Media>Format Media
メモリーカードを初期化します。

メニュー項目 細目と設定値 内容

Media(A) Full Format / Quick Format / Cancel スロットAのメモリーカードを初期化する。
Media(B) Full Format / Quick Format / Cancel スロットBのメモリーカードを初期化する。
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各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Monitoring>Output On/Off
映像出力の設定を行います。

メニュー項目 細目と設定値 内容

SDI On / Off SDI出力をOn/Offする。
HDMI On / Off HDMI出力をOn/Offする。

Monitoring>Output Format
出力フォーマットの設定を行います。

メニュー項目 細目と設定値 内容

SDI 設定項目について詳しくは、「出力のフォー
マットと制限」（126ページ）をご覧くださ
い。

SDIとHDMI出力の解像度設定をする。
HDMI

Monitoring>De-Squeeze
デスクイーズの設定を行います。

メニュー項目 細目と設定値 内容

Ratio 
(HDMI/VF)

Off(1.0x) / 1.3x / 1.5x / 2.0x アナモフィックレンズでの撮影時に、HDMI
出力映像およびビューファインダーに表示
する映像のデスクイーズ倍率を選択する。

Monitoring>Output Display
画面表示の出力設定を行います。

メニュー項目 細目と設定値 内容

SDI On / Off SDI出力信号へのメニューやステータスな
ど、画面表示の重畳を設定する。

HDMI On / Off HDMI出力信号へのメニューやステータス
など、画面表示の重畳を設定する。

Monitoring>Display On/Off
画面表示項目の設定を行います。

メニュー項目 細目と設定値 内容

Network 
Status

On / Off ビューファインダー画面に表示する項目を
選択する。

File Transfer 
Status

On / Off

Rec/Play 
Status

On / Off

RAW Output 
Control 
Status

On / Off

Tally On / Off
Battery 
Remain

On / Off

Focus Mode On / Off
Focus 
Position

On / Off

Focus Area 
Indicator

On / Off

Focus Area 
Ind.(AF-S)

On / Off

Face/Eye 
Detection 
Frame

On / Off

Tracking AF 
Pointer

On / Off

Lens Info On / Off
Imager Scan 
Mode

On / Off

Rec Format On / Off
Frame Rate On / Off
Zoom 
Position

On / Off

UWP RF 
Level

On / Off

SteadyShot On / Off
Base Look/
Rec Look

On / Off

Monitoringメニュー
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Monitoring>Display On/Off
画面表示項目の設定を行います。

メニュー項目 細目と設定値 内容

SDI/HDMI 
Rec Control

On / Off

Monitoring 
Look

On / Off

Proxy Status On / Off
Base ISO/
Sensitivity

On / Off

Media 
Status

On / Off

Video Signal 
Monitor

Off / Waveform / Vector / Histogram

Clip Name On / Off
White 
Balance

On / Off

Scene File On / Off
Focus 
Indicator

On / Off

Auto 
Exposure 
Mode

On / Off

Auto 
Exposure 
Level

On / Off

Timecode On / Off
ND Filter On / Off
Iris On / Off
ISO/Gain/EI On / Off
Shutter On / Off
Level Gauge On / Off
Audio Level 
Meter

On / Off

Video Level 
Warning

On / Off

Clip Number On / Off
Notice 
Message

On / Off

Monitoring>Marker
マーカー表示の設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off すべてのマーカー表示をまとめてOn/Offす
る。

Color White / Yellow / Cyan / Green / 
Magenta / Red / Blue

マーカーの信号色を選択する。

Center 
Marker

1 / 2 / 3 / 4 / Off センターマーカーを選択する。

Safety Zone On / Off セーフティーゾーンマーカーをOn/Offする。
Safety Area 80% / 90% / 92.5% / 95% セーフティーゾーンマーカーの大きさ（画面

全体に対する比率）を選択する。
Aspect 
Marker

Line / Mask / Off アスペクトマーカーの比を選択する。

Aspect 
Mask

0 ～ 15（12） マーカー外側のビデオ信号のレベルを設定
する。

Aspect 
Safety Zone

On / Off アスペクトセーフティーゾーンマーカーを
On/Offする。

Aspect 
Safety Area

80% / 90% / 92.5% / 95% アスペクトセーフティーゾーンマーカーの大
きさ（画面全体に対する比率）を選択する。

Aspect 
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 
17:9 / 1.66:1 / 1.85:1 / 2.35:1 / 2.39:1 / 
Custom

アスペクトマーカーを表示するときのモード
を設定する。

Custom 
Aspect 
Ratio

任意の値を入力する（01.00:01.00） アスペクト比を任意の値に設定する。

［ご注意］
Aspect SelectでCustomを選択した場合に、こ
の設定が有効になります。

Guide 
Frame

On / Off ガイドフレーム表示をOn/Offする。

100% 
Marker

On / Off 100%マーカーをOn/Offする。

User Box On / Off ユーザーボックスマーカーの表示をOn/Off
する。

User Box 
Width

3 ～ 479（240） ユーザーボックスマーカーの幅（中心から左
右端までの距離）を設定する。

User Box 
Height

3 ～269（135） ユーザーボックスマーカーの高さ（中心から
上下端までの距離）を設定する。

User Box H 
Position

－476 ～ +476（0） ユーザーボックスマーカーの中心の水平位
置を設定する。
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Monitoring>Marker
マーカー表示の設定を行います。

メニュー項目 細目と設定値 内容

User Box V 
Position

－266 ～ +266（0） ユーザーボックスマーカーの中心の垂直位
置を設定する。

Monitoring>VF Setting
ビューファインダーの設定を行います。

メニュー項目 細目と設定値 内容

Brightness 1 ～ 15（8） ビューファインダー映像の明るさを調整す
る。

Color Mode Color / B&W E-E表示/記録時のビューファインダーの表
示モードを選択する。

Monitoring>Gamma Display Assist
ガンマ表示アシストの設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off CustomでTarget DisplayがHDR(HLG)時
のガンマ表示アシスト機能をOn/Offする。

［ご注意］
Log撮影のときは、本設定はOffに固定されます。

Monitoring>Peaking
ピーキングの設定を行います

メニュー項目 細目と設定値 内容

Setting On / Off ピーキング機能をOn/Offする。
Peaking 
Level

High / Mid / Low カラーピーキングの信号レベルを設定する。

Color B&W / Red / Yellow / Blue カラーピーキングの信号色を選択する。

Monitoring>Zebra
ゼブラパターンの設定を行います。

メニュー項目 細目と設定値 内容

Setting Off / Zebra1 / Zebra2 ゼブラ表示の種類（Off、ゼブラ1、ゼブラ2）
を選択する。

Zebra1 Level 0%～ 109%（70%） ゼブラ1を表示するレベルを設定する。
Zebra1 
Aperture 
Level

2%～20%（10%） ゼブラ1のアパーチャーレベルを設定する。

Zebra2 
Level

0%～ 109%（100%） ゼブラ2を表示するレベルを設定する。
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Audioメニュー
各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。
「ブロックダイヤグラム」（142ページ）を併せてご覧ください。

Audio>Audio Input
音声入力の設定を行います。

メニュー項目 細目と設定値 内容

CH1 Input 
Select

INPUT1 / Internal MIC / Shoe CH1 記録CH1に対する入力元を切り替える。

CH2 Input 
Select

INPUT1 / INPUT2 / Internal MIC / Shoe 
CH2

記録CH2に対する入力元を切り替える。

CH3 Input 
Select

Off / INPUT1 / Internal MIC / Shoe CH1 記録CH3に対する入力元を切り替える。

CH4 Input 
Select

Off / INPUT1 / INPUT2 / Internal MIC / 
Shoe CH2

記録CH4に対する入力元を切り替える。

INPUT1 MIC 
Reference

－80dB / －70dB / －60dB / －50dB / 	
－40dB / －30dB

INPUT1からのXLRマイク入力に対するリ
ファレンスレベルを設定する。

INPUT2 MIC 
Reference

－80dB / －70dB / －60dB / －50dB / 	
－40dB / －30dB

INPUT2からのXLRマイク入力に対するリ
ファレンスレベルを設定する。

Line Input 
Reference

+4dB / 0dB / －3dB / EBUL INPUT1/INPUT2スイッチの設定がLINEの
場合の基準入力レベルを選択する。

Reference 
Level

－20dB /－18dB / －16dB / －12dB / 
EBUL

基準入力レベルの1 kHz信号の記録レベル
を選択する。

CH1 Wind 
Filter

On / Off 記録CH1に対する風音低減フィルターを設
定する。

CH2 Wind 
Filter

On / Off 記録CH2に対する風音低減フィルターを設
定する。

CH3 Wind 
Filter

On / Off 記録CH3に対する風音低減フィルターを設
定する。

CH4 Wind 
Filter

On / Off 記録CH4に対する風音低減フィルターを設
定する。

CH3 Level 
Control

Auto / Manual 記録CH3の音声入力レベル調整を自動にす
るか、手動にするかを設定する。

［ご注意］
CH3 Input Select、CH4 Input Selectがどちら
もInternal MICに設定されている場合は、本設
定に連動してCH4の自動・手動も切り替わります。

Audio>Audio Input
音声入力の設定を行います。

メニュー項目 細目と設定値 内容

CH4 Level 
Control

Auto / Manual 記録CH4の音声入力レベル調整を自動にす
るか、手動にするかを設定する。

［ご注意］
CH3 Input Select、CH4 Input Selectがどちら
もInternal MICに設定されている場合は、CH3 
Level Controlの設定に連動してCH4の自動・手
動も切り替わります。

CH3 Input 
Level

0 ～ 99（49） 記録CH3の入力レベルを設定する。

CH4 Input 
Level

0 ～ 99（49） 記録CH4の入力レベルを設定する。

Audio Input 
Level

0 ～ 99 音声入力レベルを設定する。
CH1 Level ～ CH4 Levelの設定に従って、
マスターボリュームとして使用できます。

Limiter 
Mode

Off / －6dB / －9dB / －12dB / －15dB / 
－17dB

オーディオ入力レベルの手動調節時の大き
な信号に対するリミッター特性を選択する。

CH1&2 AGC 
Mode

Mono / Stereo 記録CH1と記録CH2の自動レベル調整モー
ドを設定する。Stereoに設定されていると
きは、CH間でAGCが連動する。

CH3&4 AGC 
Mode

Mono / Stereo 記録CH3と記録CH4の自動レベル調整モー
ドを設定する。Stereoに設定されていると
きは、CH間でAGCが連動する。

AGC Spec －6dB / －9dB / －12dB / －15dB / 	
－17dB

AGC特性を選択する。

1kHz Tone 
on Color 
Bars

On / Off カラーバー表示中の1 kHzの基準音声信号
をOn/Offする。

［ご注意］
Onに設定すると、CH3 Input Select、CH4 
Input SelectがOffの場合でも、1 kHzの基準音
声信号を記録CH3、記録CH4に乗せます。
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Audio>Audio Input
音声入力の設定を行います。

メニュー項目 細目と設定値 内容

CH1 Level XLRアダプター入力なし
Audio Input Level / Side / 
Level+Side

XLRアダプター入力あり（51ページ）
Audio Input Level / Through

記録CH1の音声入力レベル調整の組み合わ
せを設定する。

［ご注意］
Sideは本機側面のAUDIO LEVEL（CH1）ダイヤ
ルを指します。Level+Sideを設定したときは
Audio Input Level設定の割合とダイヤル設定の
割合を掛け合わせた割合が録音レベルになります
（142ページ）。

CH2 Level XLRアダプター入力なし
Audio Input Level / Side / 
Level+Side

XLRアダプター入力あり（51ページ）
Audio Input Level / Through

記録CH2の音声入力レベル調整の組み合わ
せを設定する。

［ご注意］
Sideは本機側面のAUDIO LEVEL（CH2）ダイヤ
ルを指します。Level+Sideを設定したときは
Audio Input Level設定の割合とダイヤル設定の
割合を掛け合わせた割合が録音レベルになります
（142ページ）。

CH3 Level XLRアダプター入力なし
Audio Input Level / CH3 Input 
Level / Level+CH3 Input Level

XLRアダプター入力あり（51ページ）
Audio Input Level / Through

記録CH3の音声入力レベル調整の組み合
わせを設定する。

CH4 Level XLRアダプター入力なし
Audio Input Level / CH4 Input 
Level / Level+CH4 Input Level

XLRアダプター入力あり（51ページ）
Audio Input Level / Through

記録CH4の音声入力レベル調整の組み合
わせを設定する。

Audio>Audio Output
音声出力の設定を行います。

メニュー項目 細目と設定値 内容

Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1 / 
CH2 / CH3 / CH4

ヘッドホン端子および内蔵スピーカーに出
力する音声チャンネルを選択する。

［ご注意］
複数チャンネルの音声を同時出力する設定値を
選択した場合は、音割れしないように各チャンネ
ルの出力レベルを下げて音声が出力されます。

Volume 0～ 50 ヘッドホン端子および内蔵スピーカーのモ
ニター音声レベルを調整する。

Headphone 
Out

Mono / Stereo ヘッドホン端子をモノラル（Mono）出力に
するか、ステレオ（Stereo）出力にするかを
選択する。

Alarm Level 0 ～7（4） 警告音の音量を調整する。
HDMI 
Output CH

CH1/CH2 / CH3/CH4 HDMIに出力される音声チャンネルの組み
合わせを設定する。



6章　メニュー表示と詳細設定104

各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Thumbnail
メニュー項目 細目と設定値 内容

Display Clip 
Properties

クリップ詳細情報画面を開く。

Thumbnail>Set Clip Flag
クリップフラグの編集を行います。

メニュー項目 細目と設定値 内容

Add OK OKフラグを付ける。
Add NG NGフラグを付ける。
Add KEEP Keepフラグを付ける。
Delete Clip 
Flag

すべてのフラグを外す。

Thumbnail>Lock/Unlock Clip
クリップの保護設定を行います。

メニュー項目 細目と設定値 内容

Select Clip 保護/保護解除するクリップを選択して実
行する。

Lock All 
Clips

すべてのクリップを保護する。

Unlock All 
Clips

すべてのクリップを保護解除する。

Thumbnail>Delete Clip
クリップを削除します。

メニュー項目 細目と設定値 内容

Select Clip 任意のクリップを削除する。
All Clips クリップを一括削除する。

Thumbnail>Transfer Clip
クリップを転送します。

［ご注意］
NetworkメニューのAccess Authenticationでパスワードを設定していない場合、Transfer Clipは設定できません。

メニュー項目 細目と設定値 内容

Select Clip 任意のクリップを転送する。

Thumbnail>Transfer Clip
クリップを転送します。

［ご注意］
NetworkメニューのAccess Authenticationでパスワードを設定していない場合、Transfer Clipは設定できません。

メニュー項目 細目と設定値 内容

All Clips クリップを一括転送する。

［ご注意］
転送できるクリップの上限は200件です。

Thumbnail>Transfer Clip (Proxy)
プロキシクリップを転送します。

［ご注意］
NetworkメニューのAccess Authenticationでパスワードを設定していない場合、Transfer Clip (Proxy)は設定で
きません。

メニュー項目 細目と設定値 内容

Select Clip 任意のクリップに対応しているプロキシク
リップを転送する。

All Clips クリップに対応するプロキシクリップを一
括転送する。

［ご注意］
転送できるクリップの上限は200件です。

Thumbnail>Filter Clips
表示するクリップの設定を行います。

メニュー項目 細目と設定値 内容

OK OKフラグのついたクリップのみを表示する。
NG NGフラグのついたクリップのみを表示する。
KEEP Keepフラグのついたクリップのみを表示す

る。
None フラグのついていないクリップのみを表示

する。
All フラグのありなしによらず、すべてのクリッ

プを表示する。

Thumbnail>Customize View
サムネイル画面の表示を切り替えます。

メニュー項目 細目と設定値 内容

Thumbnail 
Caption

Date Time / Time Code / Duration / 
Sequential Number

サムネイル画像直下の表示内容を切り替え
る。

Thumbnailメニュー
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Technicalメニュー
各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Technical>Color Bars
カラーバーの設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off カラーバーをOn/Offする。
Type ARIB / 100% / 75% / SMPTE カラーバーの種類を選択する。

Technical>ND Dial
ND VARIABLEダイヤルの操作に関する設定を行います。

メニュー項目 細目と設定値 内容

CLEAR with 
Dial

On / Off ND VARIABLEダイヤルの操作でNDの状
態遷移（CLEAR⇔On）を可能にするかどう
か設定する。

Technical>Tally
記録/タリーランプの設定を行います。

メニュー項目 細目と設定値 内容

Front On / Off 記録/タリーランプ（Front）をOn/Offする。
Rear On / Off 記録/タリーランプ（Rear）をOn/Offする。

Technical>HOLD Switch Setting
ホールドスイッチの設定を行います。

メニュー項目 細目と設定値 内容

with Rec 
Button

On / Off 録画START/STOPボタンをホールドの対象
にするか非対象にするかを設定する。

with Hand 
Grip Remote

On / Off グリップリモコンによる操作をホールドの対
象にするか非対象にするかを設定する。

Handle 
HOLD 
Switch

Normal / Rec Button Only ハンドルHOLDスイッチのホールド対象をハ
ンドル録画START/STOPボタンだけに限定
するかを設定する。
Normal：	
ハンドル部のすべての操作部材をホー
ルド対象にする。	
ただし、ハンドル録画START/STOPボ
タンはwith Rec Buttonの設定に従い
ます。

Rec Button Only：	
ハンドル録画START/STOPボタンだけ
をホールド対象にする。

Technical>Touch Operation
タッチ操作に関する設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off タッチ操作をOn/Offする。

Technical>Rec Review
レックレビューの設定を行います。

メニュー項目 細目と設定値 内容

Setting 3 s / 10 s / Clip レックレビューで直前に記録したクリップを
再生する時間を選択する。

Technical>Zoom
ズームの設定を行います。

メニュー項目 細目と設定値 内容

Zoom Type Optical Zoom Only / On(Clear Image 
Zoom)

ズームの種類を設定する。
Optical Zoom Only：	
レンズを動かすことにより、光学的な
ズームを行う

On(Clear Image Zoom)：	
画質劣化が少ない、電子的なズームを
行う

Technical>Handle Zoom
ハンドルズームの設定を行います。

メニュー項目 細目と設定値 内容

Setting Off / Low / High / Variable ハンドルズームスピードを設定する。
High 1 ～ 8（8） ハンドルズームスピードHigh選択時、ハン

ドルズームレバーを押したときのズームス
ピードを設定する。

Low 1～ 8（3） ハンドルズームスピードLow選択時、ハンド
ルズームレバーを押したときのズームスピー
ドを設定する。

［ご注意］
ズームスピードが低速のときにズーミングにむら
が出ることがあります。

Technical>Menu Settings
メニューに関する設定を行います。

メニュー項目 細目と設定値 内容

User Menu 
Only

On / Off メニューを表示したときに、Userメニュー
だけを表示するか（On）、メニューリストを
表示するか（Off）を設定する。
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Technical>Menu Settings
メニューに関する設定を行います。

メニュー項目 細目と設定値 内容

User Menu 
with Lock

On / Off メニュー表示にロックをかけて、Userメ
ニューだけの表示にするかどうかを設定す
る。

［ご注意］
通常のメニュー表示操作では表示されません。メ
ニュー表示の操作方法は、76ページをご覧く
ださい。

Technical>Menu Page On/Off
ステータス画面の表示に関する設定を行います。

メニュー項目 細目と設定値 内容

Main On / Off メインステータス画面の表示をOn/Offす
る。

Camera On / Off カメラステータス画面の表示をOn/Offす
る。

Audio On / Off オーディオステータス画面の表示をOn/
Offする。

Project On / Off プロジェクトステータス画面の表示をOn/
Offする。

Monitoring On / Off モニタリングステータス画面の表示をOn/
Offする。

Assignable 
Button

On / Off アサイナブルボタンステータス画面の表示
をOn/Offする。

Battery On / Off バッテリーステータス画面の表示をOn/
Offする。

Media On / Off メディアステータス画面の表示をOn/Off
する。

Network On / Off ネットワークステータス画面の表示をOn/
Offする。

File Transfer On / Off ファイル転送ステータス画面の表示をOn/
Offする。

Technical>Fan Control
ファン制御モードの設定を行います。

メニュー項目 細目と設定値 内容

Setting Auto / Minimum / Off in Rec 本機のファン制御モードを設定する。

［ご注意］
Off in Recを選択していても、本機の内部温度
が一定温度を超えるとファンが回転します。

Technical>Lens
レンズに関する設定を行います。

メニュー項目 細目と設定値 内容

Zoom Ring 
Direction

Left(W)/Right(T) / Right(W)/Left(T) ズームリングの操作方向を設定する。

［ご注意］
ズームリングの操作方向切り替えに対応したEマ
ウントレンズ使用時のみ設定できます。

Shading 
Compensation

Auto / Off 自動周辺光量補正を設定する。

Chroma 
Aberration 
Comp.

Auto / Off 自動倍率色収差補正を設定する。

Distortion 
Comp.

Auto / Off 自動歪曲収差補正を設定する。

Breathing 
Compensation

Auto / Off レンズのブリージング補正を設定する。

Distance 
Display

Meter / Feet レンズ情報とフォーカスポジションの表示
単位を設定する。

Zoom 
Position 
Display

Focal Length / Number / Bar ズーム位置の表示形式を設定する。
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Technical>Video Light Set
ビデオライトの点灯方式を設定します。HVL-LBPC（別売）使用時のみ有効な設定です。

メニュー項目 細目と設定値 内容

Video Light 
Set

Power Link / Rec Link / Rec Link + Stby マルチインターフェースシューに取り付ける
ビデオライトの点灯方式を設定する。
Power Link： 

本機の電源の入/切に連動してビデオラ
イトが点灯/消灯する。

Rec Link： 
本機の録画開始/終了に連動してビデ
オライトが点灯/消灯する。

Rec Link + Stby： 
本機の録画開始/終了に連動してビデ
オライトが点灯/スタンバイ点灯する。

Technical>APR
APRを実行します。

メニュー項目 細目と設定値 内容

APR Execute / Cancel APR（Auto Pixel Restoration：イメージ
センサーの自動調整）を実行する。
Execute：実行

［ご注意］
実行前に必ずレンズキャップを装着してください。

Technical>Camera Battery Alarm
バッテリーの電圧低下警告の設定を行います。

メニュー項目 細目と設定値 内容

Low Battery 5% / 10% / 15% / ... / 45% / 50% バッテリー電圧低下警告を表示する残量を
設定する（5%刻み）。

Battery 
Empty

3% ～ 7% バッテリー切れ警告を表示する残量を設定
する。

Technical>Camera DC IN Alarm
入力電圧警告の設定を行います。

メニュー項目 細目と設定値 内容

DC Low 
Voltage1

16.0V ～ 19.0V（16.5V） DC INへの入力電圧の低下警告を表示する
電圧を設定する。

DC Low 
Voltage2

15.5V ～ 18.5V DC INへの入力電圧の不足警告を表示する
電圧を設定する。
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Networkメニュー
各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Network>Setup for Mobile App
ネットワーク設定支援ツールを実行します。

メニュー項目 細目と設定値 内容

Setup ネットワーク設定支援ツールを起動する。

Network>Access Authentication
アクセス認証に関する設定を行います。

メニュー項目 細目と設定値 内容

User Name アクセス認証のためのユーザー名を設定す
る。

Input 
Password

アクセス認証のためのパスワードを設定す
る。

［ご注意］
セキュリティの観点から、パスワードには他人に
推測されにくく十分な長さのある文字列を設定
し、厳重に保管することを推奨します。

Generate 
Password

Execute / Cancel アクセス認証のためのパスワードを自動生
成する。
Execute：実行

Show 
Settings

アクセス認証の情報を表示する。
ユーザー名、パスワード、フィンガープリン
ト、シリアル番号、モデル名を文字とQRコー
ドで表示する。

［ご注意］
パスワードを盗み見られたり、QRコードの画像
を流出させないように注意してください。

Network>Wireless LAN
無線LAN接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Setting Access Point Mode / Station Mode / 
Off

無線LAN接続の動作モードを選択する。

WPS Execute / Cancel WPS（Wi-Fi Protected Setup）による接
続設定を開始する。
Execute：実行

NFC Execute / Cancel NFC（Near Field Communication）によ
る接続設定を開始する。
Execute：実行

MAC 
Address

本機の無線LANインターフェースのMACア
ドレスを表示する。

Network>AP Mode Settings
アクセスポイントモードでの接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Channel Auto(5GHz) / Auto / CH1 / CH2 / CH3 / 	
CH4 / CH5 / CH6 / CH7 / CH8 / CH9 / 
CH10 / CH11

無線LANのチャンネルを設定する。

Camera SSID 
& Password

本機のSSIDとパスワードを表示する。

Regenerate 
Password

Execute / Cancel パスワードを再生成する。
Execute：実行

IP Address 本機のアクセスポイントモードでのIPアドレ
スを表示する。

Subnet 
Mask

本機のアクセスポイントモードでのサブ
ネットマスクを表示する。
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Network>ST Mode Settings
ステーションモードでの接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Camera 
Remote 
Control

Enable / Disable ステーションモードで本機と無線LAN接続
されているデバイスからのリモートコント
ロールを許可するかどうかを設定する。

Connected 
Network

接続中の無線LANネットワーク（アクセスポ
イント）を表示する。

SSID 接続先アクセスポイントのSSIDを表示す
る。

Security 接続先アクセスポイントのセキュリティ種
別を表示する。

Password 接続先アクセスポイントのパスワードを表
示する。
セキュリティがWEP/WPA時：*******
セキュリティがNone時：空欄

DHCP DHCPの有効（On）、無効（Off）を表示する。
IP Address DHCPがOffのときに本機のIPアドレスを表

示する。
Subnet Mask DHCPがOffのときに本機のサブネットマス

クを表示する。
Gateway DHCPがOffのときに本機のデフォルトゲー

トウェイを表示する。
DNS Auto DNS自動取得のON/OFFを表示する。
Primary DNS Server DNS AutoがOffのときに本機のプライマ

リー DNSサーバーを表示する。
Secondary DNS Server DNS AutoがOffのときに本機のセカンダ

リー DNSサーバーを表示する。

Network>ST Mode Settings
ステーションモードでの接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Scan 
Networks

無線LANネットワーク（アクセスポイント）
を検出し、リスト表示する。
リストから接続先を選択し、接続する。

SSID 接続先アクセスポイントのSSIDを表示す
る。

Security 接続先アクセスポイントのセキュリティ種
別を表示する。

Password 接続先アクセスポイントのパスワードを入
力する。

DHCP	
On / Off

DHCPの有効（On）、無効（Off）を設定する。

IP Address DHCPがOffのときに本機のIPアドレスを入
力する。

Subnet Mask DHCPがOffのときに本機のサブネットマス
クを入力する。

Gateway DHCPがOffのときに本機のデフォルトゲー
トウェイを入力する。

DNS Auto	
On / Off

DNS自動取得をOn/Offする。

Primary DNS Server DNS AutoがOffのときに本機のプライマ
リーDNSサーバーを入力する。

Secondary DNS Server DNS AutoがOffのときに本機のセカンダ
リーDNSサーバーを入力する。
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Network>ST Mode Settings
ステーションモードでの接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Manual 
Register

アクセスポイントと手動接続する。
SSID 接続先アクセスポイントのSSIDを入力す

る。
Security	
None / WEP / WPA

接続先アクセスポイントのセキュリティ種
別を設定する。接続先アクセスポイントの
セキュリティ種別がWPAまたはWPA2の場
合は、WPAを選択。

Password 接続先アクセスポイントのパスワードを入
力する。

DHCP	
On / Off

DHCPの有効（On）、無効（Off）を設定する。

IP Address DHCPがOffのときに本機のIPアドレスを入
力する。

Subnet Mask DHCPがOffのときに本機のサブネットマス
クを入力する。

Gateway DHCPがOffのときにデフォルトのゲート
ウェイを入力する。

DNS Auto	
On / Off

DNS自動取得をOn/Offする。

Primary DNS Server DNS AutoがOffのときにプライマリー 
DNSサーバーを入力する。

Secondary DNS Server DNS AutoがOffのときにセカンダリー 
DNSサーバーを入力する。

Network>Wired LAN
有線LAN接続に関する設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off 有線LANをOn/Offする。
Camera 
Remote 
Control

Enable / Disable 本機と有線LAN接続されているデバイスか
らのリモートコントロールを許可するかどう
かを設定する。

Detail 
Settings

有線LAN接続の詳細設定を行う。
DHCP	
On / Off

DHCPの有効（On）、無効（Off）を設定する。

IP Address DHCPがOffのときに本機のIPアドレスを入
力する。

Subnet Mask DHCPがOffのときに本機のサブネットマス
クを入力する。

Gateway DHCPがOffのときにデフォルトのゲート
ウェイを入力する。

DNS Auto	
On / Off

DNS自動取得をOn/Offする。

Primary DNS Server DNS AutoがOffのときにプライマリー 
DNSサーバーを入力する。

Secondary DNS Server DNS AutoがOffのときにセカンダリー 
DNSサーバーを入力する。

Network>Modem
USBテザリングの使用に関する設定を行います。

メニュー項目 細目と設定値 内容

Setting On / Off スマートフォン接続の有効（On）、無効（Off）
を設定する。

Camera 
Remote 
Control

Enable / Disable スマートフォンアプリであるMonitor & 
ControlやCreators' App for enterprise
など、USBテザリング経由でのリモートコ
ントロールの可否を設定する。

Device 
Name

スマートフォンのDevice Nameを表示す
る。

IP Address スマートフォンのIPアドレスを表示する。
Subnet 
Mask

スマートフォンのサブネットマスクを表示す
る。
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Network>File Transfer
ファイルの転送に関する設定を行います。

メニュー項目 細目と設定値 内容

Auto Upload On / Off オリジナルファイルの自動転送をOn/Offす
る。

［ご注意］
Projectメニュー >Simul RecのSetting（89
ページ）がOnに設定されている場合は、スロット
Bのメディア上に記録されるクリップは、自動転
送の対象にはなりません。

Auto Upload 
(Proxy)

On / Off / Chunk On：
プロキシファイルの自動転送を有効に
する。

Off：
プロキシファイルの自動転送を無効に
する。

Chunk：
分割記録したプロキシファイルを自動
で転送する。

［ご注意］
Projectメニュー >Simul RecのSetting（89
ページ）がOnに設定されている場合は、スロット
Bのメディア上に記録されるクリップは、自動転
送の対象にはなりません。また、Chunkはグレー
アウトされ選択できません。

Default 
Upload 
Server

ファイルの転送先サーバーを選択する。こ
こで選択したサーバーは、オリジナルファイ
ルやプロキシファイルの自動転送先、およ
びサムネイル画面からのファイル転送先の
サーバーになる。
Server Settings 1 ～ 3で設定したDisplay 
Nameを表示する。

Clear 
Completed 
Jobs

Execute / Cancel 転送完了済みのジョブをリストからクリア
する。
Execute：実行

Clear All 
Jobs

Execute / Cancel すべての転送ジョブをリストからクリアす
る。
Execute：実行

View Job 
List

転送ジョブ一覧を表示する。

Network>File Transfer
ファイルの転送に関する設定を行います。

メニュー項目 細目と設定値 内容

Server 
Settings1

Display Name 転送先設定のメニュー上の表示名を入力す
る。

Service	
FTP

サーバーの種類を表示する。

Host Name 転送先サーバーのホスト名を設定する。
Port（1～ 65535（21）） 転送先サーバーのポート番号を設定する。
User Name 転送先サーバー接続の認証用ユーザー名を

設定する。
Password 転送先サーバー接続の認証パスワードを設

定する。
Passive Mode	
On / Off

PASVモードをOn/Offする。

Destination Directory 転送先のディレクトリー名を入力する。
Using Secure Protocol	
On / Off

セキュアなFTP転送（FTPSのExplicit 
Mode：FTPES）を行うか（On）、行わない
か（Off）を設定する。

Root Certificate	
Load / Clear / None

セキュアなFTP転送ためのルート証明書の
読み込み、削除を設定する。

Root Certificate Status	
Loaded / No Certificate

セキュアなFTP転送ためのルート証明書の
読み込み状態を表示する。

Reset	
Execute / Cancel

Server Settingsの設定を初期値に戻す。
Execute：実行

Server 
Settings2

Server Settings 1と同じ

Server 
Settings3

Server Settings 1と同じ

Network>Network Reset
ネットワークの設定をリセットします。

メニュー項目 細目と設定値 内容

Reset Execute / Cancel ネットワークの設定をリセットする。
Execute：実行
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各メニュー項目の機能および設定値は以下のとおりです。
工場出荷時の初期設定値は、太文字（例：18dB）で示します。

Maintenance>Language
表示する言語を設定します。

メニュー項目 細目と設定値 内容

Select 表示する言語を設定する。
SET：実行

Maintenance>Clock Set
内蔵時計に関する設定を行います。

メニュー項目 細目と設定値 内容

Time Zone UTC -12:00 ～ UTC +14:00 UTCからの時差を30分単位で設定する。
Date Mode YYMMDD / MMDDYY / DDMMYY 年月日の表示方式を選択する。

YYMMDD：年月日の順
MMDDYY：月日年の順
DDMMYY：日月年の順

12h/24h 12h / 24h 時刻の表示形式を選択する。
12h：12時間表示
24h：24時間表示

Date 現在の日付を設定する。
SET：決定

Time 現在の時刻を設定する。
SET：決定

Maintenance>All Reset
工場出荷時の状態にリセットします。

メニュー項目 細目と設定値 内容

Reset Execute / Cancel 工場出荷時の状態へのリセットを実行す
る。
Execute：実行

［ご注意］
Paint/LookメニューのBase LookのImport 
from Media(B)、Import from Cloud(Private)
およびImport from Cloud(Share)（94ペー
ジ）でインポートした3D LUTファイルは削除され
ません。インポートした3D LUTファイルを削除
する場合は、Paint/LookメニューのBase Look
のDelete Allを実行してください（94ページ）。

Maintenance>All Reset
工場出荷時の状態にリセットします。

メニュー項目 細目と設定値 内容

Reset 
without 
Network

Execute / Cancel Networkメニュー以下の設定を除いたメ
ニュー設定値を工場出荷状態にリセットす
る。

Reset to 
Factory 
Defaults

Execute / Cancel すべての設定やファイルを削除し、工場出
荷状態に戻す。

Maintenance>Hours Meter
積算時間を表示します。

メニュー項目 細目と設定値 内容

Hours
（System）

積算使用時間（リセット不可）を表示する。

Hours
（Reset）

積算使用時間（リセット可）を表示する。

Reset Execute / Cancel Hours（Reset）表示を0にリセットする。
Execute：実行

Maintenance>Version
バージョンを表示します。

メニュー項目 細目と設定値 内容

Version 
Number

Vx.xx 本機のソフトウェアバージョンを表示する。

Version Up Execute / Cancel 本機をバージョンアップ*する。
Execute：実行
*	 バージョンアップは本機のソフトウェアをアッ
プデートする機能です。

Lens Version 
Number

Vxx Eマウントレンズのソフトウェアバージョン番
号を表示する。

Maintenanceメニュー



6章　メニュー表示と詳細設定113

Shootingメニューの設定値と初期値について
ISO/Gainメニューの設定値と初期値

Mode、Target Display、Base LookのSelect、Base Sensitivity、Base ISOの設定によって、ISO/Gainメニュー（80ページ）の設定範囲と初期値が異なります。グレーの範囲が設定可能な値です。

ModeがISOのとき

Custom時
Target Display SDR(BT.709) HDR(HLG) SDR(BT.709)、HDR(HLG)共通
Base LookのSelect S-Cinetone / Standard / Still / ITU709 / 709tone HLG Live / HLG Natural User1 ～ User16
Base Sensitivity Low High Low High Low High
ISO 320 ISO/Gain<L>初期値
ISO 400
ISO 500
ISO 640 ISO/Gain<M>初期値
ISO 800 ISO/Gain<L>初期値 ISO/Gain<L>初期値
ISO 1000
ISO 1250 ISO/Gain<H>初期値
ISO 1600 ISO/Gain<M>初期値 ISO/Gain<M>初期値
ISO 2000
ISO 2500
ISO 3200 ISO/Gain<H>初期値 ISO/Gain<H>初期値
ISO 4000
ISO 5000 ISO/Gain<L>初期値
ISO 6400
ISO 8000
ISO 10000 ISO/Gain<M>初期値
ISO 12800 ISO/Gain<L>初期値 ISO/Gain<L>初期値
ISO 16000
ISO 20000 ISO/Gain<H>初期値
ISO 25600 ISO/Gain<M>初期値 ISO/Gain<M>初期値
ISO 32000
ISO 40000
ISO 51200 ISO/Gain<H>初期値 ISO/Gain<H>初期値
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Flexible ISO時
Base ISO ISO 12800 ISO 800

ISO 320

ISO 400

ISO 500

ISO 640

ISO 800 ISO/Gain<L>初期値

ISO 1000

ISO 1250

ISO 1600 ISO/Gain<M>初期値

ISO 2000

ISO 2500

ISO 3200 ISO/Gain<H>初期値

ISO 4000

ISO 5000

ISO 6400

ISO 8000

ISO 10000

ISO 12800 ISO/Gain<L>初期値

ISO 16000

ISO 20000

ISO 25600 ISO/Gain<M>初期値

ISO 32000

ISO 40000

ISO 51200 ISO/Gain<H>初期値

ISO 64000

ISO 80000

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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ModeがdBのとき

設定範囲
－3dB
－2dB
－1dB
0dB ISO/Gain<L>初期値
1dB
2dB
3dB
4dB
5dB
6dB ISO/Gain<M>初期値
7dB
8dB
9dB
10dB
11dB
12dB ISO/Gain<H>初期値
13dB
14dB
15dB
16dB
17dB
18dB
19dB
20dB
21dB
22dB
23dB
24dB
25dB
26dB
27dB
28dB
29dB
30dB
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AGC Limitメニューの設定値と初期値

Mode、Target Display、Base LookのSelect、Base Sensitivity、Base ISOの設定によって、AGC Limitメニュー（83ページ）の設定範囲と初期値が異なります。グレーの範囲が設定可能な値です。

ModeがISOのとき

Custom時
Target Display SDR(BT.709) HDR(HLG) HDR(HLG) SDR(BT.709)、HDR(HLG)共通
Base LookのSelect S-Cinetone / Standard / Still / ITU709 / 709tone HLG Live HLG Natural User1 ～ User16
Base Sensitivity Low High Low High Low High Low High
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000 初期値
ISO 2500
ISO 3200
ISO 4000
ISO 5000 初期値 初期値 初期値
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000 初期値
ISO 40000
ISO 51200
ISO 64000
ISO 80000 初期値 初期値 初期値
ISO 102400
ISO 128000
ISO 160000

ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Flexible ISO時
Base ISO ISO 12800 ISO 800

ISO 400

ISO 500

ISO 640

ISO 800

ISO 1000

ISO 1250

ISO 1600

ISO 2000

ISO 2500

ISO 3200

ISO 4000

ISO 5000 初期値

ISO 6400

ISO 8000

ISO 10000

ISO 12800

ISO 16000

ISO 20000

ISO 25600

ISO 32000

ISO 40000

ISO 51200

ISO 64000

ISO 80000 初期値

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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ModeがdBのとき

設定範囲
3dB
6dB
9dB
12dB
15dB 初期値
18dB
21dB
24dB
27dB
30dB
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画質に関する設定項目は、以下の撮影モード（25ページ）ごとに現在の設定状態が保持されます。撮影モードを切り替えると、切り替え後の撮影モードが保持する設定状態が適用されます。

ˎˎ CustomのSDR(BT.709)

ˎˎ CustomのHDR(HLG)

ˎˎ Log撮影（Cine EI、Cine EI Quick、Flexible ISO）
画質に関する各設定状態は撮影モードごとに以下のように保存されます。
Yes：保存されます
No：保存されません

設定項目 撮影モード
Custom Flexible ISO Cine EI Quick Cine EI
SDR(BT.709) HDR(HLG)

Shootingメニュー ISO/Gain/EI ISO/Gain Yes1) Yes No
Exposure Index No No Yes Yes
Base Sensitivity Yes No
Base ISO No Yes4) No3) Yes4)

White Preset White Yes Yes
上記以外 Yes

White Setting Yes
Offset White Yes No
LUT On/Off No Yes
Noise Suppression Setting(Custom) Yes Yes No

Level(Custom) Yes Yes No
Setting (Cine EI/Flex. ISO) No Yes
Level (Cine EI/Flex. ISO) No Yes

Paint/Lookメニュー Base Look Select Yes Yes Yes
Input2) Yes
Output2) Yes
AE Level Offset2) Yes

Black Yes Yes No
Knee Auto Knee Yes No No

上記以外 Yes Yes No
Detail Yes Yes No
Matrix Yes Yes No
Multi Matrix Yes Yes No

1)	 ISO感度については、CustomのSDR(BT.709)、HDR(HLG)で設定値が個別に保存される場合があります。
2)	設定値はBase Lookごとに保持されており、各撮影モードには依存しません。
3)	Exposure Indexに連動して、基準ISO感度が切り替わります。
4)	Flexible ISOとCine EI間で、共通の設定値となります。

撮影モードごとの画質に関する設定状態の保存について
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設定データの保存と読み込み
設定データ

フルメニューの設定内容を、本機のCFexpress 
Type A/SDカードスロット（B）に挿入したメモ
リーカードに保存することができます。また、All
ファイルをクラウドサービスに保存することがで
きます。このデータを使って適切なセットアップ
状態をすばやく再現できます。
設定データは、次のように分類されて保存され
ます。

User File（ユーザーファイル）
カスタマイズしたUserメニューの設定項目と設定
データを保存します。
メモリーカードに64個まで保存することができ
ます。
このファイルを本機のメモリーに読み込むことに
より、Userメニューをカスタマイズした状態に
セットアップすることができます。

All File（ALLファイル）
全メニューの設定データを保存します。メモリー
カードに64個まで保存することができます。C3 
Portal（クラウドサービス）には、個人60個まで
と共通60個までの計120個まで保存することが
できます。

［ご注意］
Allファイルに保存される内容については「ファイルに保存さ
れる項目」（133ページ）をご覧ください。

ユーザーファイル、ALLファイ
ルを保存する

メモリーカードに保存する

1	 メモリーカードをCFexpress Type A/SD
カードスロット（B）（6ページ）に差し込
む。

ˎˎ CFexpressカードの場合はラベルを左に
する。

ˎˎ SDカードの場合はラベルを右にして切り
欠き部を下にする。

2	 ユーザーファイルの場合は、フルメニュー
のProjectメニュー>User FileのSave to 
Media(B)（93ページ）で、Executeを選
択する。
ALLファイルの場合は、フルメニュー
のProjectメニュー>All FileのSave to 
Media(B)（93ページ）で、Executeを選
択する。
ファイルの保存先画面が表示されます。

3	 保存先画面のNo Fileの行を選択する。
File IDが記載されている行を選択すると、
そのファイルに上書きされます。
保存する際に付けられるFile IDはメニューで
変更できます。設定方法については「File ID
を変更するには」（121ページ）をご覧くだ
さい。

4	 確認画面のExecuteを選択する。

Allファイルをクラウドサービスに保存
する

1	 本機をスマートフォンアプリ「Creators' App 
for enterprise」に接続する（70ページ）。

2	 フルメニューのProjectメニュー>All File
のSave to Cloud(Private)またはSave to 
Cloud(Share)（93ページ）で、Execute
を選択する。
ファイルの保存先画面が表示されます。

3	 保存先画面のNo Fileの行を選択する。
File IDが記載されている行を選択すると、
そのファイルに上書きされます。
保存する際に付けられるFile IDはメニューで
変更できます。設定方法については「File ID
を変更するには」（121ページ）をご覧くだ
さい。

4	 確認画面のExecuteを選択する。

ユーザーファイル、ALLファイ
ルを読み込む

メモリーカードから読み込む

1	 ファイルを保存したメモリーカードを
CFexpress Type A/SDカードスロット（B）
（6ページ）に差し込む。

ˎˎ CFexpressカードの場合はラベルを左に
する。

ˎˎ SDカードの場合はラベルを右にして切り
欠き部を下にする。

2	 ユーザーファイルの場合は、フルメニューの
Projectメニュー>User FileのLoad from 
Media(B)（93ページ）で、Executeを選
択する。
ALLファイルの場合は、フルメニューの
Projectメニュー>All FileのLoad from 
Media(B)（93ページ）で、Executeを選
択する。
ファイルの一覧画面が表示されます。

3	 読み込むファイルを選択する。
確認画面が表示されます。

4	 Executeを選択する。
［ご注意］

ˎˎ 設定データを読み込むと、本機は自動的に再起動され
ます。
ˎˎ フルメニューのProjectメニュー >All FileのLoad 
Network DataがOffの場合は、Networkメニューの
設定項目を除いたALLファイルを読み込みます。
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Allファイルをクラウドサービスから読
み込む

1	 本機をスマートフォンアプリ「Creators' App 
for enterprise」に接続する（70ページ）。

2	 フルメニューのProjectメニュー>All File
のLoad from Cloud(Private)またはLoad 
from Cloud(Share)（93ページ）で、
Executeを選択する。
ファイルの一覧画面が表示されます。

3	 読み込むファイルを選択する。
確認画面が表示されます。

4	 Executeを選択する。
［ご注意］

ˎˎ 設定データを読み込むと、本機は自動的に再起動され
ます。
ˎˎ フルメニューのProjectメニュー >All FileのLoad 
Network DataがOffの場合は、Networkメニューの
設定項目を除いたALLファイルを読み込みます。

File IDを変更するには

1	 ユーザーファイルの場合は、フルメニュー
のProjectメニューのUser Fileで、File ID
（93ページ）を選択する。
ALLファイルの場合は、フルメニューの
ProjectメニューのAll Fileで、File ID（93
ページ）を選択する。
File IDの編集画面が表示されます。

2	 マルチセレクター（7ページ）またはマル
チファンクションダイヤル（5ページ）で
文字を選択し、マルチセレクターの決定ボタ
ンまたはマルチファンクションダイヤルを押
す。

3	 手順2を繰り返す。

4	 文字の入力が終了したら、Doneを選択する。
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外部モニターや記録装置を接続する
記録・再生画像を外部モニターに表示させるとき
は、本機の出力信号を選択し、接続するモニター
に応じた接続ケーブルを使用してください。
VTRなどの記録装置を接続して、本機の出力信
号を記録することもできます。
外部モニターにビューファインダーと同様の各種
ステータス情報やメニューなどを表示させること
ができます。モニターに出力する信号に応じて、
MonitoringステータスのInfo. Disp.（15ペー
ジ）、またはフルメニューのMonitoringメニュー
のOutput Display（99ページ）をOnに設定し
てください。

［ご注意］
本機に外部モニターや記録装置などを接続する際には次の
ことにご注意ください。これらを守らないと、本機の内部
回路に大電流が流れ、電気部品が破壊することがあります。
1.	 DCケーブルについて	
外部モニターや記録装置などに接続するDCケーブルは、
GND線のインピーダンスが低いものを使用してください。

2.	電位差の確認について	
事前にすべての接続機器と本機に電位差がないことを
確認してください。
（1）	 外部モニターや記録装置などすべての接続機器と

本機の接続がない状態にする。	
75Ω同軸ケーブルやHDMIケーブルなどは接続しな
い状態で確認してください。

（2）	すべての接続機器と本機のDCケーブルを接続し、
各接続機器および本機の電源をONにする。

（3）	本機と各接続機器との間に電位差がないことをテス
ターなどで確認する。

	 もし電位差があった場合はいずれかのDCケーブルの
GND線のインピーダンスが高いことが考えられます。
GND線のインピーダンスが低いケーブルに交換するなど
して電位差がなくなるようにしてください。

3.	接続と電源ONの順番について	
各ケーブル接続と電源ONは次の順番で行ってください。
（1）	 本機と外部モニターや記録装置などの電源をすべて

OFFにする。
（2）	初めにすべての機器のDCケーブルを接続する。
（3）	75Ω同軸ケーブル、HDMIケーブルなどを接続する。
（4）	すべての接続機器と本機の電源をONにする。
詳しくはソニーサービス窓口にご相談ください。

SDI OUT端子（BNC型）

Monitoringメニュー（99ページ）で、出力の
On/Offや出力フォーマットを設定します。
接続には市販の75Ω同軸ケーブルを使用してくだ
さい。

本機と同時に外部機器で記録を開始
するには

SDI信号出力時は、フルメニューのProjectメ
ニュー>SDI/HDMI Rec Control（90ペー
ジ）のSettingをSDI/HDMI Remote I/Fまたは
Parallel Recに設定すると、SDI OUT端子に接
続した外部機器にRECトリガー信号を出力するこ
とによって、本機に連動した記録が可能になりま
す。

［ご注意］

ˎˎ 接続した外部機器がRECトリガー信号に対応していない
場合は動作しません。
ˎˎ SDI/HDMI Remote I/Fに設定した場合、記録メディア
が挿入されていないときは、RECトリガー信号のみ出力
されます。

HDMI OUT端子（Type Aコネ
クター）

フルメニューのMonitoringメニュー（99ペー
ジ）で、出力のOn/Offや出力フォーマットを設
定します。

本機と同時に外部機器で記録を開始
するには

HDMI信号出力時は、フルメニューのTC/Media
メニュー>HDMI TC OutのSetting（97ペー
ジ）をOnにして、Projectメニュー>SDI/HDMI 
Rec ControlのSetting（90ページ）をSDI/
HDMI Remote I/FまたはParallel Recに設定
すると、HDMI OUT端子に接続した外部機器に
RECトリガー信号を出力することによって、本機
と同期した記録が可能になります。

［ご注意］

ˎˎ 接続した外部機器がRECトリガー信号に対応していない
場合は動作しません。
ˎˎ SDI/HDMI Remote I/Fに設定した場合、記録メディア
が挿入されていないときは、RECトリガー信号のみ出力
されます。
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タイムコードを合わせる
本機のタイムコードを他機に合わせることができ
ます。

他機のタイムコードにロック
させる

タイムコード供給源となる機器は、タイムコード
出力が更新されるモード（Free RunやClock）に
設定してください。

1	 フルメニューのTC/Mediaメニューの
Timecode（97ページ）を次のように設定
する。
Mode：Preset
Run：Free Run

2	 DURATION/TC/U-BIT機能が割り当てられ
たアサイナブルボタン（52ページ）を押し
て、画面にタイムコードを表示させる。

3	 TC IN/OUT切り替えスイッチ（4ページ）
がIN側になっていることを確認し、TC IN/
TC OUT端子に、本機のシステム周波数に
同期した基準タイムコードを供給する。

これで本機のタイムコードジェネレーターが基準
タイムコードにロックし、画面に「EXT-LK」と表
示されます。
ロックしてから約10秒経過した後は、外部から
の基準タイムコードの接続を外しても、外部ロッ
ク状態は保たれます。

［ご注意］

ˎˎ 外部ロックの操作をすると、タイムコードは瞬時に外部
のタイムコードにロックし、外部タイムコードの値と同じ
値がタイムデータ表示部に出ますが、タイムコードジェ
ネレーターが安定するまでの数秒間は、記録を開始しな
いでください。
ˎˎ 基準タイムコードの周波数と本機のフレーム周波数が同
じでないと、正しくロックできず、本機が正常に動作で
きません。この場合、タイムコードも外部のタイムコー
ドに正しくロックできません。
ˎˎ 基準タイムコードに対し1時間で1フレームずれる場合が
あります。

外部ロックを解除するには

フルメニューのTC/MediaメニューのTimecode
の設定を変更してください。
システム周波数を変更した場合や、特殊記録モー
ド（スロー＆クイックモーションまたはインターバ
ルレック）での記録を開始した場合も、外部ロッ
クは解除されます。

本機のタイムコードに他機の
タイムコードを合わせる

タイムコード供給源となる機器は、タイムコード
出力が更新されるモード（Free RunやClock）に
設定してください。

1	 フルメニューのTC/Mediaメニューの
Timecodeで本機のタイムコードを設定する
（97ページ）。

2	 TC IN/OUT切り替えスイッチ（4ページ）
がOUT側になっていることを確認し、TC 
IN/TC OUT端子を、同期させたい機器のタ
イムコード入力端子に接続する。
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コンピューターでクリップ管理・編集する
USBケーブルを使って接続す
る

カードリーダー（別売）を使う

コンピューターにCFexpress Type Aカードリー
ダーまたはSDカードリーダーをUSBケーブルで接
続すると、カードリーダーのスロットに装着され
たメモリーカードがコンピューターの拡張ドライ
ブとして認識されます。なお、対応したコンピュー
ターの場合、本機のマスストレージモードを使用
するよりも高速に、クリップを取り込むことがで
きます。

本機のマスストレージモードを使う

［ご注意］
フルメニューのNetworkメニュー >ModemのSettingが
On、またはNetworkメニュー >Wired LANのSettingが
Onに設定されている場合は、マスストレージモードを使う
ことができません。両方ともOffに設定してください。

本機をUSBケーブルで接続すると、カードスロッ
トA/Bに装着されたメモリーカードがコンピュー
ターの拡張ドライブとして認識されます。

1	 USB-C端子（7ページ）またはUSB/マ
ルチ端子（7ページ）とコンピューターを
USBケーブルで接続する。

2	 本機のPOWERスイッチをOnにする。
ビューファインダー画面にUSBの接続を有効
にするかどうかを確認するメッセージが表示
されます。

	 ［ご注意］
メモリーカードのフォーマットや修復など、実行を確
認するメッセージや実行中のメッセージが表示されて
いる間は、USB接続確認メッセージは表示されません。
フォーマットや修復などの実行が終了後に表示されま
す。またクリップの詳細情報表示中もUSB接続確認
メッセージは表示されません。処理が終了するか、サ
ムネイル画面に戻ると表示されます。

3	 マルチファンクションダイヤルを回して
Executeを選ぶ。

4	 Windowsの場合、「マイコンピュータ」にリ
ムーバブルディスクとして追加されているこ
とを確認する。
Macの場合、デスクトップにNO NAMEま
たはUntitledフォルダー（フォルダー名は任
意に変更可）が作成されていることを確認す
る。

［ご注意］

ˎˎ アクセスランプが赤く点灯しているときは、次の操作を
しないでください。
–– 電源を切る。電源コードを抜く
–– メモリーカードを抜く
–– USBケーブルを抜く

ˎˎ すべてのコンピューターについて、動作を保証するもの
ではありません。

ノンリニア編集システムを使
う

ノンリニア編集システムには、本機で記録した
フォーマットに対応した編集ソフトウェア（別売）
が必要です。
専用アプリケーションソフトウェアを使って、あ
らかじめコンピューターのHDDに編集したいク
リップを保存しておきます。
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使用上のご注意
結露について

本機を寒いところから急に暖かいところに持ち込
んだときなど、機器表面や内部に水滴がつくこと
があります。これを結露といいます。結露が起き
たときは電源を切り、結露がなくなるまで放置し、
結露がなくなってからご使用ください。結露時の
ご使用は機器の故障の原因となる場合がありま
す。

LCDパネルについて

本機のLCD（液晶）パネルは有効画素99.99％以
上の非常に精密度の高い技術で作られています
が、画面上に黒い点が現れたり（画素欠け）、常
時点灯している輝点（赤、青、緑など）や滅点が
ある場合があります。また、LCD（液晶）パネル
の特性上、長期間ご使用の間に画素欠けが生じ
ることもあります。これらの現象は故障ではあり
ませんので、ご了承の上本機をお使いください。
なお、これらの点が記録されることはありません。

本機搭載のCMOSイメージセンサーの
現象

［ご注意］
撮影画面に出る下記の現象は、イメージセンサー特有の現
象で、故障ではありません。

白点
イメージセンサーは非常に精密な技術で作られ
ていますが、宇宙線などの影響により、まれに
画面上に微小な白点が発生する場合があります。
これはイメージセンサーの原理に起因するもので
故障ではありません。
また、下記の場合、白点が見えやすくなります。

ˎˎ 高温の環境で使用するとき

ˎˎ ゲイン（感度）を上げたとき

フリッカー
蛍光灯、ナトリウム灯、水銀灯、LEDによる照明
下で撮影すると、画面が明滅したり、色が変化
したように見えることがあります。

有寿命部品について

ˎˎ ファン、バッテリーは有寿命部品として定期的
な交換が必要です。	
常温でのご使用の場合、5年を目安に交換し
てください。ただし、交換時期は目安であり、
部品の寿命を保証するものではありません。
交換の際はお買い上げ店 にご相談ください。

ˎˎ ＡＣアダプターと電解コンデンサの寿命は約5
年です。（常温で1日に8時間、1カ月で25日間、
通常に使用すると想定した場合）したがって、
使用時間が上記より長い場合は、その分寿命
は短くなります。

ˎˎ 機器に搭載されているバッテリー端子（バッテ
リーパックやACアダプターとの接点部分）は消
耗品です。	
振動や衝撃によって端子が変形したり、曲がっ
たり、あるいは長期の屋外での使用などによっ
て表面が腐食したりすると、本体に電源が供
給されなくなります。	
長期間機器を使用していただくために、定期
点検を実施することをお願いします。点検につ
きましては、ソニーのサービス担当者または営
業担当者にご相談ください。

内蔵の充電式電池について

本機は日時や各種の設定を電源の入/切と関係
なく保持するために、充電式電池を内蔵していま
す。内蔵の充電式電池は、本機の電源の入/切に
関わらず、ACアダプターでコンセントにつながっ
ているか、充電されたバッテリーを本機に装着し

た状態で24時間経過すれば充電されます。ACア
ダプターで電源につながない、またはバッテリー
を入れないままで2か月近くまったく使わないと
完全に放電してしまいます。充電してから使って
ください。ただし、充電式電池が充電されてい
ない場合でも、使用時の日時を記録する必要が
なければ本機を使えます。

使用場所・保管場所について

水平な場所、空調のある場所に保管してください。
次のような場所での使用・保管は避けてください。

ˎˎ 極端に寒い所、暑い所（使用温度は0 ℃～
40 ℃）。	
真夏、窓を閉め切った自動車内は50 ℃を越え
ることがあります。

ˎˎ 湿気・ほこりの多い所。雨があたる所。

ˎˎ 激しく振動する所。

ˎˎ 強い磁気を発生するものの近く。

ˎˎ 強力な電波を発生するテレビやラジオの送信
所の近く。

ˎˎ 直射日光が長時間当たる場所や暖房器具の近
く。

レーザービームについてのご注意

レーザービームはCMOSイメージセンサーに損傷
を与えることがあります。レーザービームを使用
した撮影環境では、CMOSイメージセンサー表
面にレーザービームが照射されないように充分
注意してください。特に医療用などの強力なレー
ザー光の場合は、反射光や散乱光でも損傷を与
えることがあります。

携帯電話などによる電波障害を防止す
るために

携帯電話などを本機の近くで使用すると、誤動
作を引き起こしたり、映像、音声などに影響を与
えることがあります。携帯電話などはできるだけ
本機に近づけないようにしてください。

セキュリティに関するご注意

ˎˎ 通信を行う機器でセキュリティ対策を行わな
かった結果、または、通信仕様上の、やむを
得ない事情により、データ漏洩等、セキュリティ
上の問題が発生した場合、弊社ではそれによっ
て生じたあらゆる損害に対する責任を負いかね
ます。

ˎˎ 使用環境によってはネットワーク上の意図せぬ
第三者から製品にアクセスされる可能性があり
ます。本機をネットワークに接続する際には、
セキュアなネットワークであることをご確認の
上ご使用ください。

ˎˎ 利用者が気付かないうちに、電波が届くところ
から意図せぬ第三者に通信内容を盗み見られ
てしまうおそれがあります。無線LAN通信を利
用する際は、通信内容を保護するために、適
切なセキュリティ対策をしてください。

ˎˎ 本製品のネットワークへの接続には、ルーター
やファイアウォールなどの保護機能を通して接
続をしてください。このような接続をしない場
合、セキュリティ上の問題が生じる可能性があ
ります。
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初期設定値は、太文字（例：1920×1080P (Level A)）で示します。

［ご注意］

ˎˎ 出力フォーマットの解像度はフルメニューのProjectメニュー >Rec FormatのFrequency、CodecおよびVideo 
Formatの設定によって制限されます（87ページ）。
ˎˎ 出力フォーマットの解像度は、S&Qのフレームレートとの組み合わせによっても制限されます。下記のSDI OUT/HDMI 
OUT端子の出力フォーマットの表に加えて、以下の設定条件をすべて満たす場合、HDMI出力はFHD以下になります。
–– Shootingメニュー >S&Q MotionのSettingがOn
–– Shootingメニュー >S&Q MotionのFrame Rateが60fpsを超える値
–– Projectメニュー >Rec FormatのCodecがRAW、RAW & XAVC-Iのいずれか、または、Monitoringメニュー
>Output On/OffのSDIがOn

ˎˎ 上記条件を満たした場合、Monitoringメニュー >Output FormatのSDI/HDMI（99ページ）でHDMI出力が4096
×2160P/3840×2160Pとなっている選択肢はグレーアウトされ選択できなくなります。
ˎˎ 再生画像の解像度より大きな解像度が設定されている場合、映像は出力されません。

SDI OUT/HDMI OUT端子の出力フォーマット

システム周波数設
定	
（Projectメニュー
>Rec Formatの
Frequency）

Codec設定	
（Projectメニュー
>Rec Formatの
Codec）

RAW/録画フォーマッ
ト設定	
（Projectメニュー
>Rec FormatのRAW 
Output Format/
Video Format）

出力フォーマット（Monitoringメニュー
>Output Format）
SDI HDMI

50/59.94Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 
RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i

3840×2160 (RAW) (3840×2160 
RAW)

3840×2160P
1920×1080P
1920×1080i

RAW(HDMI)
RAW(HDMI) & 
XAVC-I

4240×2392(RAW) 1920×1080P 
(Level A)

(4240×2392 
HDMI RAW)

1920×1080P 
(Level B)
1920×1080i

システム周波数設
定	
（Projectメニュー
>Rec Formatの
Frequency）

Codec設定	
（Projectメニュー
>Rec Formatの
Codec）

RAW/録画フォーマッ
ト設定	
（Projectメニュー
>Rec FormatのRAW 
Output Format/
Video Format）

出力フォーマット（Monitoringメニュー
>Output Format）
SDI HDMI

50/59.94Hz XAVC-I
XAVC-L

4096×2160(Video) 4096×2160P1) 4096×2160P
4096×2160P 1920×1080P
4096×2160P 1920×1080i
3840×2160P 3840×2160P
3840×2160P 1920×1080P
3840×2160P 1920×1080i
1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level A)

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080P 
(Level B)

1920×1080i

1920×1080i 1920×1080i
3840×2160(Video) 3840×2160P 3840×2160P

3840×2160P 1920×1080P
3840×2160P 1920×1080i
1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level A)

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080P 
(Level B)

1920×1080i

1920×1080i 1920×1080i

出力のフォーマットと制限
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システム周波数設
定	
（Projectメニュー
>Rec Formatの
Frequency）

Codec設定	
（Projectメニュー
>Rec Formatの
Codec）

RAW/録画フォーマッ
ト設定	
（Projectメニュー
>Rec FormatのRAW 
Output Format/
Video Format）

出力フォーマット（Monitoringメニュー
>Output Format）
SDI HDMI

50/59.94Hz XAVC-I
XAVC-L

1920×1080(Video) 1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level A)

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080P 
(Level B)

1920×1080i

1920×1080i 1920×1080i
（出力停止） 720×480P1) 2)

720×576P1) 3)

25/29.97Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 
RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i

3840×2160(RAW) (3840×2160 
RAW)

3840×2160P
1920×1080P
1920×1080i

RAW(HDMI)
RAW(HDMI) & 
XAVC-I

4240×2392(RAW) 1920×1080P (4240×2392 
HDMI RAW)1920×1080PsF

XAVC-I
XAVC-L

4096×2160(Video) 4096×2160P1) 4096×2160P
4096×2160P 1920×1080P
3840×2160P 3840×2160P
3840×2160P 1920×1080P
1920×1080P 1920×1080P
1920×1080PsF 1920×1080i

3840×2160(Video) 3840×2160P 3840×2160P
3840×2160P 1920×1080P
1920×1080P 1920×1080P
1920×1080PsF 1920×1080i

1920×1080(Video) 1920×1080P 1920×1080P
1920×1080PsF 1920×1080i

システム周波数設
定	
（Projectメニュー
>Rec Formatの
Frequency）

Codec設定	
（Projectメニュー
>Rec Formatの
Codec）

RAW/録画フォーマッ
ト設定	
（Projectメニュー
>Rec FormatのRAW 
Output Format/
Video Format）

出力フォーマット（Monitoringメニュー
>Output Format）
SDI HDMI

23.98Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 
RAW)

4096×2160P
3840×2160P
1920×1080P

3840×2160(RAW) (3840×2160 
RAW)

3840×2160P
1920×1080P

RAW(HDMI)
RAW(HDMI) & 
XAVC-I

4240×2392(RAW) 1920×1080P (4240×2392 
HDMI RAW)1920×1080PsF

XAVC-I
XAVC-L

4096×2160(Video) 4096×2160P1) 4096×2160P
4096×2160P 1920×1080P
3840×2160P 3840×2160P
3840×2160P 1920×1080P
1920×1080P 1920×1080P
1920×1080PsF 1920×1080P

3840×2160(Video) 3840×2160P 3840×2160P
3840×2160P 1920×1080P
1920×1080P 1920×1080P
1920×1080PsF 1920×1080P

1920×1080(Video) 1920×1080P 1920×1080P
1920×1080PsF 1920×1080P

24Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 
RAW)

4096×2160P
1920×1080P

XAVC-I 4096×2160(Video) 4096×2160P1) 4096×2160P
1920×1080P 1920×1080P

1)	 画面表示の重畳はできません。
2)	システム周波数が59.94のとき。
3)	システム周波数が50のとき。
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電源

症状 原因 対策
電源が入らない。 バッテリーパックからの電源、

DC IN電源のどちらも供給さ
れていない。

バッテリーパックを取り付ける（18ペー
ジ）か、ACアダプターを使用してAC電源
に接続する（19ページ）。

バッテリーパックが完全に消耗
している。

充電済みのバッテリーパックと交換する
（18ページ）。

電源が途中で切れる。 バッテリーパックが消耗してい
る。

充電済みのバッテリーパックと交換する
（18ページ）。

バッテリーパックがすぐ消耗す
る。

温度が極端に低いところで使
用している。

バッテリーパックの特性によるもので、故
障ではありません。

充電が不充分。 バッテリーパックをもう一度充電し直す
（18ページ）。
フル充電してもすぐに消耗する場合は、
バッテリーパックの寿命です。新しいバッ
テリーパックに交換してください。

記録・再生

症状 原因 対策
録画START/STOPボタンを押
しても記録が始まらない。

メモリーカードの容量がいっ
ぱいになっている。

充分な空き容量のあるメモリーカードに
交換する。

修復が必要なメモリーカード
が入っている。

メモリーカードを修復する（35ページ）。

音声が記録できない。 AUDIO LEVEL（CH1/CH2）ダ
イヤルが最小の位置になって
いる。

AUDIO LEVEL（CH1/CH2）ダイヤルを調
節する（50ページ）。

記録した音声がひずんでいる。 音声レベルが高すぎる。 AUDIO LEVEL（CH1/CH2）ダイヤルを調
節する（50ページ）。

雑音が多い。 音声レベルが低すぎる。 AUDIO LEVEL（CH1/CH2）ダイヤルを調
節する（50ページ）。
外部マイク選択時は、Audioメニューの
Audio InputのINPUT MIC Reference
の設定値も調節する（102ページ）。

症状 原因 対策
クリップを再生できない。 クリップが編集されている。 コンピューターでフォルダーやファイル名

を変更したり、クリップを加工したりする
と、再生できない場合があります。故障
ではありません。

クリップが他機で記録されて
いる。

他機で記録したクリップは、再生できな
かったり、正しいサイズで表示されなかっ
たりすることがあります。故障ではありま
せん。

外部機器

症状 対策
本機がコンピューターに認識され
ない。

USBテザリングを無効に設定する。
コンピューターからUSBケーブルを抜き、もう一度しっかりと差し込む。
コンピューターからUSBケーブルを抜き、コンピューターを再起動して
から正しい手順でもう一度コンピューターと本機をつなぐ。
USB-C端子またはUSB/マルチ端子のどちらか一方にのみUSBケーブ
ルを差し込んでコンピューターと本機をつなぐ。

クリップがコンピューターに取り込
めない。

コンピューターからUSBケーブルを抜き、本機の電源を入れてから、
もう一度つなぐ。
クリップをコンピューターに取り込むにはアプリケーションソフトウェ
アのダウンロードが必要です（124ページ）。

トラブル時の対処
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無線LAN使用時

［ご注意］
本機と無線LANアクセスポイントまたは端末機器間の障害物や電波状況、壁の材質など、周囲の環境によって通信可能距
離が短くなったり、接続できなくなったりすることがあります。本機の場所を移動するなど、本機とアクセスポイントまたは
端末機器の距離を近づけて、接続/通信状態を確認してください。

症状 対策
端末機器から本機にアクセスでき
ない

ˎˎ 無線LANの接続（IPアドレスなど）を確認してください
ˎˎ アクセスポイントのクライアント間の通信設定が無効になっている
可能性があります。詳しくは、アクセスポイントの取扱説明書をご
覧ください。

ログインできない 登録したユーザー名、パスワードが正しいか確認してください。

インターネット接続

症状 対策
ファイル転送が失敗する サーバーのユーザー名/パスワードが間違っている可能性があります。

正しい値を入力してください。
ファイル転送ができない 電波状態が悪い可能性があります。

移動して再度試してください。

NDフィルター使用時

症状 対策
NDフィルターが動かない。 次の作業により、手動でClearの位置に移動させることができます。

1	 本機のPOWERスイッチをOffにする。

2	 底面の丸いフタを外す。

3	 ドライバーを穴に差し込んで左に回す。
ˎˎ 左に回すことで、NDフィルターがClear側に動きます。Clearの位置になるまで回し続けてくだ
さい。

ˎˎ φ2.4以下のマイナスドライバーを使用してください。ドライバー挿入部の深さは約3.0 cmです。

ドライバー挿入部
（フタを外した状態）

4	 ND PRESET/VARIABLEスイッチ（5ページ）をPRESETの位置にして、ND FILTER 
POSITION上下ボタン（5ページ）をCLEARの位置にする。

［ご注意］

ˎˎ 上記の作業は、通常の動作時には行わないでください。NDフィルターが動かなくなった場合のみに行ってください。通
常の動作時に行うと、NDユニットが故障するおそれがあります。
ˎˎ 上記の作業を行ったあと、サービスセンターで本機を修理してください。
ˎˎ 上記の作業を行ってもエラーメッセージが出たままの場合がありますが、撮影は可能です。



8章　付録130

本機では警告、注意、動作確認などが必要な状況では、ビューファインダー画面のメッセージ表示、
記録/タリーランプの点滅、および警告音で対応します。
警告音は、ヘッドホン端子に接続したヘッドホンに出力します。

エラー表示

次のような表示が出た場合は、本機は動作を停止します。

ビューファインダー	
警告表示

警告音 記録/タリー
ランプ

原因と対策

E+エラーコード 連続音 高速点滅 本体の異常の可能性があります。ビューファインダー
画面上にRECと表示されていても記録は止まってい
ます。
電源を切り、接続している機器やケーブル類、メディ
アに異常がないか確認してください。これらに異常が
ないときは、再度電源を入れ、エラーが継続する場
合はソニーのサービス窓口にご連絡ください。
（POWERスイッチをOffにしても電源が切れない場合
は、バッテリーパックやDC IN電源も外してください。）
本機の状況によっては、エラー表示や警告音が出な
い可能性があります。

警告表示

次のような表示が出た場合は、メッセージに従って対策してください。

ビューファインダー	
警告表示

警告音 記録/タリー
ランプ

原因と対策

Battery Near End 断続音 点滅 バッテリーパックの残量が少なくなっています。
早い機会に充電してください。

Battery End 連続音 高速点滅 バッテリーパックが消耗しました。記録はできません。
一旦操作を中止し、バッテリーパックを交換してくだ
さい。

Temperature High 断続音 点滅 内部温度が上昇しました。
一旦電源を切り、温度が下がるまで使用を中止してく
ださい。

ビューファインダー	
警告表示

警告音 記録/タリー
ランプ

原因と対策

Media Temperature 
High

断続音 点滅 CFexpressカードの温度が上昇しました。
カードを交換するか、温度が下がるまでカードの使
用を中止してください。

Voltage Low 断続音 点滅 DC IN電圧が低くなっています（段階1）。供給電源を
確認してください。

Insufficient Voltage 連続音 高速点滅 DC IN電圧が低すぎます（段階2）。記録はできません。
他の電源に接続し直してください。

Media Near Full 断続音 点滅 メモリーカードの残量が少なくなっています。
早い機会に交換してください。

Media Full 連続音 高速点滅 メモリーカードの残量がないため、記録、コピーはで
きません。
交換してください。

Clips Near Full 断続音 点滅 メモリーカードに記録できる残りのクリップ数が少な
くなっています。
早い機会に交換してください。

Clips Full 連続音 高速点滅 メモリーカードに記録できるクリップ数の上限に達し
ました。
これ以上記録やコピーはできません。交換してくださ
い。

Last Clip Recording 断続音 点滅 記録中のクリップの記録を完了すると、記録可能なク
リップ数の上限に達します。
新しいメモリーカードをご用意ください。

Media(A)1) Life Near 
End

断続音 点滅 メモリーカードの寿命が僅かです。早めに交換してく
ださい。

Media(A)1) Life End 連続音 高速点滅 メモリーカードの寿命がきました。交換してください。
Media(A)1) Near Full 断続音 点滅 同時記録機能使用時
Media(A)1) Full 連続音 高速点滅 同時記録機能使用時
Media(A)1) Clips 
Near Full

断続音 点滅 同時記録機能使用時

Media(A)1) Clips Full 連続音 高速点滅 同時記録機能使用時
Media(A)1) Last Clip 
Rec

断続音 点滅 同時記録機能使用時

Transfer Jobs Near 
Full

― ― FTPファイル転送ジョブ登録可能数が少なくなってい
ます。

エラー/警告表示
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ビューファインダー	
警告表示

警告音 記録/タリー
ランプ

原因と対策

Transfer Jobs Full ― ― FTPファイル転送ジョブ登録可能数が上限に達しまし
た。ジョブを追加したい場合は、不要なジョブを削
除してください。2)

1)	 スロットBに入れたカードの場合は(B)
2)	フルメニューのNetworkメニューのFile Transfer > View Job List（111ページ）からジョブを選んで削除することがで
きます。または、CBMのジョブリストからジョブを削除することができます。

注意・動作確認表示

画面中央部分に次のような注意・動作確認表示が現れることがあります。この場合は次表に従って対
処してください。

表示内容 原因と対策
Battery Error
Please Change Battery

バッテリーパックに異常が検出されました。
正常なバッテリーパックに交換してください。

Backup Battery End
Please Change

バックアップ電池の残量が不足しています。
バックアップ電池を充電してください。

Unknown Media（A）1）

Please Change
パーティションが切られているメモリーカードや、本機で扱えるク
リップ数を超えて記録されたメモリーカードが挿入されました。
本機では使用できませんので、交換してください。

Cannot Use Media（A）1）

Unsupported File System
ファイルシステムの異なるカードまたはフォーマットされていない
カードが挿入されました。
本機では使用できませんので、交換または本機でフォーマットし
てください。

Media Error
Media（A）1）Needs to be Restored

メモリーカードに異常が発生し、修復が必要な状態になりました。
メモリーカードの修復を行ってください。

Media Error
Cannot Record to Media（A）1）

メモリーカードが故障して、記録ができなくなりました。
再生は可能ですので、コピーをとるなどして、新しいメモリーカー
ドに交換することをお勧めします。

Media Error
Cannot Use Media（A）1）

メモリーカードが故障して記録も再生もできなくなりました。
本機では扱えませんので、他のカードに交換してください。

Media（A）1）Error
Recording Halted
Playback Halted

メモリーカードに異常が発生したため、記録または再生が停止し
ました。
頻繁に起きる場合には、メモリーカードを交換してください。

Media Reached Rewriting Limit
Change Media（A）1）

メモリーカードの寿命がきました。
バックアップをとり、速やかに交換してください。継続して使用す
ると、正常に記録・再生できない可能性があります。
詳しくは、メモリーカードの取扱説明書を参照してください。

The specified address is invalid. 指定したアドレスが間違っています。
正しく設定しているか確認してください。

Cannot Use Specified Port 
Number

指定したポート番号が間違っています。
正しく設定しているか確認してください。

Fan Stopped 本体内のファンが停止しています。
高温下での使用を避け、電源を切ってソニーのサービス担当者に
連絡してください。
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表示内容 原因と対策
LENS Error Eマウントレンズ装着時にレンズI/F通信でレンズの不具合が検出

されました。
Eマウントレンズとの接続状態を確認してください。

This Multi Term. acc is not 
supported by the device and 
cannot be used.
Please verify the compatibility.

非対応のアクセサリーが検出されました。
本機が対応するマルチ端子アクセサリーは、付属のグリップリモ
コンのみです。

Failed. DHCP Onでアドレスが割り当てられない場合、本エラーが出る
可能性があります。
DHCPサーバーの設定を確認してください。

Addition of auto upload job failed. 転送ジョブの数が上限に達しています。
不要なジョブをクリアしてください。また、オリジナルファイルま
たはプロキシファイルの自動転送先設定が間違っている可能性が
あります。正しく設定しているか確認してください。

<SSID>Not found. 指定した<SSID>のネットワーク（アクセスポイント）が見つかりま
せん。
正しく設定しているか確認してください。

<SSID>Authentication Failed 指定した<SSID>のネットワーク（アクセスポイント）の接続認証に
失敗しました。
パスワードなどを正しく設定しているか確認してください。

An IP address conflict has 
occurred. Please check the 
network settings.

無線LANと有線LANかUSBテザリング同士のネットワークアドレ
スが衝突しています。
アドレスを手動で変更するか、お使いのネットワークルーターの
設定を変更してください。

The IP address of the Wireless 
LAN Access Point Mode has been 
changed due to an IP address 
conflict.

無線LANアクセスポイントモードと有線LAN、またはUSBテザリ
ングのネットワークアドレスが衝突したため、無線LANアクセス
ポイントモードのIPアドレスを変更しました。
IPアドレスを確認してください。

1）	スロットBに入れたカードの場合は（B）
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フルメニューによる設定項目

Yes：ファイルに保存されます
No：ファイルに保存されません
―：ファイルに保存されません（一時的動作メニュー）

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Shooting ISO/Gain/EI Mode Yes No
ISO/Gain<H> Yes No
ISO/Gain<M> Yes No
ISO/Gain<L> Yes No
Exposure Index<H> Yes No
Exposure Index<M> Yes No
Exposure Index<L> Yes No
Shockless Gain Yes No
Base Sensitivity Yes No
Base ISO Yes No

ND Filter Preset1 Yes No
Preset2 Yes No
Preset3 Yes No

Shutter Mode Yes No
Shutter Speed On/Off Yes No
Shutter Speed Yes No
Shutter Angle Yes No
ECS On/Off Yes No
ECS Frequency Yes No

Iris Bokeh Control No No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Shooting Auto Exposure Level Yes No
Mode Yes No
Speed Yes No
AGC Yes No
AGC Limit Yes No
AGC Point Yes No
Auto Shutter Yes No
A.SHT Limit Yes No
A.SHT Point Yes No
Clip High light Yes No
Detect Window Yes No
Detect Window Indication Yes No
Custom Width Yes No
Custom Height Yes No
Custom H Position Yes No
Custom V Position Yes No

White Preset White Yes No
Color Temp <A> Yes No
Tint<A> Yes No
R Gain <A> Yes No
B Gain <A> Yes No
Color Temp <B> Yes No
Tint<B> Yes No
R Gain <B> Yes No
B Gain <B> Yes No

White Setting Shockless White Yes No
ATW Speed Yes No
White Switch<B> Yes No
Filter White Memory Yes No

ファイルに保存される項目
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Shooting Offset White Offset White <A> Yes No
Offset Color Temp<A> Yes No
Offset Tint<A> Yes No
Offset White <B> Yes No
Offset Color Temp<B> Yes No
Offset Tint<B> Yes No
Offset White<ATW> Yes No
Offset Color Temp<ATW> Yes No
Offset Tint<ATW> Yes No

Focus AF Transition Speed Yes No
AF Subj. Shift Sens. Yes No
Focus Area Yes No
Focus Area (AF-S) Yes No
Face/Eye Detection AF Yes No
Push AF Mode Yes No
Touch Function in MF Yes No
Multi Selector Function Yes No
Pointer Color Yes No
Pointer Border Yes No
AF Assist Yes No

S&Q Motion Setting Yes No
Frame Rate Yes No

LUT On/Off SDI/HDMI Yes No
VF/Proxy/Stream Yes No
Internal Rec Yes No

Noise Suppression Setting(Custom) Yes No
Level(Custom) Yes No
Setting (Cine EI/Flex. ISO) Yes ―
Level (Cine EI/Flex. ISO) Yes ―

Flicker Reduce Mode Yes No
Frequency Yes No

SteadyShot Setting Yes No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Project Base Setting Shooting Mode Yes ―
Target Display Yes ―

Rec Format Frequency Yes No
Imager Scan Mode Yes No
Codec Yes No
RAW Output Format Yes No
Video Format Yes No

Cine EI/Flex.ISO Set Color Gamut Yes ―
Embed LUT File Yes No

HDR Setting VF SDR Preview Yes No
SDR Gain Yes No

Simul Rec Setting Yes No
Rec Button Set Yes No

Proxy Rec Setting Yes No
Audio Channel Yes No
Chunk Yes No

Interval Rec Setting No No
Interval Time Yes No
Number of Frames Yes No
Pre-Lighting Yes No

Picture Cache Rec Setting Yes No
Cache Size Yes No
Cache Rec Time ― ―

SDI/HDMI Rec Control Setting Yes No
Assignable Button <1> Yes No

<2> Yes No
<3> Yes No
<4> Yes No
<5> Yes No
<6> Yes No
<7> Yes No
<8> Yes No
<9> Yes No
Focus Hold Button Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Project Assignable Dial Grip/Remote Dial Yes No
Grip Dial Direction Yes No
Handle Dial Yes No
Handle Dial Direction Yes No

Multi Function Dial Default Function Yes No
User File Load from Media(B) ― ―

Save to Media(B) ― ―
File ID No No
Load Customize Data Yes No
Load White Data Yes No

All File Load from Media(B) ― ―
Load from Cloud(Private) ― ―
Load from Cloud(Share) ― ―
Save to Media(B) ― ―
Save to Cloud(Private) ― ―
Save to Cloud(Share) ― ―
File ID Yes No
Load Network Data No No

Paint/Look Scene File Recall ― ―
Store ― ―
Delete ― ―
Preset Recall ― ―

Base Look Select Yes Yes
Delete ― ―
Delete All ― ―
Import from Media(B) ― ―
Import from Cloud(Private) ― ―
Import from Cloud(Share) ― ―
Input Yes Yes
Output Yes Yes
AE Level Offset Yes Yes

Reset Paint Settings Reset without Base Look ― ―

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Paint/Look Black Master Black Yes Yes
R Black Yes Yes
B Black Yes Yes

Knee Setting Yes Yes
Auto Knee Yes Yes
Point Yes Yes
Slope Yes Yes

Detail Setting Yes Yes
Level Yes Yes
Manual Setting Yes Yes
V/H Balance Yes Yes
B/W Balance Yes Yes
Limit Yes Yes
Crispening Yes Yes
High Light Detail Yes Yes

Matrix User Matrix Yes Yes
User Matrix Level Yes Yes
User Matrix Phase Yes Yes
User Matrix R-G Yes Yes
User Matrix R-B Yes Yes
User Matrix G-R Yes Yes
User Matrix G-B Yes Yes
User Matrix B-R Yes Yes
User Matrix B-G Yes Yes

Multi Matrix Setting Yes Yes
Area Indication No No
Reset ― ―
Axis No Yes
Hue Yes Yes
Saturation Yes Yes
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

TC/Media Timecode Mode Yes No
Run Yes No
Setting No No
Reset ― ―
TC Format Yes No

TC Display Display Select Yes No
Users Bit Mode Yes No

Setting No No
HDMI TC Out Setting Yes No
Clip Name Format Auto Naming Yes No

Camera ID No No
Reel Number No No
Camera Position No No
Title Prefix Yes No
Number Set No No

Update Media Media(A) ― ―
Media(B) ― ―

Format Media Media(A) ― ―
Media(B) ― ―

Monitoring Output On/Off SDI Yes No
HDMI Yes No

Output Format SDI Yes No
HDMI Yes No

De-Squeeze Ratio (HDMI/VF) Yes No
Output Display SDI Yes No

HDMI Yes No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Monitoring Display On/Off Network Status Yes No
File Transfer Status Yes No
Rec/Play Status Yes No
RAW Output Control Status Yes No
Tally Yes No
Battery Remain Yes No
Focus Mode Yes No
Focus Position Yes No
Focus Area Indicator Yes No
Focus Area Ind.(AF-S) Yes No
Face/Eye Detection Frame Yes No
Tracking AF Pointer Yes No
Lens Info Yes No
Imager Scan Mode Yes No
Rec Format Yes No
Frame Rate Yes No
Zoom Position Yes No
UWP RF Level Yes No
SteadyShot Yes No
Base Look/Rec Look Yes No
SDI/HDMI Rec Control Yes No
Monitoring Look Yes No
Proxy Status Yes No
Base ISO/Sensitivity Yes No
Media Status Yes No
Video Signal Monitor Yes No
Clip Name Yes No
White Balance Yes No
Scene File Yes No
Focus Indicator Yes No
Auto Exposure Mode Yes No
Auto Exposure Level Yes No
Timecode Yes No
ND Filter Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Monitoring Display On/Off Iris Yes No
ISO/Gain/EI Yes No
Shutter Yes No
Level Gauge Yes No
Audio Level Meter Yes No
Video Level Warning Yes No
Clip Number Yes No
Notice Message Yes No

Marker Setting Yes No
Color Yes No
Center Marker Yes No
Safety Zone Yes No
Safety Area Yes No
Aspect Marker Yes No
Aspect Mask Yes No
Aspect Safety Zone Yes No
Aspect Safety Area Yes No
Aspect Select Yes No
Custom Aspect Ratio Yes No
Guide Frame Yes No
100% Marker Yes No
User Box Yes No
User Box Width Yes No
User Box Height Yes No
User Box H Position Yes No
User Box V Position Yes No

VF Setting Brightness Yes No
Color Mode Yes No

Gamma Display Assist Setting Yes No
Peaking Setting Yes No

Peaking Level Yes No
Color Yes No

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Monitoring Zebra Setting Yes No
Zebra1 Level Yes No
Zebra1 Aperture Level Yes No
Zebra2 Level Yes No

Audio Audio Input CH1 Input Select Yes No
CH2 Input Select Yes No
CH3 Input Select Yes No
CH4 Input Select Yes No
INPUT1 MIC Reference Yes No
INPUT2 MIC Reference Yes No
Line Input Reference Yes No
Reference Level Yes No
CH1 Wind Filter Yes No
CH2 Wind Filter Yes No
CH3 Wind Filter Yes No
CH4 Wind Filter Yes No
CH3 Level Control Yes No
CH4 Level Control Yes No
CH3 Input Level Yes No
CH4 Input Level Yes No
Audio Input Level Yes No
Limiter Mode Yes No
CH1&2 AGC Mode Yes No
CH3&4 AGC Mode Yes No
AGC Spec Yes No
1kHz Tone on Color Bars Yes No
CH1 Level Yes No
CH2 Level Yes No
CH3 Level Yes No
CH4 Level Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Audio Audio Output Monitor CH Yes No
Volume No No
Headphone Out Yes No
Alarm Level Yes No
HDMI Output CH Yes No

Thumbnail Display Clip 
Properties

― ―

Set Clip Flag Add OK ― ―
Add NG ― ―
Add KEEP ― ―
Delete Clip Flag ― ―

Lock/Unlock Clip Select Clip ― ―
Lock All Clips ― ―
Unlock All Clips ― ―

Delete Clip Select Clip ― ―
All Clips ― ―

Transfer Clip Select Clip ― ―
All Clips ― ―

Transfer Clip (Proxy) Select Clip ― ―
All Clips ― ―

Filter Clips OK ― ―
NG ― ―
KEEP ― ―
None ― ―
All ― ―

Customize View Thumbnail Caption Yes ―

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Technical Color Bars Setting No No
Type Yes No

ND Dial CLEAR with Dial Yes No
Tally Front Yes No

Rear Yes No
HOLD Switch Setting with Rec Button Yes No

with Hand Grip Remote Yes No
Handle HOLD Switch Yes No

Touch Operation Setting Yes No
Rec Review Setting Yes No
Zoom Zoom Type Yes No
Handle Zoom Setting Yes No

High Yes No
Low Yes No

Menu Settings User Menu Only Yes No
User Menu with Lock No No

Menu Page On/Off Main Yes No
Camera Yes No
Audio Yes No
Project Yes No
Monitoring Yes No
Assignable Button Yes No
Battery Yes No
Media Yes No
Network Yes No
File Transfer Yes No

Fan Control Setting Yes No
Lens Zoom Ring Direction Yes No

Shading Compensation Yes No
Chroma Aberration Comp. Yes No
Distortion Comp. Yes No
Breathing Compensation Yes No
Distance Display Yes No
Zoom Position Display Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Technical Video Light Set Video Light Set Yes No
APR APR ― ―
Camera Battery Alarm Low Battery Yes No

Battery Empty Yes No
Camera DC IN Alarm DC Low Voltage1 Yes No

DC Low Voltage2 Yes No
Network Setup for Mobile App Setup ― ―

Access 
Authentication

User Name No No
Input Password No No
Generate Password ― ―
Show Settings ― ―

Wireless LAN Setting Yes No
WPS ― ―
NFC ― ―
MAC Address ― ―

AP Mode Settings Channel Yes No
Camera SSID & Password ― ―
Regenerate Password ― ―
IP Address ― ―
Subnet Mask ― ―

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Network ST Mode Settings Camera Remote Control Yes No
Connected Network
SSID ― ―
Security ― ―
Password ― ―
DHCP ― ―
IP Address ― ―
Subnet Mask ― ―
Gateway ― ―
DNS Auto ― ―
Primary DNS Server ― ―
Secondary DNS Server ― ―

Scan Networks
SSID ― ―
Security ― ―
Password No No
DHCP Yes No
IP Address Yes No
Subnet Mask Yes No
Gateway Yes No
DNS Auto Yes No
Primary DNS Server Yes No
Secondary DNS Server Yes No

Manual Register
SSID Yes No
Security Yes No
Password No No
DHCP Yes No
IP Address Yes No
Subnet Mask Yes No
Gateway Yes No
DNS Auto Yes No
Primary DNS Server Yes No
Secondary DNS Server Yes No
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Network Wired LAN Setting Yes No
Camera Remote Control Yes No
Detail Settings
DHCP Yes No
IP Address Yes No
Subnet Mask Yes No
Gateway Yes No
DNS Auto Yes No
Primary DNS Server Yes No
Secondary DNS Server Yes No

Modem Setting Yes No
Camera Remote Control Yes No
Device Name ― ―
IP Address ― ―
Subnet Mask ― ―

File Transfer Auto Upload Yes No
Auto Upload (Proxy) Yes No
Default Upload Server Yes No
Clear Completed Jobs ― ―
Clear All Jobs ― ―
View Job List ― ―
Server Settings1/Server Settings2/Server Settings3
Display Name Yes No
Service Yes No
Host Name Yes No
Port Yes No
User Name No No
Password No No
Passive Mode Yes No
Destination Directory Yes No
Using Secure Protocol Yes No
Root Certificate ― ―
Root Certificate Status ― ―
Reset ― ―

Network Reset Reset ― ―

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene 
File

Maintenance Language Select Yes No
Clock Set Time Zone Yes No

Date Mode Yes No
12h/24h Yes No
Date No No
Time No No

All Reset Reset ― ―
Reset without Network ― ―
Reset to Factory Defaults ― ―

Hours Meter Hours(System) ― ―
Hours(Reset) ― ―
Reset ― ―

Version Version Number ― ―
Version Up ― ―
Lens Version Number ― ―
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アサイナブルボタンによる設定項目

Yes：ファイルに保存されます
No：ファイルに保存されません
―：ファイルに保存されません（一時的動作メニュー）

アサイナブルボタンの選択肢 All File Scene File
ND Filter Position Yes No
Auto Iris Yes No
ATW Yes No
Focus Setting Yes No
Display Yes ―
VF Adjust Yes ―

アサイナブルダイヤルによる設定項目

Yes：ファイルに保存されます
No：ファイルに保存されません
―：ファイルに保存されません（一時的動作メニュー）

アサイナブルダイヤルの選択肢 All File Scene File
IRIS Yes No
ND Filter Yes No
Audio Input Level Yes No
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「収録する音声を設定する」（50ページ）と「Userメニュー」（78ページ）の関連項目をあわせてご覧ください。

Audio Input (CH1&CH2)
ハンドル装着時のブロックダイヤグラムです。

INPUT1

L

R

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

CH1

[CH1 Input Select]
INPUT1
Internal MIC
Shoe CH1

[CH2 Input Select]
INPUT1
INPUT2
Internal MIC
Shoe CH2

XL
R

ア
ダ

プ
タ

ー
の

場
合

XL
R

ア
ダ

プ
タ

ー
の

場
合

<CH1 LEVEL
   CONTROL>*
AUTO
MAN

<CH1 INPUT LEVEL>
0 ～ 10

[CH1 Wind Filter]
On
Off

[CH2 Wind Filter]
On
Off

CH2

<CH2 LEVEL
   CONTROL>*
AUTO
MAN

<CH2 INPUT LEVEL>
0 ～ 10

[CH1&2 AGC Mode]
Mono
Stereo [Color Bars]

[1kHz Tone on Color
Bars]
On
Off

[Audio Input Level]
0 ～ 99

[Limiter Mode]
Off, -6dB,

-9dB, -12dB,
-15dB, -17dB SG

[CH1 Level]
Audio Input Level
Side
Level + Side
Through

[CH2 Level]
Audio Input Level
Side
Level + Side
Through

*	 XLRアダプターからの音声入力があるときはManualになります。

ブロックダイヤグラム
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Audio Input (CH3&CH4)
ハンドル装着時のブロックダイヤグラムです。

L

R

CH3

[CH3 Level
 Control]*
Auto
Manual

[CH4 Level
 Control]*
Auto
Manual

[CH3 Input Level]
0 ～ 99

CH4

[CH4 Input Level]
0 ～ 99

[CH3&4 AGC Mode]
Mono
Stereo

[Audio Input Level]
0 ～ 99

[Limiter Mode]
Off, -6dB,
-9dB, -12dB,
-15dB, -17dB SG

OFF

[CH3 Input Select]
Off
INPUT1
Internal MIC
Shoe CH1

XL
R

ア
ダ

プ
タ

ー
の

場
合

XL
R

ア
ダ

プ
タ

ー
の

場
合

[CH3 Wind Filter]
On
Off

[CH4 Wind Filter]
On
Off

[CH4 Input Select]
Off
INPUT1
INPUT2
Internal MIC
Shoe CH2

INPUT1

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

[CH3 Level]
Audio Input Level
CH3 Input Level
Level+CH3 Input Level
Through

[CH4 Level]
Audio Input Level
CH4 Input Level
Level+CH4 Input Level
Through

[Color Bars]
[1kHz Tone on Color
Bars]
On
Off

 

*	 XLRアダプターからの音声入力があるときはManualになります。
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Audio Output

L

R

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

[VOLUME]
0 ～ 50

[Alarm Level]
0 ～ 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

CH2

CH3

CH4
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本機でEマウントレンズ本体のソフトウェアをアッ
プデートできます。
アップデートできるレンズ本体とそのソフトウェア
は、レンズのWebサイトをご覧ください。

バージョンを確認する

1	 Eマウントレンズを本機に取り付ける（23
ページ）。

2	 フルメニューのMaintenanceメニューの
Versionを選択してLens Version Number
を表示する（112ページ）。
Eマウントレンズのソフトウェアバージョン番
号が横に表示されます。

ソフトウェアをアップデートす
る

本機をマスストレージモードにします（124ペー
ジ）。
レンズのソフトウェアに添付された手順書に従っ
てソフトウェアをアップデートしてください。

Eマウントレンズのソフトウェアをアップデートする
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MPEG-4 AVC Patent 
Portfolio Licenseについて

本製品は、MPEG LA, LLCがライセンス活動を
行っているAVC PATENT PORTFOLIO LICENSE
の下、次の用途に限りライセンスされています：
(i)	消費者が個人的または他の報酬を受けていな
い使用目的で、MPEG-4 AVC規格に合致し
たビデオ信号（以下、AVC VIDEOといいます）
にエンコードすること。

(ii)	AVC VIDEO（消費者が個人的または他の報
酬を受けていない目的でエンコードしたもの、
若しくはMPEG LAよりライセンスを取得した
プロバイダーがエンコードしたものに限られま
す）をデコードすること。

なお、その他の用途に関してはライセンスされて
いません。プロモーション、商業的に利用するこ
とに関する詳細な情報につきましては、MPEG 
LA, LLC.のホームページをご参照ください。

GPL/LGPL適用ソフトウェア
の入手について

本製品はGPL/LGPL適用のソフトウェアを使用
しており、お客様には、これらのソフトウェアの
ソースコードの入手、改変、再配布の権利がある
ことをお知らせします。
これらのソースコードはインターネットのサーバー
からダウンロードすることが可能です。以下の
URLにアクセスすれば、具体的なダウンロードの
方法がわかるようになっています。

https://oss.sony.net/Products/Linux/

なお、ソースコードの中身についてのお問い合わ
せはご遠慮ください。

ライセンス内容（英文）に関しては、本機の内蔵メ
モリー内に記録されています。
本機とパソコンをマスストレージ接続し、
「PMHOME」 - 「LICENSE」内にあるファイルをご
一読ください。

END USER LICENSE 
AGREEMENT

IMPORTANT: 
BEFORE USING THE SOFTWARE CONTAINED IN THE 
SOLID STATE MEMORY CAMCORDER, PLEASE READ THIS 
END USER LICENSE AGREEMENT (“EULA”) CAREFULLY. BY 
USING THE SOFTWARE YOU ARE ACCEPTING THE TERMS 
OF THIS EULA. IF YOU DO NOT ACCEPT THE TERMS OF 
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and Sony 
Corporation (“SONY”). This EULA governs your rights 
and obligations regarding the software of SONY and/or 
its third party licensors (including SONY’s affiliates) and 
their respective affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”) contained in the wireless adapter, together 
with any updates/ upgrades provided by SONY, any 
printed, on-line or other electronic documentation for 
such software, and any data files created by operation of 
such software (collectively, the “SOFTWARE”).

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user license 
agreement (including, but not limited to, GNU General 
Public license and Lesser/Library General Public License) 
shall be covered by such applicable separate end user 
license agreement in lieu of the terms of this EULA to 
the extent required by such separate end user license 

agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The SOFTWARE is 
protected by copyright and other intellectual property 
laws and international treaties.

COPYRIGHT
All right and title in and to the SOFTWARE (including, 
but not limited to, any images, photographs, animation, 
video, audio, music, text and “applets” incorporated into 
the SOFTWARE) is owned by SONY or one or more of the 
THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the SOFTWARE 
solely in connection with the wireless adapter and only 
for your individual use. SONY and the THIRD-PARTY 
SUPPLIERS expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual property 
rights) in and to the SOFTWARE that this EULA does not 
specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, attempt to 
derive source code, modify, reverse engineer, decompile, 
or disassemble any of the SOFTWARE, whether in whole 
or in part, or create any derivative works from or of the 
SOFTWARE unless such derivative works are intentionally 
facilitated by the SOFTWARE. You may not modify or 
tamper with any digital rights management functionality 
of the SOFTWARE. You may not bypass, modify, defeat 
or circumvent any of the functions or protections of the 
SOFTWARE or any mechanisms operatively linked to 
the SOFTWARE. You may not separate any individual 
component of the SOFTWARE for use on more than one 
wireless adapter unless expressly authorized to do so 
by SONY. You may not remove, alter, cover or deface 
any trademarks or notices on the SOFTWARE. You may 
not share, distribute, rent, lease, sublicense, assign, 
transfer or sell the SOFTWARE. The software, network 
services or other products other than SOFTWARE upon 
which the SOFTWARE’S performance depends might 
be interrupted or discontinued at the discretion of 
the suppliers (software suppliers, service suppliers, or 
SONY). SONY and such suppliers do not warrant that the 
SOFTWARE, network services, contents or other products 

will continue to be available, or will operate without 
interruption or modification. 

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license grant, 
you acknowledge that the SOFTWARE may include 
EXCLUDED SOFTWARE. Certain EXCLUDED SOFTWARE 
may be covered by open source software licenses 
(“Open Source Components”), which means any 
software licenses approved as open source licenses by 
the Open Source Initiative or any substantially similar 
licenses, including but not limited to any license that, 
as a condition of distribution of the software licensed 
under such license, requires that the distributor make 
the software available in source code format. If and to 
the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list 
of applicable OPEN SOURCE COMPONENTS included in 
the SOFTWARE from time to time, and the applicable 
terms and conditions governing its use. Such terms 
and conditions may be changed by the applicable 
third party at any time without liability to you. To the 
extent required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will apply in lieu 
of the terms of this EULA. To the extent the terms of the 
licenses applicable to EXCLUDED SOFTWARE prohibit 
any of the restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will not apply 
to such EXCLUDED SOFTWARE. To the extent the terms 
of the licenses applicable to Open Source Components 
require SONY to make an offer to provide source code 
in connection with the SOFTWARE, such offer is hereby 
made. 

USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used by you 
to view, store, process and/or use content created by 
you and/or third parties. Such content may be protected 
by copyright, other intellectual property laws, and/
or agreements. You agree to use the SOFTWARE only 
in compliance with all such laws and agreements that 
apply to such content. You acknowledge and agree 
that SONY may take appropriate measures to protect 
the copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are not 

ライセンスについて

https://oss.sony.net/Products/Linux/
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limited to, counting the frequency of your backup and 
restoration through certain SOFTWARE features, refusal 
to accept your request to enable restoration of data, and 
termination of this EULA in the event of your illegitimate 
use of the SOFTWARE. 

CONTENT SERVICE 
PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE 
DESIGNED TO BE USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT SERVICES (“CONTENT 
SERVICE”). USE OF THE SERVICE AND THAT CONTENT IS 
SUBJECT TO THE TERMS OF SERVICE OF THAT CONTENT 
SERVICE. IF YOU DECLINE TO ACCEPT THOSE TERMS, 
YOUR USE OF THE SOFTWARE WILL BE LIMITED. You 
acknowledge and agree that certain content and 
services available through the SOFTWARE may be 
provided by third parties over which SONY has no 
control. USE OF THE CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE 
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet connection 
for which you are solely responsible. Further, you are 
solely responsible for payment of any third party fees 
associated with your Internet connection, including 
but not limited to Internet service provider or airtime 
charges. Operation of the SOFTWARE may be limited 
or restricted depending on the capabilities, bandwidth 
or technical limitations of your Internet connection 
and service. The provision, quality and security of such 
Internet connectivity are the sole responsibility of the 
third party providing such service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export and re-
export restrictions and regulations of the area or country 
in which you reside, and not to transfer, or authorize 
the transfer, of the SOFTWARE to a prohibited country 
or otherwise in violation of any such restrictions or 
regulations.

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not designed, 
manufactured or intended for use or resale as on-line 

control equipment in hazardous environments requiring 
fail-safe performance, such as in the operation of nuclear 
facilities, aircraft navigation or communication systems, 
air traffic control, direct life support machines, or 
weapons systems, in which the failure of the SOFTWARE 
could lead to death, personal injury, or severe physical or 
environmental damage (“HIGH RISK ACTIVITIES”). SONY, 
each of the THIRD-PARTY SUPPLIERS, and each of their 
respective affiliates specifically disclaim any express or 
implied warranty, duty or condition of fitness for HIGH 
RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE 
is at your sole risk and that you are responsible for use 
of the SOFTWARE. The SOFTWARE is provided “AS IS,” 
without warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) EXPRESSLY DISCLAIM ALL WARRANTIES, DUTIES 
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY, NONINFRINGEMENT AND 
FITNESS FOR A PARTICULAR PURPOSE. SONY 
DOES NOT WARRANT OR MAKE ANY CONDITIONS 
OR REPRESENTATIONS (A) THAT THE FUNCTIONS 
CONTAINED IN ANY OF THE SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE UPDATED, (B) 
THAT THE OPERATION OF ANY OF THE SOFTWARE WILL 
BE CORRECT OR ERROR-FREE OR THAT ANY DEFECTS 
WILL BE CORRECTED, (C) THAT THE SOFTWARE WILL 
NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE OR 
DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES 
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER 
THAN THE SOFTWARE) UPON WHICH THE SOFTWARE’S 
PERFORMANCE DEPENDS WILL CONTINUE TO BE 
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND 
(E) REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR OTHERWISE. 

NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN 
BY SONY OR AN AUTHORIZED REPRESENTATIVE OF SONY 
SHALL CREATE A WARRANTY, DUTY OR CONDITION OR 
IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. 

SHOULD THE SOFTWARE PROVE DEFECTIVE YOU ASSUME 
THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR 
OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW 
THE EXCLUSION OF IMPLIED WARRANTIES, SO THESE 
EXCLUSIONS MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) SHALL NOT BE LIABLE FOR ANY INCIDENTAL 
OR CONSEQUENTIAL DAMAGES FOR BREACH OF ANY 
EXPRESS OR IMPLIED WARRANTY, BREACH OF CONTRACT, 
NEGLIGENCE, STRICT LIABILITY OR UNDER ANY OTHER 
LEGAL THEORY RELATED TO THE SOFTWARE, INCLUDING, 
BUT NOT LIMITED TO, ANY DAMAGES ARISING OUT OF 
LOSS OF PROFITS, LOSS OF REVENUE, LOSS OF DATA, 
LOSS OF USE OF THE SOFTWARE OR ANY ASSOCIATED 
HARDWARE, DOWN TIME AND USER'S TIME, EVEN IF ANY 
OF THEM HAVE BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. IN ANY CASE, EACH AND ALL OF THEIR 
AGGREGATE LIABILITY UNDER ANY PROVISION OF THIS 
EULA SHALL BE LIMITED TO THE AMOUNT ACTUALLY 
PAID FOR THE PRODUCT. SOME JURISDICTIONS DO NOT 
ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL 
OR CONSEQUENTIAL DAMAGES, SO THE ABOVE 
EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its affiliates, 
partners and agents may read, collect, transfer, process 
and store certain information collected from the 
SOFTWARE, including but not limited to information 
about (i) the SOFTWARE and (ii) the software 
applications, contents and peripheral devices that 
interact with your wireless adapter and the SOFTWARE 
(“Information”). Information includes, but is not limited 
to: (1) unique identifiers relating to your wireless adapter 
and its components; (2) performance of the wireless 
adapter, the SOFTWARE and their components; (3) 
configurations of your wireless adapter, the SOFTWARE 
and the software applications, contents and peripheral 
devices that interact with the wireless adapter and the 
SOFTWARE; (4) use and frequency of use of the functions 
of (x) the SOFTWARE, and (y) the software applications, 

contents and peripheral devices that interact with the 
SOFTWARE; and (5) location data, as indicated below. 
SONY and its affiliates, partners and agents may use 
and disclose Information subject to applicable laws in 
order to improve its products and services or to provide 
products or services to you. Such uses include, but are 
not limited to: (a) administering the functionalities 
of the SOFTWARE; (b) to improve, service, update or 
upgrade the SOFTWARE; (c) improving, developing and 
enhancing the current and future products and services 
of SONY and other parties; (d) to provide you with 
information about the products and services offered by 
SONY and other parties; (e) complying with applicable 
laws or regulations; and (f) to the extent offered, 
providing you with location-based services of SONY 
and other parties, as indicated below. In addition, SONY 
retains the right to use Information to protect itself and 
third parties from illegal, criminal or harmful conduct.

Certain services available through the SOFTWARE may 
rely upon location information, including, but not limited 
to, the geographic location of the wireless adapter. You 
acknowledge that for the purpose of providing such 
services, SONY, the THIRDPARTY SUPPLIERS or their 
partners may collect, archive, process and use such 
location data, and that such services are governed by the 
privacy policies of SONY or such third party. By reviewed 
the privacy policies applicable to such services and 
consent to such activities. 

SONY, its affiliates, partners and agents will not 
intentionally use Information to personally identify the 
owner or user of the SOFTWARE without your knowledge 
or consent. Any use of Information will be in accordance 
with the privacy policies of SONY or such third party. 

Please contact applicable contact address of each area or 
country for SONY's current privacy policy. Please contact 
applicable third parties for privacy policies relating 
to personally identifiable and other information you 
provide when you use or access third party software or 
services. 

Information may be processed, stored or transferred 
to SONY, its affiliates or agents which are located in 
countries outside of your country of residence. Data 
protection and information privacy laws in certain 
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countries may not offer the same level of protection 
as your country of residence and you may have fewer 
legal rights in relation to Information processed and 
stored in, or transferred to, such countries. SONY will 
use reasonable efforts to take appropriate technical and 
organizational steps to prevent unauthorized access to 
or disclosure of Information, but does not warrant it will 
eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE
From time to time, SONY or the THIRD-PARTY SUPPLIERS 
may automatically update or otherwise modify the 
SOFTWARE, including, but not limited to, for purposes 
of enhancement of security functions, error correction 
and improvement of functions, at such time as you 
interact with SONY's or third parties’ servers, or 
otherwise. Such updates or modifications may delete 
or change the nature of features or other aspects of the 
SOFTWARE, including, but not limited to, functions you 
may rely upon. You acknowledge and agree that such 
activities may occur at SONY's sole discretion and that 
SONY may condition continued use of the SOFTWARE 
upon your complete installation or acceptance of such 
update or modifications. Any updates/modifications 
shall be deemed to be, and shall constitute part of, the 
SOFTWARE for purposes of this EULA. By acceptance of 
this EULA, you consent to such update/modification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY
This EULA and SONY's privacy policy, each as amended 
and modified from time to time, together constitute the 
entire agreement between you and SONY with respect 
to the SOFTWARE. The failure of SONY to exercise or 
enforce any right or provision of this EULA shall not 
constitute a waiver of such right or provision. If any part 
of this EULA is held invalid, illegal, or unenforceable, 
that provision shall be enforced to the maximum extent 
permissible so as to maintain the intent of this EULA, 
and the other parts will remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for the 
International Sale of Goods shall not apply to this EULA. 
This EULA shall be governed by the laws of Japan, 
without regards to conflict of laws provisions. Any 
dispute arising out of this EULA shall be subject to the 
exclusive venue of the Tokyo District Court in Japan, and 

the parties hereby consent to the venue and jurisdiction 
of such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this EULA to the 
contrary, you acknowledge and agree that any violation 
of or noncompliance with this EULA by you will cause 
irreparable harm to SONY, for which monetary damages 
would be inadequate, and you consent to SONY 
obtaining any injunctive or equitable relief that SONY 
deems necessary or appropriate in such circumstances. 
SONY may also take any legal and technical remedies 
to prevent violation of and/or to enforce this EULA, 
including, but not limited to, immediate termination of 
your use of the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to violate 
this EULA. These remedies are in addition to any other 
remedies SONY may have at law, in equity or under 
contract.

TERMINATION
Without prejudice to any of its other rights, SONY may 
terminate this EULA if you fail to comply with any of its 
terms. In case of such termination, you must: (i) cease 
all use, and destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section below 
entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND ANY OF THE 
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY 
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, BY 
EMAIL NOTIFICATION TO AN EMAIL ADDRESS PROVIDED 
BY YOU, BY PROVIDING NOTICE AS PART OF THE 
PROCESS IN WHICH YOU OBTAIN UPGRADES/ UPDATES 
OR BY ANY OTHER LEGALLY RECOGNIZABLE FORM OF 
NOTICE. If you do not agree to the amendment, you 
should promptly contact SONY for instructions. Your 
continued use of the SOFTWARE after the effective date 
of any such notice shall be deemed your agreement to 
be bound by such amendment.

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express intended 
thirdparty beneficiary of, and shall have the right to 
enforce, each provision of this EULA with respect to the 
SOFTWARE of such party. 

Should you have any questions concerning this EULA, 
you may contact SONY by writing to SONY at applicable 
contact address of each area or country.

Copyright © 2012 Sony Corporation.

オープンソースソフトウェアの
ライセンスについて

本製品には、弊社がその著作権者とのライセン
ス契約に基づき使用しているソフトウェアが搭載
されています。
当該ソフトウェアの著作権者の要求に基づき、弊
社はこれらの内容をお客様に通知する義務があ
ります。
ライセンス内容（英文）に関しては、本機の内蔵メ
モリー内に記録されています。
本機とパソコンをマスストレージ接続し、

「PMHOME」 - 「LICENSE」内にあるファイルをご
一読ください。
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保証書

ˎˎ この製品には保証書が添付されていますので、
お買い上げの際お受け取りください。

ˎˎ 所定の事項の記入および記載内容をお確かめ
のうえ、大切に保存してください。

アフターサービス

調子が悪いときはまずチェックを

この説明書をもう一度ご覧になってお調べくださ
い。

それでも具合が悪いときは

お買い上げの店、またはソニーの相談窓口にご
相談ください。

保証期間中の修理は

保証書の記載内容に基づいて修理させていただ
きます。詳しくは保証書をご覧ください。

保証期間経過後の修理は

修理によって機能が維持できる場合、ご要望に
より有料修理させていただきます。

保証書とアフターサービス
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一般

質量
	 約890 g（本体のみ）
	 約2.59 kg（SEL24105Gレンズ、レンズフード、

バッテリー（BP-U35）、ビューファ
インダー、ハンドル、グリップを含む）

外形寸法
	 152ページ参照
電源電圧
	 DC 19.5 V（18.0 V～20.5 V）
消費電力
	 約18.0 W（本体、レンズ付、XAVC-I QFHD 

59.94P記録時、ビューファインダー
点灯時、外部機器接続なし）

	 約36.0 W（本体、レンズ付、XAVC-I QFHD 
59.94P記録時（S&Q120fps）、
ビューファインダー点灯時、HDMI、
SDI、外部機器接続端子を使用）

動作温度
	 0 ℃～ 40 ℃
保存温度
	 －20 ℃～＋60 ℃
連続操作時間
	 約105分（BP-U35使用時）	

（本体、レンズ付、XAVC-I QFHD 
59.94P記録時、ビューファインダー
点灯時、外部機器接続なし）

記録フォーマット（ビデオ）
	 XAVC Intra
	 	 XAVC-I 4K/QFHDモード：	

VBR、最大ビットレート
600 Mbps、	
MPEG-4 AVC/H.264

	 	 XAVC-I HDモード：	
CBG、最大ビットレート
223 Mbps、MPEG-4 AVC/H.264

	 XAVC Long
	 	 XAVC-L QFHDモード：	

VBR、最大ビットレート150 Mbps、
MPEG-4 H.264/AVC

	 	 XAVC-L HD 50モード：	
VBR、最大ビットレート50 Mbps、
MPEG-4 H.264/AVC

	 	 XAVC-L HD 35モード：	
VBR、最大ビットレート35 Mbps、
MPEG-4 H.264/AVC

記録フォーマット（オーディオ）
	 LPCM 24ビット、48 kHz、4チャンネル
記録フレームレート
	 XAVC Intra
	 	 XAVC-I 4Kモード：	

4096×2160/59.94P、50P、
29.97P、25P、24P、23.98P

	 	 XAVC-I QFHDモード：	
3840×2160/59.94P、50P、
29.97P、25P、23.98P

	 	 XAVC-I HDモード：	
1920×1080/59.94P、50P、
29.97P、25P、23.98P

	 XAVC Long
	 	 XAVC-L QFHDモード：	

3840×2160/59.94P、50P、
29.97P、25P、23.98P

	 	 XAVC-L HD 50モード：	
1920×1080/59.94P、50P、
29.97P、25P、23.98P

	 	 XAVC-L HD 35モード：	
1920×1080/59.94P、50P、
29.97P、25P、23.98P

記録・再生時間
	 XAVC Intra
	 	 XAVC-I QFHDモード：
	 	 	 59.94P
	 	 	 約30分（CEA-G160T使用時）
	 	 XAVC-I HDモード：
	 	 	 59.94P
	 	 	 約78分（CEA-G160T使用時）

	 XAVC Long
	 	 XAVC-L QFHDモード：
	 	 	 59.94P
	 	 	 約115分（CEA-G160T使用時）
	 	 XAVC-L HD 50モード：
	 	 	 59.94P
	 	 	 約155分（CEA-G80T使用時）
	 	 XAVC-L HD 35モード：
	 	 	 59.94P
	 	 	 約210分（CEA-G80T使用時）

［ご注意］
記録再生時間は、使用条件やメモリーの特性などにより、
多少の誤差が生じる場合があります。また、記録・再生時
間は、1クリップとして連続記録したときの時間です。記録
するクリップ数によっては記載の時間より短くなる場合が
あります。

カメラ部

撮像素子
	 35mmフルサイズ相当単板CMOSイメージセン

サー
画素数
	 12.9M（total）
	 10.2M（effective）
オートフォーカス
	 検出方式：位相差検出方式/コントラスト検出

方式
内蔵NDフィルター
	 CLEAR：OFF
	 1：1/4ND
	 2：1/16ND
	 3：1/64ND
	 リニア可変ND：1/4ND ～ 1/128ND
ISO感度
	 ISO 800/12800（Cine EI Quick/Cine EI、

D55 Light source）
レンズマウント
	 Eマウント

ラティチュード
	 15+ stops
シャッタースピード
	 64F ～ 1/8000秒（23.98P時）
シャッターアングル
	 5.6°～ 360°、2～ 64frame
スロー＆クイックモーション
	 XAVC QFHD：1～ 120 fps
	 XAVC HD：1～240 fps
	 XAVC 4K：1～ 60 fps
	 XAVC HD（S35）：1～ 120 fps
ホワイトバランス
	 2000 K～ 15000 K
ゲイン
	 －3 dB～＋30 dB（1 dB単位）
基本ルック
	 S-Cinetone、Standard、Still、ITU709、

709tone、s709、709(800%)、
S-Log3、HLG Live、HLG 
Natural

オーディオ部

サンプリング周波数
	 48 kHz
量子化特性
	 24ビット
周波数特性
	 本体XLR入力MICモード時：20 Hz～20 kHz

（±3 dB以内）
	 本体XLR入力LINEモード時：20 Hz～20 kHz

（±3 dB以内）
ダイナミックレンジ
	 本体XLR入力MICモード時：80 dB（Typical）
	 本体XLR入力LINEモード時：90 dB（Typical）
ひずみ率
	 本体XLR入力MICモード時：0.08%以下	

（入力レベル－40 dBu時）
	 本体XLR入力LINEモード時：0.08%以下	

仕様
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（入力レベル＋14 dBu時）
内蔵スピーカー
	 モノラル
本体内蔵マイク
	 モノラル
ハンドル内蔵マイク
	 無指向性ステレオエレクトレットコンデンサー	

マイク

［ご注意］
ハンドル装着時はハンドル内蔵マイクのみが有効になりま
す。

入出力部

入力
INPUT 1/2：
	 XLR型、3ピン、凹
	 LINE / MIC / MIC+48V切り替え可能
	 MIC：Reference －30 dBu～－80 dBu
TC IN：
	 BNC型

出力
SDI OUT：
	 BNC型、12G-SDI、6G-SDI、	

3G-SDI（Level A/B）、HD-SDI
ヘッドホン（ステレオミニジャック）：
	 －16 dBu（基準レベル出力、モニターボリューム

最大、16 Ω負荷時）
HDMI：
	 TypeA、19ピン
TC OUT：
	 BNC型

その他
DC IN：
	 EIAJ標準、DC 18 V～20.5 V
マルチインターフェースシュー：
	 専用21ピン
REMOTE：
	 2.5φ3極ミニミニタイプ
グリップリモコン端子：
	 3.5φ4極stereo miniジャック（同梱されるグ

リップリモコン専用コネクター）
USB-C：
	 USB3.2 Gen1
USB/マルチ：
	 2.0規格準拠マスストレージ用microBタイプ（1）
VF：
	 専用40ピン

表示部

ビューファインダー（LCD）
画面サイズ
	 対角8.8 cm（3.5型）
アスペクト比
	 16:9
画素数
	 1280（H）×720（V）

メディアスロット部

CFexpress Type A/SDカードスロット（2）

無線LAN

対応規格
	 IEEE 802.11a/b/g/n/ac
使用周波数帯
	 2.4 GHz帯/5 GHz帯
セキュリティ
	 WEP/WPA-PSK/WPA2-PSK
接続方式
	 Wi-Fi Protected Setup™ (WPS)/マニュアル
アクセス方式
	 インフラストラクチャーモード

付属品

ACアダプター（1）
電源コード（1）
ハンドル（1）
LCDモニター（1）
USB-Cケーブル（1）
グリップリモコン（1）
LCDフード（1）
コールドシューキット（1）	
（コールドシュー（1）、シューバネ（1）、ビス（4））
レンズマウントキャップ（1）
ハンドル端子保護キャップ（1）
ご使用になる前に（1）
保証書（1）

仕様および外観は、改良のため予告なく変更す
ることがありますが、ご了承ください。

ˎˎ 必ず事前に記録テストを行い、正常に記録さ
れていることを確認してください。本機や記
録メディアなどを使用中、万一これらの不具
合により記録されなかった場合の記録内容の
補償については、ご容赦ください。

ˎˎ お使いになる前に、必ず動作確認を行ってく
ださい。故障その他に伴う営業上の機会損
失等は保証期間中および保証期間経過後に
かかわらず、補償はいたしかねますのでご了
承ください。

ˎˎ 本製品を使用したことによるお客様、または
第三者からのいかなる請求についても、当社
は一切の責任を負いかねます。

ˎˎ 本機内、記録メディア等に記録されたデータ
の損失、修復、複製の責任は負いかねます。

ˎˎ 諸事情による本製品に関連するサービスの停
止、中断について、一切の責任を負いかねま
す。
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外形寸法

単位：mm

UNC 1/4-20, Depth:6

UNC 3/8-16, Depth:5.5

2-UNC 1/4-20, Depth:6

UNC 1/4-20, Depth:6

UNC 1/4-20, Depth:5.5

98.6

11.9 8-UNC 1/4-20, Depth:6

UNC 1/4-20, Depth:6
UNC 1/4-20, Depth:6

143 60

98.6 89.8

82.5

114

62.8

60.6

258

90.1 60.6

25
25
25

4.9
25

117
228

74
116

15326.1

6.9 28

外形寸法は概算値です。
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商標について

ˎˎ  はソニー株式会社の商標です。

ˎˎ “XAVC”および  はソニー株式会社の登録
商標です。

ˎˎ HDMI、High-Definition Multimedia 
Interface、およびHDMIロゴは、米国お
よびその他の国におけるHDMI Licensing 
Administrator, Inc.の商標または、登録商標
です。

ˎˎ Microsoft、Windowsは、Microsoft 
Corporationの米国およびその他の国におけ
る登録商標または商標です。

ˎˎ Mac、macOSはApple Inc.の米国およびそ
の他の国における登録商標です。

ˎˎ “Catalyst Browse”、“Monitor & Control”、
“Content Browser Mobile”、“Content 
Browser Mobile”ロゴはソニー株式会社の商
標または登録商標です。

ˎˎ IOSは、米国シスコの商標もしくは登録商標です。

ˎˎ Android、Google PlayはGoogle Inc.の登
録商標または商標です。

ˎˎ Wi-Fi、Wi-Fiロゴ、Wi-Fi PROTECTED 
SETUPはWi-Fi Allianceの商標または登録商
標です。

ˎˎ「おサイフケータイ」は、株式会社NTTドコモ
の登録商標です。

ˎˎ NマークはNFC Forum,Inc.の米国およびその
他の国における商標あるいは登録商標です。

ˎˎ SDXCロゴはSD-3C,LLCの商標です。

ˎˎ CFexpress Type Aロゴ、CFexpressは
CompactFlash Associationの商標です。

ˎˎ QRコードは株式会社デンソーウェーブの登録
商標です。

ˎˎ USB Type-C™およびUSB-C™はUSB 
Implementers Forumの商標 です。

その他の各社名および各商品名は各社の登録商
標または商標です。なお、本文中では™、®マー
クは明記していません。
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